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Congratulations on purchasing Ulead PhotoImpact, the powerful

image editing solution for desktop professionals and novice alike. This

version of PhotoImpact features a comprehensive array of state-of-the-

art imaging tools that allow users to create professional-quality images

with unmatched ease-of-use. Its Microsoft Office-style interface and

guided workflow tools steer you swiftly through the entire program,

making the editing process a fairly smooth one while giving your

images impact. PhotoImpact’s outstanding features include compre-

hensive paint, retouch, and clone tools; enhanced image and text

manipulation; and a broad suite of out-of-this world special effects

plug-ins.  Its EasyPalette stores within it a variety of unique and

custom effects, styles, textures, gradients, and objects which you can

drag-and-drop into any image. Whether designing images for online

presentations, business documents, web pages, or simply for fun,

PhotoImpact is the standard in imaging for Microsoft Office users and

web designers.

Welcome to Ulead PhotoImpact

Introduction

Introduction at a glance:

• What would you like to do? .......................................................................... 10

• Installation .................................................................................................... 11

• Installing the Acrobat Reader ...................................................................... 12

• Overview of the programs ............................................................................ 12

• What's new in version 4 ................................................................................ 15

• Learning PhotoImpact ................................................................................  16
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What would you like to do?

The fastest way to learn the how-to's of PhotoImpact is through the use of the
program's various resources. These resources will assist you in seeking
significant and relevant information you need before and while using the
program. It is always best to refer to any of these guides as you explore the
many wonders of PhotoImpact.

I want to skip the manual and dive right in

In this case then, the absolute alternative for learning on-the-fly is the Online
Help. The Online Help is the best way to learn things for those who prefer
exploring the program on their own over reading the user's manual. It is always
at hand to guide you through PhotoImpact whenever you need help. For instant
information on a particular command or feature, press the F1 hot key. This is
the quickest and most convenient way to access Help anytime, anywhere within
the program. There is also the Help button on the Standard toolbar in
PhotoImpact that displays help for selected buttons, menus and windows. All
you have to do is click the icon (a question mark will appear beside your
pointer) and click the item of interest for help.

I want to see what's new in this version

If you have older versions of PhotoImpact, you'll be amazed how much has
changed in this version. To see what we've done differently and what we've
added, go to What's New on p.16. Get familiar with it first. Only then can you
go straight to the program and start working on your own documents. If you
need help in understanding the new tools and commands, check out the Online
Help.

I am a first time user and want to start at the beginning

If you've never used Ulead programs before, go to Learning PhotoImpact on
p.17 and What's New on p.16. Both sections will give you an good overview of
PhotoImpact and what it can do for you. Be sure to check out the Online Help
and this user's manual while exploring the program. Both of them take you
through easy-to-follow procedures for working with the commands and
features of PhotoImpact.
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I am an Office user and want to work closely with those programs

If you are an Office user, go to Chapter 8, Album, on p.217. Album is designed
to work hand in hand with the Microsoft Office suite and this chapter shows
you how to completely integrate your work in PhotoImpact with those other
programs. It gives you a better view of how to use Album for embedding and
linking image files into Office documents.

I want to design for the Web

For professional webmasters and web graphic designers, go to Chapter 6,
Imaging for the Web, on p.161. This chapter gives you an indepth look at web
imaging, helping you learn all there is to know about it – from image bit-depth
to creating buttons, backgrounds, and animations. This section will provide you
with the essential tools and knowledge to assist you in creating the most
impressive and dynamic web sites around.

Installation

Before using this user guide, you will need to run the PhotoImpact installation
program. The program runs from within Windows and contains complete
instructions on the installation process. Its step-by-step directions will take you
through the procedure almost effortlessly. All you need to do is follow the on-
screen instructions and prompts.

To install PhotoImpact:

1 One of the most important things to keep in mind before beginning any
installation is to READ the license agreement. The license agreement, which
comes with the PhotoImpact package, is very important as it bears various
legal stipulations that you need to be aware of. Once you agree to abide by
the License Agreement, the installation process continues.

Note: Please take some time to fill out the Registration card during installation.
Becoming a registered user entitles you to product update, update information, and
technical support.

2 Insert the PhotoImpact CD into your CD-ROM drive. Windows should
detect the CD and then automatically run the installation program. If it fails
to do so or if the automatic detection feature is turned off, use Windows
Explorer instead to run the SETUP.EXE program directly from your CD-
ROM drive.
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The next step is to follow the installation program instructions. While the
program is installing files, the installation window displays relevant informa-
tion about PhotoImpact. It also indicates the progress of the installation.

Note:  To move from one entry box to another in the installation program, use your
mouse or press Tab, not Enter.

Installing the Acrobat Reader

An electronic copy of this user guide is also available in the Adobe Acrobat
format, or the Portable Document Format (PDF). To view this, first run the
READER.EXE file, located with the PhotoImpact program files, and follow the
installation instructions.

After successfully installing the Reader program, use the File: Open menu
command from Acrobat Reader to open the file UPI-4 MANUAL.PDF (found
on the PhotoImpact CD). You can then view the user guide on-line.

Overview of the programs

The following is a brief overview of the programs in the PhotoImpact suite:

PhotoImpact

PhotoImpact is the leading office and web design and imaging tool around. It's
a feature-rich, next generation program giving you the power to scan, paint,
and retouch images with unmatched ease of use and flexibility. Within it, you'll
find tools for distorting, warping, enhancing, cloning, scanning, optimizing, and
animating any image you can lay your hands on.

Some of PhotoImpact's key features are:

• Extensive file format support for more than 30 of the most common
imaging file formats, including the primary web-centric GIF, JPG, and PNG
image types as well as a wide range of file formats designed for professional
graphic design such as TIF, PSD, and BMP.
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• Powerful particle effects system is one of the most powerful plug-in
effects included with PhotoImpact. Mapping attributes to individual particles,
PhotoImpact allows you to create wild and vibrant effects such as Snow,
Fire, Rain, and Fog.

• Flexible vector graphics drawings created with the Path tool give tremen-
dous versatility in creating custom vector-based 2D and 3D drawings.

• Professional paint, retouch and clone tools are a collection of high-end
paint, retouch, and clone tools that make it possible to do anything with your
images. Add paint to liven up flat pictures; use the retouch tools to clean up
scanned images; or use the clone tools to create wild, surreal scenes.
Pressure-sensitive tablet support gives you unmatched ease-of-use and
freedom.

• Unmatched Web support allows you to design, and optimize images for the
World Wide Web. Already an increasingly important part of our daily lives,
the Web is where you reach your largest audience, and PhotoImpact pro-
vides you with all the tools necessary for creating the coolest web site
around. Inside you'll find GIF Animator, the premiere Web-based animation
program; background and shadow designers; image mapping in flash; and
image file size downsizing without a loss in quality, just to name a few.

• Guided workflow puts the power of this complete image editing solution
right at your fingertips. Scan, process, and edit your images in a few quick
and easy steps with the Post-Processing Wizard. Or, use the Auto-Process-
ing Wizard to clean up and enhance images from within a single interface.

• Macro recording and playback allows you to simplify and catalog repeti-
tive, often-used steps or procedures. Using the dynamically expandable
Quick Command Panel, you can place frequently used menu commands
within mouse-click range, or record a string of actions and save them to the
Task List for use again later.

• Text effects that are easy to use and intuitive. Create a wide variety of
special effects using any TrueType font and PhotoImpact's 3D text effects
and enhancements. The Material dialog box gives you convenient access to
special lighting, texture, bump map, and shading options in order to turn plain
old ordinary text into dazzling, eye-catching headlines.
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Album

Album is a major module in the PhotoImpact suite as it aids you in organizing
your files visually by using thumbnails to represent their contents. It is a
powerful application in its own right as it ensures that your images and files do
not overrun your hard disk and that you can manage them easily and effec-
tively.

By using Album, you can create your own database which you can edit and
update as easily and as often as you want.

Album has a range of key features with which it helps keep your system in
order. These include OLE 2 support, user definable fields, e-mail support,
folder monitoring, and compact mode.

• OLE 2 support integrates Album more closely with other PhotoImpact and
Office programs. For instance, you will see the Album icon in other Office
programs such as Microsoft Word and PowerPoint. You can even activate
PhotoImpact from an object within a container program such as Word, and
then edit the object directly in Word’s workspace.

• User definable fields create a database complete with fields or categories
that you define. No longer are you restricted to just subject and description
information, now you can also include other details and arrange information
under your own headings, such as sports, date, age, and marital status. This
makes it an essential tool for anyone who needs to compile diverse and
comprehensive information such as employee or customer records.

• E-mail support sends your files over the Internet, directly from Album. You
can also send your files by fax using the Windows MAPI service.

• Folder monitoring allows Album to check your system for any changes to
the number of files in a folder and updates albums accordingly.

• Compact mode provides you with access to Album, while at the same time
revealing background programs. In compact mode, all Album windows are
removed from view, leaving only the active album, thereby allowing you to
quickly and easily drag-and-drop thumbnails within and between programs.
This is great for incorporating your work into other programs such as
Microsoft Word, PowerPoint, and Excel.

• Web support posts albums and images directly to the web from Album.
Also, URL data linked to images is hot, allowing a user to click hyperlink
annotations and immediately jump to the corresponding location on the
Internet.
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GIF Animator

GIF Animator is another major module in PhotoImpact that helps create cool
and dynamic web animations. As much as it is designed to work alongside
PhotoImpact, it is also a powerful stand-alone application in its own right.

Using GIF Animator, you can store a series of images in a single, web-oriented
file format and then assign timing and display attributes to each image layer,
thus effectively creating an animation. Not only can GIF Animator help you
create animations, it also compresses them to the smallest possible file size with
the highest quality through one of its key features, GIF Optimization.

Some of GIF Animator's key features are:

• Intuitive WYSIWYG interface makes creating Web-animations as easy as
dragging and dropping images from your desktop straight into GIF Animator.
Arrange frames simply by moving them with your mouse cursor in the Layer
Pane, or adjust an image's alignment the same way in the Workspace.

• Digital video support lets you turn your favorite digitized movies into Web-
ready animations in two easy steps.

• Restore optimized frames that have become 'broken' as a result of the
optimization process. This works with any animation you can find on the
Web or that you create.

• GIF Animation Wizard gets you up and running in no time flat. The GIF
Animation Wizard walks you through the process of creating an animated
GIF, step-by-step.

• GIF Optimization Wizard optimizes your animated GIF files according to
the specifications you set. Generate web-friendly animations with a minimum
amount of fuss and hassle.

• Special effects filters and plug-ins support digital video based effects
plug-ins and filters, bringing your web animations up to an entirely new level.
Create astounding results with custom transition effects and unique filters.

• Pixel Editor lets you edit images directly within the GIF Animator for
performing minor retouches and enhancements.

• Instant browser preview gives you the chance to preview animations in
your favorite web browser to see how they play.
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SmartSaver

SmartSaver is the utility in the PhotoImpact suite that saves your images with
the highest possible quality at the lowest possible file size, ensuring that your
images won't exceed the byte budget for the web. As GIF and JPEG formats
are the two most common web formats, both GIF and JPEG SmartSavers
function similarly to attain the best optimization result.

• GIF SmartSaver compresses images up to 256 colors in an effecient,
lossless file format that also supports image stacking (animation). This file
format is best suited for text and line art with fewer colors.

• JPEG SmartSaver compresses your image to a smaller file size than GIF
SmartSaver, but files saved as JPEGs are best suited for photorealistic
images. As a result, while the compression tends to be quite good, some-
times there is a slight loss in image quality.

•  PNG SmartSaver allows you to save your images in one of the newer web
file formats, PNG. PNG combines the best qualities of both GIF and JPEG,
allowing you to save images of any data type in this compact file format
without a loss in quality.

• Animation SmartSaver lets you optimize entire folders or websites of GIF
animations without ruining their quality. In fact, animations optimized with
Animation SmartSaver retain all of their original qualities while at the same
time being saved at the smallest possible file size.

What's new in version 4

There have been significant upgrades, additions, and other changes to this
version of PhotoImpact. All the modifications are designed to further make
PhotoImpact the industry standard in image editing and to provide more
powerful solution for office professionals and web enthusiasts alike.

This new version is mostly focused on imaging for the World Wide Web.
Among the added features are buttonizers which help you create dynamic and
eye-catching buttons for your websites; the background designer which helps
you create unique patterns for backgrounds not only on websites but also on
other presentations. Also topping the list of upgrades are the special effects and
EasyPalette. This version has an expanded array of special effects which can
greatly help you in giving your images the "professional look" – be it mosaic,
blurred, charcoal painted, or a staggered look. You can even add snow, rain, or
smog to any image! But these are just a few of the many amazing capabilities of
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the program. The EasyPalette contains a huge collection of galleries and
libraries where you can store images and effects for easy editing.

PhotoImpact incorporates plug-ins and modules that add to the program’s
special features. Make cool and exciting animations for the web using GIF
Animator. Compress your files with the highest possible quality at the lowest
possible file size with SmartSaver. The View: Browser Preview menu command
is also another addition to this version. This command simulates Netscape
Navigator or Internet Explorer and displays your image in an indexed-256 color
screen, allowing you to see a preview of a particular image in a web setting.

The Options command button has been greatly enhanced, opening the Material
dialog box for both the Text and Path tools and containing significantly more
options for creating outstanding text and vector drawings. PhotoImpact even
lets you import previously-saved illustration files created in Adobe Illustrator for
use with the Path tool. The Transform tool also has an additional option – the
3D Transform tool – which allows you to create three-dimensional effects
using a virtual track ball.

Learning PhotoImpact

PhotoImpact is a native Windows 95 program that pioneers a whole new
approach to image editing. Since its early days as ImagePals, it has been
constantly developed so as to always bring new productivity to both novices
and seasoned users, creating professional results in no time at all. Everything
within the program is so easy to use that there are no complex features and
irreparable changes; only intuitive imaging power for all your professional
needs.

There are innumerable ways to learn PhotoImpact, from reading the manual to
clicking the Help button whenever necessary. But the most effective of all is
exploring the program itself. Play with the software and you'll be a pro in no
time. After all, experience is always the best teacher.

Running the programs

To run the PhotoImpact programs, click the appropriate command on the Start:
Programs – Ulead PhotoImpact 4 submenu. All four programs in the
PhotoImpact suite are available in the PhotoImpact program group, but they
can also be accessed via a variety of other methods.
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PhotoImpact:

• Double-click any image file associated with the PhotoImpact program
(associated files use the PhotoImpact icon).

SmartSaver:

• Right-click over any image file in Windows Explorer and select the
SmartSaver menu command from the popup context menu.

• Click the Web: SmartSaver menu command from within PhotoImpact.

GIF Animator:

• Select GIF Animator from the Switch menu in PhotoImpact.

• Click the Animation button from many of PhotoImpact's custom effects.

Album:

• Double-click any AB3 file in Windows Explorer.

• Select Album from the Switch menu in PhotoImpact.

• Click the Album Quickstart icon in the Windows system tray.
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Chapter 2

PhotoImpact Fundamentals

This chapter describes the basic commands and features you will use

most often in PhotoImpact. As such, this chapter does not delve into

indepth and advanced image editing or enhancement techniques, but

does provide you with a comprehensive information you will need in

understanding the basics of PhotoImpact.

This chapter begins with a discussion of the PhotoImpact preferences

and then examines common file operations such as opening and saving

a file, recovering from mistakes, and printing out your images.

In this chapter you will learn:

• Understanding the basics ............................................................................ 20

• Customizing the way you work .................................................................... 22

• Working with image files .............................................................................. 27

• Sending images by electronic mail ............................................................. 31

• Using the Quick Command Panel .............................................................. 31

• Recovering from mistakes ........................................................................... 32

• Printing images ............................................................................................ 34

• Using the clipboard ...................................................................................... 37

• Performing OLE operations ......................................................................... 40

• Controlling the view of an image ................................................................. 41

• Using the EasyPalette .................................................................................. 45

• Understanding objects and selections ........................................................ 48

• Working with selection areas ....................................................................... 48

• Using grayscale masks ................................................................................ 57

• Working with objects .................................................................................... 58

• Using the Object libraries ............................................................................ 64
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Understanding the basics

When you run PhotoImpact for the first time, the first thing you notice is that it
contains a rather large program window. At first glance, this can be a bit
confusing, but once you become accustomed to it, you'll find that its layout
makes quite a lot of sense and is optimized for ease-of-use. To the left is the
Tool panel, where all the essential tools for image editing are docked, everything
from the Selection tools to the Bucket Fill tools. To the right is the Color
Palette, where you choose colors for painting, filling, and for other various
effects. At the top of the program window, below the menus, are the Standard
toolbar and the Attribute toolbar. The Standard toolbar contains shortcuts to all
the most common commands, while the Attribute toolbar contains Tool proper-
ties and changes according to the currently selected tool.

The PhotoImpact program window
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Standard toolbar
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Customizing the way you work

One of the first commands in PhotoImpact that you will get familiar with is the
Preferences command on the File menu. This enables you to customize the way
PhotoImpact looks according to your own liking and allows you to operate so
that it better suits your work habits. When you choose the Preferences com-
mand, a dialog box opens allowing you to set various options specific to
PhotoImpact as well as Album.

PREFERENCES DIALOG BOX: PHOTOIMPACT TAB

The PhotoImpact tab allows you to modify the way the program operates. You can, for
example, set the measurement unit to inches instead of pixels, give yourself more levels of
undo, and perform enhancements at higher quality levels.

Measurement unit  – can be in pixels, inches, or centimeters. All image size informa-
tion and ruler measurements are based on this setting. (This can also be changed by
clicking the Measurement Unit button on the Status bar.)

Enable undo  – allows you to take advantage of the multiple undo/redo feature in
PhotoImpact and to set the number of undo levels that you wish to make available (up to 99
levels). As PhotoImpact allocates more memory for each level of undo/redo, you may find
that too high a level adversely affects performance. In such cases, try setting the level of
undo/redo to a lower value, such as 3 or 4. You can, of course, disable Undo, but this
means that any editing done to an image is final.

Number of recently opened files – specifies the number of files listed at the bottom
of the File menu (up to 9). By clicking on a name from the list you immediately reopen that
file in the workspace.
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4

7

Generation quality  – allows you to set the quality of any effects and filters.
A higher quality results in better image reproduction but may take longer to calculate.

Highlight inactive selections and objects  – displays or hides a dark border around
objects and selections that are not active. Select this option if you have trouble keeping
track of objects in an image.

Display a confirmation message when saving – displays or hides a confirmation
message whenever you save a file containing objects to a non-UFO format, or for when
saving a file to a format that involves a compression scheme where image data is lost,
such as JPEG.

Display quick samples  – allows you to display or hide the sample thumbnails that
appear whenever you open an enhancement or effect dialog box.

Show the marquees of active objects  – allows you to display or hide the dotted
lines that appear around an image selection. Hide the selection marquee if you find it
distracting or select this option if you want to have an idea of how your selection appears.

Check Ulead's web site at start  – specifies how often you would want to check
out Ulead's web site at the start of the program.  Options range from one until 99 days.

Include OLE information when copying to the clipboard  – automatically places
your objects into the clipboard until you decide to perform a paste operation. Select this
option if you want to use PhotoImpact as an OLE server. Clearing it will disable the OLE
paste commands in your program.

5

6

The Plug-In tab allows you to specify the number of Plug-in programs in PhotoImpact and
the folders where they can be found. Plug-ins are external, third-party enhancements to
your image editing options. Keep in mind, however, that all changes take effect only after
restarting PhotoImpact.

PREFERENCES DIALOG BOX: PLUG-IN TAB
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Define additional folders for  –  helps you specify the folders used by PhotoImpact
as additional modules that add to the tools, filters, and effects in enhancing your program's
image editing capabilities.

Browse  –  leads you to the folder as specified in the folder name.

The Associate tab allows you to determine which file format is associated or linked to
PhotoImpact. For example, you can specify that all BMP files be associated to PhotoImpact.
The next time you double-click on a BMP file in Windows Explorer, it will open up in
PhotoImpact, regardless of which imaging program it may have originally been created in.

Associate file extension with PhotoImpact list box – displays all the file formats
supported by PhotoImpact. To associate a file format to PhotoImpact, click on the checkbox
of the appropriate format’s file extension.

Common preferences options

Both PhotoImpact and Album share a Preferences dialog box with the following
tabs: Memory and Display. Changes you make to any option in these tabs are
reflected in both programs, regardless of the program you change them in. For
example, if you calibrate your monitor in PhotoImpact, Album will have the
same calibration.

PREFERENCES DIALOG BOX: ASSOCIATE TAB

1

2

Note:  The Album Preferences command has a submenu of two commands, Album and
General. Album opens a dialog box just for Album program related features, whereas
General opens a dialog box of all the shared features.

1

1
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3PREFERENCES DIALOG BOX: MEMORY TAB

The Memory tab gives you the opportunity to specify folders that provide additional swap
space when working with files. You can also determine how much space is allocated on the
hard disk for virtual memory as well as how much space is allocated in RAM for use by all
Ulead programs.

Define additional folders for virtual memory  – allows you to specify the folder
used by the PhotoImpact programs as additional working space. For example, when you
don’t have enough RAM, the PhotoImpact programs can use extra memory from the hard
disk (virtual memory) as temporary RAM. The first folder shown in the Memory tab is the
TEMP folder defined by the SET TEMP statement in your AUTOEXEC.BAT file. If you have
more than one drive on your system, you can specify more than one temporary folder in the
available entry boxes. If not, leave the entry boxes empty.

Note: This option does not allow you to specify compressed hard drives as the source of
additional virtual memory folders.

Hard disk  – indicates the space available on your hard disk. (The folder specified in the
Define additional folders for virtual memory section must be located on this hard disk.)

Limit hard disk usage to  – allows you to specify how much memory you want to
allocate to the PhotoImpact programs for use as virtual memory. If you want to run other
programs in the background, then choose about ½ the maximum amount. To use PhotoImpact
defaults, leave this option cleared.

Limit RAM usage to  – allows you to specify how much memory you want to allocate
to the PhotoImpact programs for use in RAM. If you want to run other programs in the
background, then choose about ½ the maximum amount. To use PhotoImpact defaults, leave
this option cleared.
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PREFERENCES DIALOG BOX: DISPLAY TAB

The Display tab allows you to modify the way images are displayed as well as calibrate
(adjust) your monitor. You should calibrate your monitor whenever you change monitor,
display adapters or the environment in which you work, (as lighting and temperature can
also affect a monitor’s performance).

Hi Color dithering  – allows you to improve the display of True Color images when
you are in Hi-Color display mode.

View images with a common palette  – displays all images using the system
palette. This is only enabled when you are in 256-Color display mode and makes your work
quicker as there is no need to repaint any of the images with a new palette. This option is
particularly useful when preparing CD-ROM based titles and you need to see how images
appear in 256-Color display modes.

Ignore background quality  – enabled when in 256-Color display mode and improves
performance by not repainting any background images when you change views. (Do not
select this option if you need to identify background images.)

Monitor gamma  – allows you to calibrate your monitor for the optimum display of
images. (For more information, see the procedure below.)

To calibrate your display:

1 Click the File: Preferences menu command. When the Preferences dialog
box opens, click the Display tab.

At the bottom of the tab are two grayscale squares. The top square is a
checkered pattern of black and white pixels, which when viewed from a
distance, appears 50% gray. The bottom square is 50% gray as your
monitor currently shows it. In a well calibrated monitor, both of these
squares should look approximately the same.
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2 Examine the two color squares: If the two squares look different, adjust the
Monitor gamma spin box until the bottom square looks similar to the top
square.

The monitor gamma value can be any number from 0.01 to 7.99. If none of
the squares exactly match, try and estimate the best match. In general, your
value should fall within 0.8 – 2.4; if not, try adjusting the brightness and
contrast controls on your monitor.

3 Click OK. The dialog box closes and your monitor is now optimized for
displaying images in the PhotoImpact programs.

Working with image files

After configuring your preferences, you are now all set for working in
PhotoImpact. But before you get started with the program, you will need to
bring an image into the PhotoImpact workspace. There are a number of ways
by which you can do this. One of the easiest is to click the Open button on the
Standard toolbar.

Opening image files

After installation, you will find a number of files in the SAMPLES\IMAGES folder
inside your installation folder. To open these files or other image and graphics
files, just click the Open button on the Standard toolbar. Or, you can click the
File: Open [CTRL+O] menu command. The Open dialog box appears displaying
files in the current folder that correspond to the type shown in the Files of type
drop-down menu.

To open a file, select its file name and click OK. (Double-clicking the filename
also opens the file.) The dialog box closes and the file is opened in the
PhotoImpact workspace. To open multiple files, use the Shift key in conjunc-
tion with your mouse to select a range of files or the Ctrl key to select, or
deselect, individual files as you like. Once selected, click OK. The images open
in individual windows in the program workspace.

Notes:
• When you open a graphics file which does not contain bitmap data, it is converted to

an image. (The data type of this image is the same as your current display mode.) You
can then edit it in the same way as other images.

• You can also open the files you have most recently worked on by choosing their names
from the list at the bottom of the File menu. (The number of files that appear here is
controlled by the Number of recently opened files option in the Preferences dialog box,
see p.22.)
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Creating new images

Many times, probably more often than not, you’ll be opening pre-existing image
files in PhotoImpact. However, when you need to start with a clean, empty edit
window, you can click the File: New [CTRL+N] menu command, or the corre-
sponding button, and create a new image from scratch. This is especially handy
for creating empty workspaces for manipulating portions of an image or an
object independent of the original.

To create a new image:

1 Click the New button on the Standard toolbar or click the File: New
[CTRL+N] menu command. The New dialog box opens.

2 Click one of the data type buttons for your new image. You can choose
from Black & White, Grayscale, Indexed 16-Color, 256-Color, or True
Color data types.

You can also choose the background color of your new workspace by
clicking the Canvas color box which opens the Ulead Color Picker where
you can select a color.

The Preview window on the right gives you an idea of how your new image
appears in terms of background color and dimensions, as well as the current
printer the image is composed to (different printers may have slightly
different effects on an image’s appearance.)

3 Set the image dimensions in the Image size group box. Choose Standard if
you want to use default image sizes or Active image to set the size to be
the same as the currently active image (this option is disabled if there are no
images open in the workspace). To define your own, select User defined
and enter in the dimensions of the image in the Width and Height entry
boxes.
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4 Enter a value for the image’s resolution in the Resolution entry box and
select either Pixels/Cm or Pixels/Inch in the adjacent drop-down menu.

If the Measurement unit option in the Preferences dialog box (see p.22)
is in centimeters or inches, the resolution determines how many pixels are
used to create the image: the higher the resolution, the greater the number of
pixels and therefore the greater the amount of memory required to store the
image. When the Measurement unit is pixels, the resolution determines how
large your image will be when printed. The higher the resolution, the smaller
your image will print (the memory required to store the image, however,
remains the same).

5 Click OK. The dialog box closes and the new image, filled with the selected
background color, appears in an edit window.

Applying the same command to multiple files

Because PhotoImpact allows you to work with multiple files, it is very easy to
accumulate a large number of files in the workspace. Often you will want to
remove these, save them, or perform the same command to a selected few.
To help you do this, PhotoImpact provides the Batch Manager, opened by
double-clicking in the windowless portion of the workspace or by clicking the
Window: Batch Manager menu command. Once invoked, the Batch Manager
dialog box opens and displays the filenames and thumbnails of all the files
present in the workspace as well as a drop-down menu of commands that can
be applied to them. To perform a batch operation, select the command and the
files you want the operation to be performed on and click OK – the Batch
Manager does the rest for you.

Duplicating images

As you work with an image, you may find the need to make one or more copies
of it. This can be useful as it allows you to continue editing the copy without
the danger of losing any work done on the original. PhotoImpact offers you
three different kinds of duplication. You can duplicate [CTRL+D] the entire
image, including the base image and all objects, duplicate the base image alone,
or duplicate the image with all objects merged onto the base image. (For a more
thorough discussion of objects, see Chapter 2, p.48) Whenever you create a
duplicate of an image, it opens in a new image window.
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To create a duplicate of an image, you can:

• Choose the desired duplication command from the Edit: Duplicate submenu.

• Click the Edit: Selection - All to select the entire image and then drag the
selection onto the workspace. (This works only if the image has no objects
and if the Preserve Base Image command in the Options menu on the
Attribute toolbar is selected.)

Note: If the Preserve Base Image option is cleared, you can duplicate an image by
holding down the Ctrl key while dragging the selected image onto the workspace.

• Drag an object from an image or any Object Library into the workspace.

• Copy an image onto the clipboard and then click the Edit: Paste - As a New
Image menu command.

• Using a Selection tool, select part of an image and drag it onto the
workspace. Again, the Preserve Base Image command in the Options menu
on the Attribute toolbar should be selected; otherwise, press Ctrl while
dragging your image.

Saving images

Because PhotoImpact is an object-based editing program, any work you have
done that involves objects can be saved in a special Ulead File for Objects
format (UFO). A UFO file, exclusive to PhotoImpact, consists of the original
base image and any objects you may have created. (For more on objects, see
p.48.) The advantage of a UFO file is that it allows you to open the file at a later
date and still be able to edit the objects and base image independently as it
retains your objects as they are.

Note:  To save images for use in other image editing programs, you need to save the
image in a file format other than UFO.

To save an image in a non-UFO format, use the Save As command on the File
menu. Any objects present are merged onto the base image. As such, it is
important to remember that you cannot edit nor recover any objects which have
been saved in this way.

To save an image:

1 Click the Save button [CTRL+S] on the Standard toolbar or click the File:
Save As menu command. The Save As dialog box opens.

2 In the Save in list box, select the folder you want to save the image to and
then select a format from the Save as type drop-down menu.
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Choose *.UFO if you want to save any objects that are in the image.
Choosing any other format merges objects onto the base image.

3 In the File name entry box, type the name of your file. You do not need to
enter the File extension.

Note:  If you type in an extension, ensure that it is the same as the extension shown in the
Save as type drop-down menu. This is because PhotoImpact saves the file using the
format specified here, regardless of what extension is typed in.

4 Click Save. The image file is saved and the dialog box closes returning you
to the workspace.

Sending images by electronic mail

With the Send command in the File menu, you can send an image to anyone
else connected to your PC through MS Exchange (Windows 95), MS Mail
(Windows NT), or your default mail system. When you choose the Send
command, the Send Mail dialog box opens, allowing you to enter the filename
you wish to send. Selecting the Smart Sending option automatically reduces the
image size and saves it in the JPEG file format, creating a more compact image
file. Click OK to get the image ready for sending. Your default mail system
opens, allowing you to write your electronic mail as you would any other mail
but with an attached image file.

Using the Quick Command panel

PhotoImpact provides a fast way to access commonly used commands with
the Quick Command panel. To display the Quick Command panel, select the
Quick Command Panel option in the Toolbars & Panels dialog box, opened by
selecting the View: Toolbars & Panels menu command.

The advantage of using the Quick Command panel over the menu bar is that
you can customize the commands that appear there, as well as resize and
position the panel so that it is always where you want it. By choosing the
Layout Options command on the Quick Command panel’s control menu, you
can set the size of the custom and cache areas. The custom area is the top part
of the panel and displays commands that you specify, whereas the cache area
occupies the bottom part of the panel and displays your most recently used
commands.
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To specify which commands to display in the custom area, choose the Modify
command on the Quick Command panel’s control menu. This opens a dialog
box allowing you to add or remove any command from the custom area as well
as assign aliases to command names. For example, T&P can be used as an alias
for the Toolbars & Panels command in the View menu. Used in this way, aliases
help keep the Quick Command panel relatively narrow, taking up less space on
the screen.

Finally, the Quick Command Panel offers you the power to record macros of
frequently used commands and tools. Along the top of the Quick Command
Panel are controls for: Record, Play, Stop, and Batch Task. When you click the
Record button, each action performed is stored on the Quick Command Panel
until the time you click the Stop button. Pressing the Play button executes the
actions in the order they are stored on the Panel. Alternatively, to execute a
single action, you can simply click it. Macro lists are stored as ‘tasks’, with
each task list acting as a single macro unit.

The Options menu gives you commands for configuring the behavior of the
Quick Command Panel, for adding and removing macro tasks, as well as
Layout options. You can create Tasks for storing groups of actions as a single
macro by clicking the Task Manager command on the Options menu. To record
actions automatically to a task list, click the Batch Task button. To switch
between Task sheets, click the Task button.

For more on using the Quick Command Panel and Macros, please refer to the
Online Help.

Recovering from mistakes

PhotoImpact keeps track of every action and command that you use when
editing an image. This means that you can easily change your mind about a
command you have just performed without having to re-open the entire image.
This is very useful as you may sometimes wander down the wrong editing path
and want to backtrack to the point where that path began. PhotoImpact makes
this easy by giving you multiple levels of undo and redo. You can even go back
to what you did 99 commands earlier. But before you are able to do so, you
should first configure your settings in the Preference dialog box. (To control
the number of levels of undo or to disable the undo/redo feature, see the
Preferences dialog box, p.22.)
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Using Undo

Oftentimes, you may change your mind about an action or series of actions
you have previously performed on an image. In this case, click the Undo button
[CTRL+Z] on the Standard toolbar and the most recent action will be reversed.
To reverse more than one action, click the Edit: Undo Before menu command.
A submenu of the most recent actions appears with the most recent action on
top of the list. Choose the action you wish to undo up to. The effect of the
action, and all above it, are then reversed. Soon you will find your image
restored to its last state prior to the application of those actions.

Using Redo

When you wish to reapply an action that has been undone, click the Redo
button [CTRL+Y] on the Standard toolbar and the action is reapplied. If you
want to reapply a series of actions that has been undone, use the Redo To
command in the Edit menu. When you choose Redo To, a submenu of undone
actions appears with the most recent one on top. Select the undone action that
you wish reapplied and all undone actions above that will be reapplied as well.

Clearing your undo/redo list

Repeated use of the Undo Before and Redo To commands can use up valuable
system resources, as well as leave you with a mixture of desired and undesired
actions applied to your image. For this reason PhotoImpact gives you the
option of clearing the Undo Before and Redo To submenus with the Clear
Undo/Redo History command on the Edit menu. When choosing this command
all actions from the Undo Before and Redo To submenus are removed auto-
matically. (Be careful when you use this command as it is permanent and
cannot be undone.)

Restoring an image

When a series of undesirable changes have been made to an image that cannot
be easily undone with the Undo Before command, you have the option of using
the File: Restore menu command. Restore cancels all changes made to the
image since it was last saved. (This essentially closes the file and reopens it.)
Before using this command, consider carefully because it cannot be undone.

Note:  Because the restoring command cannot be undone, it is always best to create a
duplicate image before restoring so that you can compare the current stage of your work
with the original. For more on duplicating images, see p. 29.
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Printing images

PhotoImpact provides extensive print options to give you full control over
printing images. To print an image, click the Print button on the Standard
toolbar or click the File: Print  [CTRL+P] menu command. The Print dialog box
opens displaying various printing options. Basic printing options allow you to
select which printer to print from, the paper size you want, the number of
copies to print, and where on the page to print the image.

Using Print Preview

PhotoImpact allows you to see what your printed image looks like before
actually printing it. Click the Print Preview button on the Standard toolbar or
the File: Print Preview menu command. When you activate Print Preview,
PhotoImpact switches from normal editing mode to print preview mode.

The Print Preview window

In the Print Preview mode, you can use the buttons across the top of the
workspace to open the basic printing and layout options. For example, click the
View button to zoom in and out on the preview or to return to the default full
page view. To position the image in the center of the page, select the Center
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Horizontally and Center Vertically commands in the Options menu button or
drag the image freely with your mouse. The Fit To Page command will auto-
matically adjust your image to fit the page in a proportionate manner. You can
also resize the image by clicking the Resize button and then dragging the control
points that appear on the image. Click the Close button to bring you back to the
normal editing mode.

Calibrating your printer

All printers print images differently. For example, some consistently print
shadowed areas too dark or highlighted areas too light. PhotoImpact can easily
compensate for this kind of printing problem through calibration.

To calibrate your printer:

1 Click the Print button on the Standard toolbar or click the File: Print
[CTRL+P] menu command. The Print dialog box opens.

2 Click the Options button. The Options dialog box opens, displaying a
calibration curve as well as an extensive range of preset calibrations.

3 Clear the Use printer’s default checkbox. The other options in the dialog
box are now enabled allowing you to manually adjust the calibration curve.

4 Click the Apply Enhancement button. A pop-up menu appears listing
commands of the enhancements you can apply to the calibration curve.



PHOTOIMPACT USER GUIDE36

3

4

Select an enhancement command that corrects one or more of your
printer’s problems. For example, if your printer makes midtones in an image
too light, select the Darken Midtone command. If no enhancement
command can effectively correct your printing problems, you can manually
adjust the calibration curve by dragging your mouse over the curve. After
adjusting the calibration curve, save it by clicking the Save button. When-
ever you print in the future, this calibration curve will be applied to the
printed image resulting in a more consistent printout.

Working with PostScript printers

If your Printer supports PostScript, PhotoImpact allows you to specify various
PostScript settings to produce the best looking print output possible. Through
the PostScript feature in the Options dialog box, opened from the Print dialog
box, you can take advantage of PostScript Level II features, such as setting the
image quality and compression level.

PRINT OPTIONS DIALOG BOX: POSTSCRIPT TAB

Use PostScript level 2 features  allows PhotoImpact to take advantage of PostScript
level 2 commands. Left cleared, PhotoImpact uses standard level 1 commands. (Check
with your printer to see what level it supports.)

Best quality  sends more information to the printer for the best quality image output.
(Selecting this option does result in slower printing times.)

Compress bitmap  sends any images to the printer in a compressed format. This
does speed up printing, but may degrade the quality of the image output.

Compress  allows you to choose the type of compression scheme to use when you
have selected the Compress bitmap option.
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Using the clipboard

You are perhaps already accustomed to using the clipboard with almost any
program. In PhotoImpact, many of the commands make use of the clipboard.
The clipboard acts as a temporary storage area for any type of information – be
it an image, text, or even sound. But the clipboard can only hold one piece of
information at a time. When you place something onto the clipboard, the
existing clipboard data or the last piece of information you have just pasted onto
it is automatically overwritten – whether you placed new data from another
program or from PhotoImpact.

Performing a cut and copy operation

The most common methods for placing data onto the clipboard are clicking the
Cut [CTRL+X] and Copy [CTRL+C] buttons on the Standard toolbar or by select-
ing their respective commands from the Edit menu. Copy places a duplicate of
a selected area or object onto the clipboard whereas Cut deletes the selected
area or object and places it onto the clipboard. (If cutting a selected area, the
image is filled with the current background color.) When there is no selection
area, both Cut and Copy are applied to the entire image.

Performing a paste operation

After cutting or copying image data, you can then paste it from the clipboard
onto an image by clicking the Paste button [CTRL+V] on the Standard toolbar or
choosing one of the five paste commands from the Edit: Paste submenu. (The
Into Selection and Fit Into Selection commands are disabled when there is no
current selection. All paste commands are disabled if the clipboard is empty or
the content of the clipboard is from another, incompatible program.) Whenever
you paste data into an image, it becomes an object and floats above the base
image and any other objects.

Notes:
• PhotoImpact allows you to paste image data onto any image, regardless of data type. If

pasting onto an image of a different data type, the pasted data is converted. At times,
this may cause an extreme change in color; for example, pasting a True Color image
into an Indexed 16-Color image.

• When pasting an image, it is placed pixel-on-pixel. If your source and target images
are at different zoom levels, the clipboard image may appear to be enlarged or
reduced after pasting.
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Pasting images as objects

The standard paste command in PhotoImpact is the As an Object command
[CTRL+V], which can also be accessed from the Standard toolbar by clicking
the Paste button. When you paste an image as an object, the image is pasted at
the top left corner of the current view. (For a thorough discussion of objects
and working with them, see p.48.)

Pasting images into a selection area

Use the Into Selection command when you want to paste a clipboard image into
a selection area. This command is useful when you want to fill a selection area
with image data.

To paste clipboard data into a selection:

1 Select an area on the image where you want to paste the clipboard image
into.

2 Click the Edit: Paste - Into Selection menu command. The clipboard image
then appears inside the selection area.

Notice how the top left corner of the clipboard image remains connected to
your mouse. This allows you to move your mouse while at the same time
repositioning the clipboard image anywhere within the selection area.

Note:  Pressing the Esc key before you have finished the pasting operation automati-
cally removes the clipboard image.

3 Move your mouse around to position the clipboard image in the selection
area as desired.

4 Click your mouse. The clipboard image is then anchored in the selection
area as an object.

Note:  If the pasted image is smaller than the selection area, it is placed at the top left
corner of the selection. The remaining areas of the image are left unaffected.

Pasting images to fit into a selection area

Use the Fit Into Selection command when you want to paste the clipboard
image inside a selection area so that the entire image fills the selection. Depend-
ing on the size of the clipboard image, this can degrade the image as it may
have to be expanded or compressed to fit the selection area.
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Original selection     Pasting into the selection        Pasting to fit into the
       selection

Pasting images into a new image window

If you want to paste a selection into its own image window, use the As a New
Image command. This command is useful when you want to save an object
or selection area as its own image or have copied an image from another
program and want to place it in its own window. (You can also accomplish this
by dragging an object from an existing image onto the workspace.)

Pasting images beneath the mouse pointer

The Under Pointer command allows you to place the clipboard image onto the
base image wherever you click your mouse. When you choose this command,
the top left corner of the clipboard image remains connected to your mouse.
This allows you to move your mouse while at the same time repositioning the
clipboard image anywhere within the image. Clicking your mouse anchors the
image in place as an object.

The Clipboard submenu

To help you work with the clipboard, PhotoImpact provides the following
commands on the Edit: Clipboard submenu:

• Load brings image files and previously saved clipboard images onto the
clipboard. This command is similar to the Open command, but rather than
opening a file and placing it into a new image window, Load places the file
onto the clipboard.

• Save saves an image from the clipboard to a file. After saving, you can open
this image as you do any other images or bring it back onto the clipboard
with the Load command.

• Display shows the current clipboard image in a Windows clipboard viewer.
To close the clipboard viewer, press any key or click your mouse.
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Performing OLE operations

PhotoImpact supports linking and embedding features that allow you to easily
modify objects that have been embedded into other container programs.
The following section describes the different ways to link and embed objects
and how to edit them once they are in place.

To link an object from PhotoImpact:

1 Click the Copy button on the Standard toolbar or click the Edit: Copy
[CTRL+C] menu command to place the active image onto the clipboard.

2 Open or switch to the container program containing the document into
which you want to place the object.

3 Choose the container program’s Paste Special command. The Paste Special
dialog box appears.

Note: Some container programs have a Paste Link command. You can use this as an
alternative to the Paste Special command.

4 Select Ulead PhotoImpact Image Object from the As list box. (If the
Paste Link option is not enabled, then select another object format that is
compatible with the container program.)

5 Click the Paste Link radio button and then click OK. The dialog box closes
and a representation of the object appears in the container program’s active
document.

Note:  Each container program may use a different Paste Special dialog box. If any of the
above procedures do not conform to the container’s dialog box, see the program’s OLE
documentation.

To embed an object from within a container program:

1 Open or switch to the container program containing the document into
which you want to place the object.

2 Click the Insert: Object menu command. The Object dialog box opens.

3 Click the Create from File tab and enter the name and location of the
object’s source file.

4 Clear the Link to File  option if it is selected and click OK. The object
appears in the container program’s active document.

Note:  You can also paste objects from PhotoImpact by drag-and-drop. Pressing the Ctrl
key as you drop an object embeds it.
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In-place editing of embedded objects

You can edit an image embedded in a container document in-place by double-
clicking on the embedded object. This displays PhotoImpact’s toolbars and
panels in the container’s program window allowing you to edit the image from
within the container program just as you would within PhotoImpact. Click
anywhere off the embedded object to display the container’s original toolbars.

Controlling the view of an image

When you open an image in PhotoImpact, the pixels of the image are “mapped”
onto your screen pixels. Controlling the mapping of these pixels determines the
way you see images. For example, the actual view (1x) of an image is when
one image pixel is mapped to one screen pixel.

Zooming on an image

When you edit an image, you may want to see part of it in greater detail or
more of the image at a smaller size. You can do this in several ways: with the
Zoom In and Zoom Out commands on the View menu; using the Zoom tool on
the Tool panel; or by selecting a zoom magnification in the Zoom drop-down
menu on the Standard toolbar. In all, you can zoom in to an image by 16x or
out to 1/16x.

The Zoom tool on the Tool panel provides an alternative to the Zoom In and
Zoom Out commands and allows you to accurately zoom in on particular areas
of an image. You can use the Zoom tool in a number of ways:

• Clicking your left mouse button zooms in on the area under your mouse
pointer.

• Holding down the Shift key and clicking the left mouse button zooms out
from the image.

• Clicking the right mouse button returns the image to actual view (1x).

• Dragging your mouse creates a rectangular viewing marquee. When you
release your mouse button, the image automatically zooms in on the area
defined by the marquee. (If the viewing area is too large or the image is
already at 16x magnification, the view will not be adjusted.)

• Clicking the right mouse button while holding down the Z key automatically
zooms in on the image where you clicked, regardless of what tool you are
using. Doing so with your left mouse button, however, brings you back to
the actual view (1x) of the image.
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Notes:
• You can also press the “+” and “-” keys to zoom in and out on images, regardless of the

current tool selected.
• Pressing down the Z key while using another tool automatically switches that tool to the

Zoom tool. Releasing the Z key then switches the tool back.

  

An image at various zoom levels

Adding a view

After having zoomed in on an image, it is easy to get lost in a sea of pixels.To
help you keep the “big picture” in mind, you can use the Add a View [CTRL+I]
command in the View menu. The Add a View command creates a new window
containing an additional view (at 1x) of the image you are working on. This
new window is not just a duplicate of the original: It is actually a dynamic
“mirror” of the original. That is to say, when you do any editing in either of the
windows, the changes are reflected in the other. As a result, you can edit fine
detail at a higher magnification in one image window and at the same time see
the overall effect of that editing in the other image window at actual view.

  

Adding an image window at 1x

Using the Global Viewer

When an entire image cannot be displayed within its image window, you would
normally have to use the scroll bars to locate hidden areas. The Global Viewer
in PhotoImpact provides a better way by displaying a thumbnail view of the
entire active image. This thumbnail image contains a floating frame that can be
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moved independently around the viewer. Moving the frame automatically
repositions the current view of the active image. To open the Global Viewer,
click the box that appears at the intersection of the scroll bars in the lower right
corner of an image window whenever the image is larger than its window. This
displays the Global Viewer at the corner of the image window allowing you to
change the view quickly and easily. When you release your mouse, the Global
Viewer disappears.

Displaying a thumbnail view of the entire image

Fitting an image in its window

When you use the zoom commands, the image window does not change to fit
the new image size. Therefore, after zooming in, the entire image may not be
displayed in its window and scroll bars appear along the window border. If you
wish to display the complete image within its window, choose an available
zoom command from the View: Fit In Window by submenu. (The maximum
zoom level available is determined by the size of the image and the resolution of
your current display mode.)

Viewing images at full screen

To maximize the amount of space to work in, you can choose to display
PhotoImpact in full screen mode with the Full Screen command [CTRL+U]
in the View menu. When you choose this command, the active image is dis-
played at the current zoom level occupying the entire screen; in its default mode
the program window and all docked toolbars and panels are hidden, leaving only
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the image in view. Maximize At Actual View displays your image in the actual
view (1x) with the window opened at its maximum level within the
PhotoImpact workspace.

Full screen mode is very useful when you want to edit an image in as much
space as possible without the distractions of the program window. Any floating
toolbars or panels will remain visible in this mode allowing you to continue
working on your image. (To return to normal screen mode, press the Esc key.)

The Browser Preview command simulates Netscape Navigator or Internet
Explorer and displays your image in an indexed-256 color screen to simulate an
8-bit environment (for more on bit-depth, see p.164.) Any objects floating on
your image will be shown as part of that image while in the Browser Preview
mode. (To return to the normal screen mode, press the Esc key or any mouse
button elsewhere.)

If you prefer to have all the toolbars and panels present, choose the Remove
Menu Bar command in the View menu. This removes the title and menu bars of
the PhotoImpact screen only, leaving all other screen elements present. (You
can still access menu commands by using their keyboard short cuts keys. To
return to the normal screen mode, press the Esc key.)

The PhotoImpact workspace without the menu bar



PHOTOIMPACT FUNDAMENTALS 45

Using the EasyPalette

The easiest and most convenient method for applying special effects and filters
is to drag them from the EasyPalette and drop them directly onto an image,
selection area, or object. PhotoImpact makes it easy to apply a full range of
predefined and custom textures, effects, gradient fills, and objects to your
image through such galleries as Effect, Painting, Creative, Material, Magic,
Style, Gradient, Texture, Web, and Frame; as well as various libraries (Path,
Image, Web, and Frame) all in the EasyPalette. You can even create your own
galleries and libraries.

To apply an effect from the EasyPalette:

1 Click the EasyPalette button on the Standard Toolbar or select the
EasyPalette option from the Toolbars & Panels dialog box, opened by
clicking the View: Toolbars & Panels menu command. The EasyPalette then
opens, displaying an array of special effects and filters.

2 You will find a number of palette icons in the EasyPalette window, repre-
senting the various galleries and libraries. Click the Galleries menu if you
want to apply special effects, paint tools, transform tools, retouch tools, or
add textures and gradients, among others. Click Object Libraries  if you
want to use any objects or paths.

3 Select any of the available galleries or libraries found within them. Each of
the galleries contains countless of special effects in different tabs. Under
each tab are thumbnails of predefined styles and effects which can be
applied instantly to your active image.

Creating and organizing your library

In PhotoImpact, you can create your own gallery of special effects and objects
where you can save your specially configured tools (see "Saving a tool's special
attributes to the Custom gallery," Chapter 4, p.109). As both galleries and
libraries are handy and useful places to store images and objects, they can,
however, become cluttered with large numbers of such images and objects. To
better organize these, place them into user-defined tab groups.

To create a gallery or library:

1 From within the EasyPalette, choose Create from the Gallery Manager or
Object Library Manager menu. The Create Gallery (or Create Object Li-
brary) dialog box opens, prompting for a name for your new gallery and the
folder where it is stored.
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2 Type in a name for your gallery or library in the Name entry box. If you
want to change the path and the folder where the gallery is saved, type in a
new destination in the Folder entry box.

3 The Tab Group window below it specifies the tabs belonging to the new
gallery. Click Add/Remove to either add to or remove tabs from the gallery.

4 Click OK. The dialog box closes and the newly created gallery appears in the
EasyPalette.

Importing and exporting galleries

From the Gallery or Object Library Manager submenu, click Import to import
any gallery files (.SMP) or object library files (.UOL) into the EasyPalette or
Export if you want to save the active gallery/library as another file in a specified
folder. If you have previously imported Adobe Illustrator .AI files using the
Path tool (see "Importing illustration files" on how to import an .AI file, Chapter
4, p.123), the path images are displayed as thumbnails in the Shapes Library of
the Object Library and are stored as objects. You can directly apply them by
dragging the thumbnail onto your image.

The Properties command from the Galleries: Gallery Manager and Object
Libraries: Object Library Manager submenus tells you the file size and the
number of tabs as well as the number of thumbnails you have under each in the
selected predefined gallery or library. Menu Layout allows you to add or remove
submenus and separators and to rename the galleries.

The Layer Manager

The Layer Manager displays all the objects present in your active image as
individual thumbnails, unless they have been merged onto the image. Each of
the thumbnails has a sequential creation number with an open eye icon on top
indicating that the object can be viewed. As you work on your image, any
enhancements made to the objects will be shown on the thumbnails. These
thumbnails appear according to the order of the layers. Therefore, moving your
objects' layers using the Pick tool's four arrow buttons (see "Changing an
object's layer in an image," p.60) changes the thumbnail position in the Layer
Manager, with the first thumbnail indicating the uppermost layer and the last
being on the bottom layer. Dragging the thumbnails directly from within the
Layer Manager also changes the objects' layer orders.



PHOTOIMPACT FUNDAMENTALS 47

Modifying the thumbnails

At times, you may find it necessary to modify your specially configured tools
and special effects directly from the EasyPalette. To further enhance a gallery
thumbnail with special effects, click the Thumbnail Menu Commands icon and
select Modify Properties and Apply. A dialog box with the thumbnail's proper-
ties opens, allowing you to further modify and add additional effects to it.
Clicking OK automatically applies the effect to your image while Add appends
the modified thumbnail to the palette. Right-clicking on a thumbnail – be it in
gallery or library – also gives you access to its properties.

To update a thumbnail:

1 Select Properties from the Thumbnail Menu Commands. The image's
properties dialog box opens, allowing you to modify your default thumbnail.

2 Click OK. The Update EasyPalette window opens, prompting for a name.
You can change the original name of the thumbnail, if necessary.

3 Click OK. The updated thumbnail now appears in the EasyPalette. Updating
your thumbnails occasionally helps you organize your galleries and avoid
repeating some effects and tools.

Use Image As Thumbnails

Sometimes, trying out all the available thumbnails in the EasyPalette in a single
editing session could be a colossal waste of time, especially if you don't have a
particular effect to apply in mind. However, sometimes it’s necessary to
experiment with a wide variety of effects in order to achieve desired result.
Therefore, the EasyPalette provides you with a convenient alternative.

The Use image as thumbnails command applies all of the available effects to
your image as thumbnails in the EasyPalette. To do so, select the Use Image As
Thumbnails from the Thumbnail menu command or click Try on the
EasyPalette window. This redraws all the existing thumbnails representations
using your image (the effects are already applied in each case). You can adjust
the size of the thumbnails by selecting from among the options in the Thumb-
nail size combo box. To bring the thumbnails back to their original appearance,
select Reset Thumbnails from the Thumbnail menu commands. The View menu
command also lets you adjust your viewing options.
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Understanding objects & selections

PhotoImpact makes extensive use of objects and selections to give you the
ability to modify all or portions of an image with ease. This section introduces
these and then goes on to discuss each in greater detail.

• Selections are selected regions of an image containing image data.
Selection areas are bordered by colored dotted lines (the selection marquee)
and can be expanded to include multiple areas of an image. Many times,
actions performed on a selection area convert it into an object. (It is not
possible, however, to create a selection area on an object. If you want to
select a portion of an object, you have to merge that object onto the image
before being able to create another selection.)

• Objects are selection areas that have been transformed in some way and
“float” above the original (base) image. They are independent of the base
image and are distinguished by an animated black and white dotted line when
they are selected and by a dark border when not selected. (This border can
be hidden by clearing the Highlight inactive selections and objects option in
the Preferences dialog box, see p.22) Each image can contain any number of
objects, with each object occupying its own layer in an image. By managing
these layers, you can move objects above or below one another.

 

An example of a selection (on the left) and objects (on the right)

Working with selection areas

In general, whenever you apply a command in PhotoImpact it is applied over an
entire image. To restrict the command to a certain area of an image, you first
need to create a selection area. PhotoImpact provides five selection tools that
allow you to do just that, offering a wide range of options for creating both
simple and more complex selection areas. To make a selection, simply click the
lower right corner of the selection tool on the Tool panel. A drawer of selection
tools then opens, prompting you to choose from Standard Selection tool, Lasso
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tool, Magic Wand, Bezier Curve tool, and the Mask Brush tool. The Bezier
Curve, which works in conjuction with the Path tool, will be discussed in
Chapter 4, p.125.

Note:  The selection tools only work on base images; you cannot create selection areas
on objects.

Pick Tool

Before we go into the five selection tools, a look at the first tool on the Tool
panel – the Pick tool – is in order. The Pick tool is used mainly to select ob-
jects, static selections, or a base image. It can also move and copy objects.

Click on an object or static selection to select it. To select multiple objects, drag
the Pick tool from an empty area across the objects' edges (or encase them
within the Pick tool's selection area.) Another way of selecting a set of objects
is by clicking the objects one after another with the Shift or Ctrl key down. To
force all the objects together as a single object, click the Edit: Object - Combine
as Single Object menu command (also available from the popup menu that
appears when you right-click over any object or group of objects.)

After creating a selection using any of the selection tools (see the following
section for more on creating selections), you can drag the static selection
anywhere in your image. The static selection, however, does not become an
object. Duplicate a selection by pressing the Ctrl key while dragging.

As the Pick tool allows you to move objects, it gives you full control of their
position by changing their layers and alignment. Position your objects above or
below the other by using the four arrow buttons on the Attribute toolbar. To
change their alignment, simply choose from among the Align options on the
Attribute toolbar or select the appropriate command from the Web: Align
Objects submenu.

Standard Selection Tool – selecting regularly shaped areas

The Shape tool allows you to select areas of an image based on a preset size
and/or shape, such as a square, rectangle, circle, or an ellipse. To determine
which shape, select one of the various shape tool options in the Shape drop-
down menu on the Attribute toolbar. To create a selection, drag your mouse
over an image where you want the selection to be. If you want the selection to
always appear at the same size, select the Fixed size option and enter the
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appropriate values in the neighboring spin boxes. Now when you click in an
image, a selection is made based on that size. Selecting a fixed size is useful
when you are selecting identically sized image portions, such as personnel
photos to be added to an employee database. The Soft edge option softens the
sharp edges of your images and gives selections, particularly rectangular ones,
rounded corners. Enter any value between 0 and 150.

When you create a selection, it starts from where you first click your mouse.
This is fine for most cases, but sometimes you may want it to start from the
center, particularly if you are creating circular or square shapes. To do this,
select the Draw From Center command in the Options menu on the Attribute
toolbar. The next time you create a selection, it starts from the center and
moves out from each side as you drag your mouse. You can specify the shape
of your selection by choosing the appropriate shape from the Shape entry box.
Options include rectangle, square, ellipse, and circle.

Lasso Tool – selecting irregularly shaped areas

The Lasso tool allows you to select an area of any shape you desire. This is
especially useful for selecting difficult areas such as a person’s head or objects
with a number of different angles or indefinite shapes.

The Lasso tool operates in two ways as you create a selection area. Dragging
your mouse allows you to draw precise curved segments, while clicking your
mouse and moving (not dragging ) it allows you to define straight line seg-
ments. By combining both drawing techniques you can quickly outline selection
areas that contain both irregular and straight segments. When you have finished
outlining the selection area, double-click and PhotoImpact automatically selects
all image data within the bounds of the drawn selection area.

By selecting the Snap to edges option on the Attribute toolbar and then entering
a value into the Sensitivity entry box (up to 10), PhotoImpact can help you
quickly trace around irregularly shaped objects. The Sensitivity attribute works
by specifying the range of contrast values that are used to define an object’s
edge, and Snap to edges pulls the selection area to that edge as you draw. This
works best when you are tracing a bright foreground object against a dull
background. (If you find the selection “pulls” to include unwanted areas, then
clear the Snap to edges option or decrease the sensitivity.) Soft edge creates a
soft and round edge around your selection. Enter any value from 0 (no soft
edge applied) to 150.
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Note:  If you make a mistake while drawing a selection area or wish to start again, press
the Esc key. Pressing the Backspace key takes you back one step.

Magic Wand – selecting an area containing similar colors

The Magic Wand tool is used when you want to select specific colors in an
image. When you click in an image, any colors that fall within the values
specified in the Similarity entry box are included in the selection area. This is
especially useful when the colors occupy a predominant part of the image, such
as a solid color background. Therefore, the bigger the number, the more areas
within that color range will be incorporated in the selection.

When you use the Magic Wand tool, it operates in one of two modes, Line or
Area. (You determine which with the Select by option on the Attribute toolbar.)
In Line mode, dragging your mouse over an image creates a line that calculates
the largest and smallest color values of the pixels under the line (any values
entered in the Similarity spin box are also included). Releasing your mouse then
creates the selection based on that range. Line mode is useful when creating
selection areas around straight edges such as borders or frames.

Area mode works in much the same way, except that instead of taking the
values of pixels under a line, it includes all pixels within a selected area.
This mode works best for irregular areas containing similar colors such as
backgrounds and gradients.

Search connected pixels picks connected or unconnected pixels with similar
colors. Leaving it cleared will automatically select similar pixels within the entire
image.

  

 Standard selection    Freehand selection       Magic Wand selection

Determining color similarity

When using the Similarity entry box, you type in a value that you feel closest
reflects the range of colors you wish to select. To help determine the color
similarity range, move the Magic Wand over target pixels in the image and
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notice the RGB and HSB color values displayed on the Status bar. Below is a
guideline on what to expect when choosing particular color ranges. (You can
only select a color range between 0 and 255):

• A value of 0 selects neighboring pixels with exactly the same color value,
such as all white.

• A value of 255 selects pixels of all colors – thereby selecting the entire
image.

• A value of 50 selects neighboring pixels that have values which differ from
the pixel you click on by 50. For example, if you click on a pixel with values
R25, G60, B190, neighboring pixels with values between R0, G10, B140, and
R75, G110, B240 will be selected.

Using the Mask Brush

The Mask Brush tool allows you to create selection areas by painting a color
mask over an image whenever you choose the Mask Brush tool on the Tool
panel. (This color is defined by the Mask color square on the Attribute toolbar.)
Using the mask makes identifying areas easier as it creates a better contrast
between the image and the selection area.

To use the Mask Brush tool, click or drag your mouse over the area of an
image that you want to include in a selection area. The affected area of the
mask is then removed, revealing the underlying image. If you reveal too much
of the underlying image, select the Subtract option in the Mode drop-down
menu on the Attribute toolbar. The next time you use the Mask Brush, the mask
is applied, rather than removed from the image. Once finished, changing to
another tool removes the mask and converts any revealed areas into selections
areas.

Notes:
• To quickly switch modes, press the “A” key to remove portions of the overlay, “S” key to

reapply them. Likewise, clicking your left mouse button removes an overlay, right
mouse button reapplies it.

• If you use the Mask Brush on an image with an existing selection area, the selection
appears as removed areas of the overlay.

Understanding the Mask Brush attributes

As the Mask Brush tool is similar in function to a painting tool, it shares many
of the painting tools attributes, such as brush shape and size. This can help you
better define the areas to include in a selection area. For example, a square
brush shape is ideal for tracing straight lines, and a circle brush for circular
objects. You can also choose to paint in a straight line, freely or in straight line
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segments using the appropriate command from the Options menu on the
Attribute toolbar. To smooth the edges of the Mask Brush, you can also specify
a value in the Soft edge spin box on the Attribute toolbar. After creating the
selection area, any enhancement or paint you apply to the selection will blend
along the edges with the underlying image.

As the Mask Brush adopts many of the attributes of a paint tool, you can use it
in conjuction with a paint tool to perform certain special effects. For example,
normally when you apply color to an image with a paint tool, it is automatically
merged onto the image. Sometimes this may not be what you want, particularly
if you want to move it at a later date. Using the Mask Brush, you can first paint
a selection, then convert the selection into an object, and then fill that selection
with a color. This method works well if you want to apply a color to several
objects, as a paint tool can only apply a color to a single object at a time.

 

Using a mask to “paint” a selection area

Moving a selection area marquee

Sometimes you will want to use a selection area itself without the image data it
contains. For example, you may want to move a selection area to expose
certain portions of an image or to protect other portions from any effects or
changes you may make to the image. To do this, choose the Move Selection
Marquee command from the Options menu on the Attribute toolbar while using
the Selection tool, or simply use the Pick tool. Now when you move a selec-
tion, only the marquee of the selection area moves, without any image data.

Preserving the base image

By default, whenever a selection area becomes an object, the image beneath the
object is preserved. This is helpful when you want to duplicate parts of an
image or leave them unaffected by any actions you may perform. However,
when you are working with objects against a solid background color you may
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find it more useful to have that option turned off. This is done by deselecting
the Preserve Base Image command in the Options menu on the Attribute
toolbar. After this, whenever a selection is moved, the area beneath the selec-
tion is filled with the current background color.

Note:  Pressing the Ctrl key as you move an object preserves the base image, irrespec-
tive of its current status.

  

Original image   Preserve base image off     Preserve base image on

Creating smooth-edged selection areas

Sometimes a particular selection area you are working on may have too rough
or too abrupt an edge and may not blend well with the surrounding image. To
help such selection areas blend in better with the base image, choose the Anti-
aliasing command from the Options menu on the Attribute toolbar. Anti-aliasing
works by smoothing out selection area edges and is especially helpful in
keeping curved selections smooth. However, since Anti-aliasing modifies the
edges of selection areas, the extent of the selection area may seem to have
changed.

Softening a selection edge

To make the edge of a selection area appear diffused, creating a “halo” like
effect, use the Soften command from the Edit: Selection submenu. (This
command is also available when you right-click over a selection area.) You can
specify the edge width to soften (from 1 to 150 pixels) in the Soften dialog box
that appears when you choose this command. After applying this command the
selection area takes on a diffuse edge corresponding to the amount of soften-
ing. A Soft edge entry box appears on the Attribute toolbar of both the Stan-
dard Selection and Lasso tool, creating a soft edge effect around your selection
as specified in that entry box.

Note:  If you do not have the Preserve Base Image command selected and you move the
selection, you will notice the base image shows a corresponding diffuse-edged hole filled
in with the background color where the selection area was created.
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Softening a selection area

Selecting a border area

When you want to add a frame or border to part of an image, or draw a box or
circle around it, click the Edit: Select - Border menu command. (This command
is also available when you right-click over a selection area.) The Border com-
mand allows you to include a border of painted pixels around the edge of the
current selection area. You can specify the width of the border (from 1 to 64
pixels) in the Border dialog box that appears when you choose this command.
(Half the specified width appears on the inside of the selection and half on the
outside.) You can also set the border to have a soft edge causing the border
edges to blend in with the surrounding image. After defining a border you can
then fill it with a color or texture to create a frame, box, or circle.

  

Original selection    Applying a border       Filling the border

Adding to or subtracting from a selection

PhotoImpact enables you to select multiple parts of an image at one time. You
can, for example, use the Lasso tool to select a tree in an image and then go on
to select other trees as well. In the same way, you can also exclude portions of
existing selection areas. To select additional areas of an image or to extend an
existing selection area, make your initial selection and then click the Mode drop-
down menu on the Attribute toolbar and choose Add or press the "A" key while
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selecting more of the image (the pointer changes to display an addition sign). If
you wish to exclude an area from an already selected area, choose Subtract or
press the "S" key as you select the unwanted area (the pointer changes to
display a subtraction sign) – the selection is redrawn so that it no longer
contains that area.

Note:  If you do not have a selection area, using Add or Subtract has no effect and will only
create a new one.

  

 Adding to the selection Subtracting from the
selection

Expanding a selection area

In addition to changing the mode to select more of an image, you can also
expand selection areas by clicking the Edit: Select - Similar menu command
(This command is also available when you right-click over a selection area.)
Using this command you can select similar colors in an image, such as the blue
sky in a city skyline, all occurrences of white in an image, or all the letters in a
word. The Similar command is much like the Magic Wand tool (see p.51)
except that it acts on already existing selection areas, either expanding the
selection to include neighboring areas of similar pixels or similar pixels from the
entire image.

Another way of expanding and shrinking selection areas is by using the Expand/
Shrink command on the Edit: Selection submenu (also accessed by right-
clicking over a selection). Enter a value (0 to 64) to specify the number of
pixels to expand or shrink. Check the Keep original soft edge option if you want
to retain the soft edge value of your original selection to expand or shrink.
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Using Grayscale masks

PhotoImpact gives you the option of creating and editing grayscale masks that
control not only the areas of an image that are selected, but also by how much.
This means that when you use a paint tool or apply an effect to the masked
area, they have only a partial effect on that area. A grayscale mask is especially
useful when you want to create a fade between two images, where one gradu-
ally fades into or out of the other.

Creating a Grayscale mask

Any Grayscale image can be used as a Grayscale mask. To convert a selection
area into a Grayscale mask, drag the selection (with the M key held down) onto
the workspace. The selection automatically opens as a grayscale image in its
own image window. (If the selection is regular in shape, it appears white. If it
is irregular in shape, the area not selected is filled with black.)

Note:  You can also use the Import and Export Selection commands in the Edit: Select
submenu to save and open Grayscale mask files as a selection or to a new document, file
or album. (This submenu can also be accessed by right-clicking over a selection area.)

Editing a Grayscale mask

Because a grayscale mask is actually a Grayscale image, you can edit the mask
with standard paint tools and enhancement commands. This enables you to alter
areas of the mask to make them more or less transparent. As you edit, do keep
in mind the following key points:

• Black areas are not selected.

• White areas are selected.

• Gray areas will be partially selected: the closer to white the greater the effect;
the closer to black the less the effect.

  

Original selection   Grayscale mask      Edited Grayscale mask
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Using a Grayscale mask

Once you have created or edited a Grayscale mask, you can now use it in any
other image. The easiest way to do this is to first save the mask in the Object
Library as a selection (see p.64) and then drag it back onto the image you want
to edit. Now whenever an effect, paint tool, or object is applied over the mask,
its effect is directly related to the shade, or transparency of the mask at that
point.

Note:  When a mask containing gray shades is dragged onto an image, the selection
border may not appear to accurately represent the mask. This is because the selection
border only shows the edges of areas in the mask that go from a value less than 128 to a
value greater than 128. If your mask is very dark, containing only gray values below 128,
no selection border will be shown: if it is very light, containing only gray values greater
than 128, the entire image will appear to be selected.

  

Mask applied to original       Changing the hue Copying the image to
image as a selection another

Working with objects

Much of the power of PhotoImpact lies in its ability to create, manipulate, and
transform objects. Objects are created whenever you move a selection, paste
an image, or perform a transformation. Once created, objects float above the
base image in independent layers, allowing you to freely move and manipulate
them without affecting other objects or the base image. You can even drag it
outside your current image to create a new one if, for instance, you want to
combine it with another object or image. When finished working with objects,
you can then merge them back into the base image.

Managing object layers

As easy as it is to create objects, the more objects you create, the more impor-
tant it is to keep track of them. To help you manage objects, PhotoImpact
provides the Layer Manager on the EasyPalette, opened by clicking the
EasyPalette button on the Standard toolbar and selecting Layer Manager.
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Whenever you view the Layer Manager, all objects present in the active image
appear as thumbnails, each with a sequential creation number. An open eye icon
on the thumbnail indicates that the object can be viewed. (To show or hide an
object, open the Object Properties dialog box and check or deselect the Show
option.) By clicking on a thumbnail, you select that object in the image. Once
selected, the object appears with an animated marquee. (If the object is hidden
behind other objects, only the animated marquee is displayed.)

Note:  You can make inactive objects (and selection areas) more noticeable by displaying
them with darkened borders by checking the Highlight inactive selections and objects
option in the Preferences dialog box (see p.22).

  

An image with its objects displayed in the Layer Manager

Grouping and ungrouping objects

In the course of editing, you may find it convenient to group objects together so
that you can move them as a unit or act on them collectively with a specific tool
or effect. To do this, hold down the Ctrl key and click the thumbnails of the
objects you want to group in the Layer Manager. (Each selected thumbnail
appears with a blue border and the corresponding objects in the image are
selected.) Selecting the Group command from the Thumbnail menu groups the
selected objects together and the thumbnails on these objects are marked as G1,
indicating that the thumbnails belongs to the first group (G2 appears for the
second group, and so on).

Note:  You can also select objects to group directly from the image.

After grouping objects together you may need to ungroup them to act on a
specific object within that group. To do this, select Ungroup from the Thumb-
nail menu. All objects in that group are now ungrouped and can be acted upon
separately.

Note:  Text/Path-based objects with shadows cannot be grouped nor ungrouped as they are
already considered 'grouped' (the main object is grouped with the shadow object.)
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Changing an object’s layer in an image

When an object is created, by pasting or from drag-and-drop between images, it
is automatically placed on the top layer of an image, covering the base image
and any other objects that may be present. (Converting a selection to an object
immediately places it on the lowest layer.) Once you have several objects, you
may find the need to position them above or below the others. To do this, use
the four arrow buttons that appear on the Attribute toolbar when the Pick tool is
selected. From left to right, the four arrow buttons move an object up one level,
down one level, to the top level, and to the bottom level.

Note:  You can also change an object’s level by dragging its thumbnail in the Layer
Manager to a different position relative to the other thumbnails. (The first thumbnail is on
the top layer, while the last thumbnail is on the bottom layer.)

 

An example of changing the layer of objects in an image

Setting an object’s properties

PhotoImpact gives you control over all the objects in your image and how they
appear. By specifying object properties you can make objects appear to blend in
with other objects and the base image. To set an object’s properties, double-
click the object or click the Edit: Object - Properties menu command, (this
command is also available when you right-click over an object).

OBJECT PROPERTIES DIALOG BOX
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Name – specifies the name of an object (up to 16 characters).

Merge  – sets the color factor for the object. You can choose from:

• Always displays the object as is.

• Hue & Saturation displays only the object's color and intensity values.

• Hue Only displays only the object's color information.

• If Lighter displays only the pixels in the object which are lighter than the underlying
image or object.

• If Darker displays only the pixels in the object which are darker than the underlying
image or object.

• Lighting displays only the lighting effects of the object against the underlying image or
object.

• Difference displays the color differences between the object and the underlying
image or object (calculated by finding the mean between the color values of each pixel
in the object and those of the area directly underlying it.)

• Addition adds the color values of the pixels in the object to those in the underlying
image or object and displays the object with the newly calculated color values.

• Subtraction subtracts the color values of the pixels in the object from those in the
underlying image or object and displays the object with the newly calculated color
values.

• Multiple multiplies the color values of the object with those of the underlying image or
object and displays the object with the newly calculated color values.

• Inverse of Multiple multiplies the color values of the object with those of the
underlying image or object, then inverts it before displaying the object with the newly
calculated color values.

Transparency  – controls the object's degree of transparency. A value of 0 means the
object is opaque whereas a value of 99 means the object is totally clear or transparent.

Soft edge  – determines how the object’s edges blend with the base image or any
underlying objects.

Transparent color  – sets which color in the object will be made transparent. For
example, you can specify that the red color in an object be transparent, therefore allowing
the base image or any underlying objects to show through.

Similarity  – allows you to determine a range of colors to be made transparent, based
on the Transparent color. Use this if the color you want to make transparent does not
appear as a soild color throughout the object. For example, it may consist of a range of
reds rather than a single red.

Position  – specifies the horizontal and vertical position of the object on the image. A
value of 0 flashes your object to the extreme left or top. The higher the value, the farther to
the right or to the top the object will move.

Show  – displays or hides the object in the image window. Objects that are hidden still
appear as thumbnails in the Layer Manager window, and their properties can still be
modified.

Lock  – controls the mobility of the object. If selected, the object will be locked in
position and cannot be moved. The Position area will be grayed out.
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Real-time preview  – allows you to see how the modifications will appear on your
image. If selected, any changes made will be reflected on the image immediately. If cleared,
you will see the effects of your work only after clicking OK.

URL – gives you the option of making an object a web clickable area or an image map.
There are a total of four image map shapes to choose from.

Adding shadows to an object

PhotoImpact provides a useful way to introduce depth to an image by applying
a shadow to an object or group of objects. To add a shadow, click the Web:
Object Shadow Designer menu command. (Alternatively, you can right-click
over an object and select Add Shadow from the popup menu.) This opens the
Add Shadow dialog box that allows you to control the direction, length, trans-
parency, edge blending, and color of the shadow.

Whenever you create a shadow, it is an independent object grouped together
with the object it was created from. In this way, whenever you move a shad-
owed object both the object and its shadow move together. (You can,
if necessary, choose to ungroup shadowed objects with the Ungroup command
in the Edit: Object submenu.)

  

Appyling a shadow to an object

Notes:
• When adding shadow to Text/Path-based objects, no dialog box will appear. Instead,

shadow will be applied directly to the object.
• You cannot ungroup shadowed Text/Path-based objects. You can, however, remove the

shadow by clearing Shadow from the Style menu on the Attribute toolbar. You may also
modify its shadow properties by choosing Options from the Style menu.

Sorting objects

When working with large numbers of objects in an image, you may find it
helpful to use the sort commands to arrange the objects’ thumbnails in the
Layer Manager. This helps you to easily keep track of your objects. You can

10
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sort object thumbnails with the Sort By Depth, Sort By Name, and Sort By
Group commands in the Layer Manager menu.

• Sort By Depth arranges the thumbnails according to their level above the
base image, with the highest level object displayed first. Since each object
floats at a different level, this sorting option is useful for showing how
objects are stacked.

• Sort By Name arranges the thumbnails alphabetically by their name. This
sorting option is useful when you want to find an object by its name. You
can modify an object’s name through the Properties dialog box accessed by
double-clicking over an object.

• Sort By Group arranges the thumbnails by the groups defined using the
Group command. The thumbnails of the first defined group are displayed
before the thumbnails of the second group, and the third, and so on. This
sorting option is useful when you have several groups and want to select a
specific group of objects to act on.

Copying and moving an object between images

PhotoImpact allows you to move objects between images and is quite useful
when you have created an object in one image and want to use it in another
image. To move objects between images, drag the object from the source image
and drop it onto the destination image. The object is removed from the source
image, and placed into the destination image. (If you want to copy an object,
hold down the Ctrl key as you release it.)

Duplicating an object

To help speed up and simplify your work, PhotoImpact allows you to duplicate
any object or group of objects that you have created. This is especially helpful
when you have put the finishing touches on a specific object or group and you
wish to use several copies of that object or group in your image.

To duplicate an object or group, first select it and then click the Edit: Object -
Duplicate menu command (also available from the right-click popup menu).
Holding down the Ctrl key while dragging can also duplicate an object. A copy
of the object or group appears next to the original. You can then position and
act on the duplicate as you wish.
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Deleting an object

As you work with objects you may, for various reasons, end up creating more
objects than you wish to have in your image. To delete an object or group of
objects, click the Edit: Object - Duplicate menu command. The object or group
is deleted from the image window and their corresponding thumbnails disappear
from the Layer Manager.

Retrieving an object’s original appearance

When working with objects, you may find it desirable to revert back to the
original form of an object. The object may have lost the “look” that you wanted
or you just wish to start over. In any case, PhotoImpact makes it easy for you
to revert to an objects original appearance by clicking the Edit: Object- Revert
menu command. (This command is also available on the right-click popup
menu.) When you choose the Revert command, the object immediately reverts
to the form it had when created.

Notes:
• The Revert command should not be confused with the Restore command in the File

menu which closes and then reopens the image file.
• The Revert command is disabled whenever the Preserve Base Image command is

cleared.

Using the object libraries

As you create and edit images with PhotoImpact you will come across portions
of an image or selection areas that you may want to save for later use with
other images. Normally, this means saving that portion of an image as a sepa-
rate file and then opening it later. PhotoImpact provides a more convenient way
to store images and selections with a unique and easy-to-use feature – the
Object Libraries.

You can open the Object Libraries by clicking the EasyPalette button on the
Standard toolbar. This opens the EasyPalette displaying the last opened gallery.
Click the Object Libraries menu and choose from among the range of libraries
available. The selected library opens, complete with thumbnails of any images,
paths, and selections that have been stored there.
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The Path Library

Saving selections to the object libraries

You save a selection to the any of the available Object Libraries by dragging it
from an image to a tab group in the Object Library window of the EasyPalette.
(You can also click the Edit: Selection - Copy Selection to Object Library menu
command or simply click the Add button on the Attribute toolbar). The selec-
tion is then automatically saved as a file (in the folder specified at the time the
group was created), and a thumbnail of the selection appear in the library.

When you add an object or selection to the Object library, an Add to EasyPalette
dialog box opens, prompting for a name for the new object or selection. You
can choose the library from among the options and the tab group to which it
belongs. You may also add multiple objects into the EasyPalette as single
thumbnail with its object properties retained.

Note:  Holding down the M key as you drag an object into the Object Library automatically
saves it as a selection.

Saving selections to a file or document

Although the object libraries in the EasyPalette allow you to easily save selec-
tions, there may be times when you want to use a selection on another machine
or save it to a secondary storage device. PhotoImpact provides a direct method
of doing this with the Export Selection command on the Edit: Selection
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submenu. This opens the Export Selection dialog box and allows you to save
the current selection area as a Grayscale image in a file format of your choice
to either a new document or a file.

Note:  In general, do not save masks in a format that involves “lossy” compression (like
JPEG). These formats will damage the original mask.

Retrieving an image or selection

Just as you save images and selections by dragging them into the Object
Library, you can retrieve them by dragging them from the Object Library into
an image window or the workspace. Dragging an object to the workspace
creates a new image window containing the image or selection as an object.

If you drag an object back to the image that it originally came from or another
of equal size, the object is placed on the image in its original position. (If the
destination image is a different size, the selection is placed at the position of
your mouse.) This feature is especially helpful when you want to preserve the
position of image elements in an image whose background needs changing. In
this case you would select and drag each element into the Object Library,
modify the background, and then drag each image element back onto the
image. Each image element is repositioned automatically. This feature is also
helpful when working with image and animation sequences for preserving the
position of stationary objects across all the images in the sequence.

Notes:
• When placing a selection that has been created from a Grayscale image into an

Indexed-Color or Black & White image, the gray areas of the selection are converted
to pure black or white.

• To import a previously saved selection (or any grayscale image) into the active image
as a selection area, use the Import Selection command in the Edit: Selection
submenu. (This submenu can also be accessed by right-clicking over an object in an
image.)

Sharing Object Libraries with other users

PhotoImpact allows you to share your custom libraries with other people,
across a network, or over the Internet. To save a particular gallery or library
and all its thumbnails, select the Gallery Manager – Export or Object Library
Manager – Export menu command. This allows you to save a copy of the
Gallery Files (*.smp) or Ulead Object Library file (*.uol) and all thumbnails to a
designated folder, and then zip the files up and distribute them. Thumbnails are
saved in the Ulead Object File format (*.ufo).
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Working with Object Library thumbnails

Objects stored in an object library can be managed by right-clicking over a
thumbnail and selecting a menu command from the resulting popup menu. This
makes it handy to quickly delete, copy, or cut an object thumbnail to and from
the library. Additionally, you can select Description to rename a thumbnail or
append descriptive information to it. The Store Image command stores all new,
incoming objects as images, replete with object attribute information, while the
Store Selection saves objects only as selection areas. The advantage to this is
that you can save frequently referenced images as smaller size thumbnails by
saving them as selections as opposed to images. However, if you need to use
not only an image but its associated attributes, then save objects as Images.

Modifying a thumbnail's properties
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The chapter in review

Here are some key points and tips to remember from this chapter:

• Customize how PhotoImpact works to improve your efficiency at image
editing as well as improve your system's performance (p.22).

• The Batch Manager (Window: Batch Manager) allows you to apply the same
command or commands to multiple files at once  (p.29).

• Use the Quick Command Panel to record common tasks and perform them
again later by rote (p.31).

• Undo allows you to recover quickly from mistakes (p.32).

• The Global Viewer allows you to quickly navigate around an overly large
image or a zoomed one (p.42).

• Save objects and effects to the EasyPalette for use again later (p.45).

• The Selection tools allow you to create a multitude of unique selections for
manipulation or enhancement (p.48).

• Objects are selection areas that 'float' above the rest of the image, indepen-
dent of it (p.58).

• Create interesting effects and customize objects in the Object Properties
dialog box (p.60).

• Save frequently used or special objects to Object Libraries on the Easy
Palette (p.65).

Other topics of interest

If you would like to learn more about:

• Enhancing images and objects see Chapter 4 (p.85).

• Adding special effects to your images or objects, see Chapter 5 (p. 127).

• Imaging for the web, see Chapter 6 (p.161).

• Managing your images, see Chapter 8 (p.217).
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Chapter 3

In this chapter you will learn:

• Acquiring images ......................................................................................... 70

• Acquiring a good image ............................................................................... 77

• Stitching images together ............................................................................ 78

Acquiring Images

PhotoImpact allows you to acquire and edit images from either your

digital camera, scanner, photo CD, or the Internet. This chapter ex-

plains how to access and calibrate your acquiring device, obtain good

input results, perform automatic post-processing and stitch together

image strips to form a new image.



PHOTOIMPACT USER GUIDE70

Before you begin

PhotoImpact allows you to acquire images from a scanner, digital camera or
other input devices through a variety of software drivers. However, since each
software driver works differently, many of the actual image acquisition options
will differ depending on the input device. For this reason, the full range of
possible acquisition options are not discussed in this chapter. For more detailed
information about such options and how they are implemented by an installed
software driver, please refer to your image input device’s software driver
documentation or Online Help.

Acquiring images

PhotoImpact makes it possible for you to import images from any image input
device that is TWAIN compliant. This capability allows you to acquire photo-
graphs, slides, and printed material, or capture frames from a camcorder, VCR,
digital camera, or even your television, and then convert them into images that
you can modify with PhotoImpact’s powerful editing and enhancement tools.
Later in this chapter, you will find some tips on how best to get images into
PhotoImpact.

TWAIN

TWAIN is an industry standard for image input devices, drivers, and software
applications that allows any TWAIN-compatible software application to acquire
image data from any TWAIN-compatible device. By being TWAIN-compatible,
PhotoImpact can work with all TWAIN-compliant devices to allow you to scan
all kinds of images.

If you have a TWAIN-compliant device, you should follow its installation
procedure. Once correctly installed, you will be able to use the device from
PhotoImpact or any other application that supports TWAIN without worrying
about compatibility problems.
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Image sources

There are a multitude of sources for you to acquire images from, the most
common being photographs you yourself have taken, pictures from magazines
or sketchbooks, and, of course, the Internet. The following section discusses
the 4 most common sources – scanners, digital cameras, photo CDs, and the
Internet. When acquiring images from these sources, there are a variety of
factors to be considered.

Selecting an image source

Before acquiring an image, you first need to select which device you want to
acquire an image from. You might, for example, have a flatbed scanner, a digital
camera, and a video capture device connected to your PC, and since each
device may have its own TWAIN driver, you need to select each one separately.
To do this, click the File: Digital Camera - Select Source or File: Scanner -
Source menu command (depending on whether you're acquiring an image from
a digital camera or a scanner). This opens the Select Source dialog box which
displays a list of TWAIN devices on your system that you can choose from.
Once selected, a TWAIN device becomes the source for image data whenever
you select the Device name command from the File: Source submenu and
remains the source until another device is selected.

Note:  If you only have one TWAIN device connected to your PC, that device is automati-
cally selected as the TWAIN source.

Getting started

After selecting your TWAIN source, you can acquire an image by clicking the
Scanner or Digital Camera buttons on the Standard toolbar or by selecting their
respective commands from the File menu. This opens the Acquire dialog box,
allowing you to choose between Basic and Advanced. Basic acquire scans your
image using the default settings while Advanced lets you specify the destination,
calibration, and post processing options for the acquired image.

The Acquire dialog box
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You can choose to set these options before acquiring an image or you can
acquire an image directly by pressing the Acquire button in the Acquire Image
dialog box. Doing so opens the TWAIN driver and displays a dialog box contain-
ing your device’s imaging options. For more information on specific imaging
options, see your image device’s documentation or Online Help.

Note: If you click the Select Source button and you do not have a TWAIN device installed,
you will see an error message. If you do have a TWAIN device, but it is incorrectly
installed, a dialog box appears containing configuration options.

The Acquire Image dialog box

Setting the destination

The destination options in the Acquire Image dialog box allows you to send your
imported images directly to any or all of the following destinations:

• New image opens an acquired image in its own image window in the
PhotoImpact workspace.

• File stores an acquired image in a file as specified. Click the File name button
to specify the filename and location. File names must end with a number,
allowing PhotoImpact to save multiple images by auto-numbering the files.
This is especially useful when you want to store multiple pages of a docu-
ment for optical character recognition (OCR) at a later time.

Note:  After entering a file name, it is displayed in the Acquire Image dialog box below the
File destination option.

• Printer  sends an acquired image to be printed on your PC’s default printer.
This destination option makes it easy for you to turn your PC system into a
high quality copy machine. Click the Setup button to specify the printer
options.
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• Fax/Mail  sends an acquired image to either your PC’s fax device or to your
mail software. This option operates in the same manner as the Send com-
mand on the File menu and makes it easy to scan in handwritten text and
images and send them off as a fax or as an e-mail attachment. Click the
Setup button to open the Send dialog box.

Note: For more information on the Send Mail dialog box, see “Sending images by
electronic mail,” p.31.

Calibrating your input device

The Calibration tab in the Acquire Image dialog box allows PhotoImpact to
automatically adjust an image’s tone as it is acquired. An extensive range of
calibration schemes allow you to correct color problems that arise because of
the different ways that your monitor, video display card, and input device handle
colors. The calibration schemes include corrections for many common color
problems as well as calibration schemes for many of the most popular scanner
models.

To apply a calibration scheme to an acquired image, select the Apply
calibration scheme checkbox and choose a scheme from the Scheme list box.
These schemes are actually tone maps created through the Tone Map dialog box
and adjust the different pixels of an image in several ways. If, for example, your
scanner tends to wash out detail in highlighted areas and make shadowed areas
appear too dark, you can create a tone map that darkens highlighted areas and
lightens shadowed areas, and apply that tone map automatically every time you
scan an image.

To add a calibration scheme:

1 Create a new tone map by using the Tone Map dialog box, opened by
selecting the Format: Tone Map menu command.

2 Save the tone map as a file with the *.MAP extension and close the Tone
Map dialog box.

3 Open the Acquire Image dialog box and click the Add button in the Calibra-
tion tab.

4 Select the new tone MAP file and click OK. The new tone map is added as a
calibration scheme which you can select from the Scheme list box.
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Post-processing options

The post-processing options in the Acquire dialog box allow you to automatically
apply several basic but powerful enhancements to an acquired image. These post-
processing enhancements analyze and modify an acquired image to correct basic
image problems, improving the image’s appearance. The following post-process-
ing options can be applied by selecting the appropriate checkbox (when in Manual
or Auto mode).

• Straighten straightens out an image that is acquired in a crooked or skewed
manner.

• Crop removes excess blank space in an image, cropping an image down to the
smallest rectangle containing relevant image data.

• Adjust focus adjusts the look of the image to make it either sharp or blurry.

• Adjust lighting  balances the brightness level in an image.

• Magic frame adds a frame, shadow, and canvas border to an image. Click the
Attributes button (only applicable when in Auto) to specify the Frame and
Shadows properties.

When the image is acquired, each of the selected post-processing options are
applied only after you close the data source dialog box.

Notes:
• When in None or Wizard mode, all the processing options are not applicable.
• For more information on post-processing options, see “Automatically enhancing an

image” on p.86. Also see "Using the Post-Processing Wizard," p.75.

Acquiring images from digital cameras

Digital cameras, like scanners, allow you to use the TWAIN interface to commu-
nicate between your PC and the camera, and then download the images stored
there. To open a connection with the digital camera connected to your computer,
click the File: Digital Camera - Camera name menu command or click the Digital
Camera button on the toolbar. If you don’t have a default device set,
PhotoImpact prompts you to select one (you can also select the device by
clicking the File: Digital Camera - Select Source menu command.) The camera’s
capture interface opens, allowing you to select the images you want to download
from the camera to your computer. For more on using the camera’s capture
interface, please refer to the documentation that came with it.



ACQUIRING IMAGES 75

Acquiring images from scanners

Scanners are perhaps the best source around for getting images from “hard”
sources such as magazines, books, photos, and paper. The most common type
of scanner is the flatbed scanner, which is nothing more than a fancy copying
machine. The only difference here is that the “photocopied” image is sent
directly to the computer instead of to hard copy output like paper or overhead
film. To negotiate the interface between scanner and computer, TWAIN, the
industry standard software protocol, allows any scanner to communicate with
any piece of hardware running TWAIN software. For more on TWAIN, refer to
p.70.

Because individual scanners translate real-world images and objects into digital
information in different ways, you will invariably need to clean up the images
you downloaded to your computer (usually, this consists of adjusting the
brightness and contrast, among other things.) For more on retouching scanned
images, see p.86.

Using the Post-Processing Wizard

When scanning images, sometimes you'll want to clean them up – the Post-
Processing Wizard makes this a quick and painless task.  The Post-Processing
Wizard  examines and applies necessary modifications to enhance your images.
It provides you with a series of image enhancement commands that help you
straighten your images, crop them to remove unnecessary spaces, give them a
more focused look, adjust the brightness and color balance, remove red eyes,
and create pre-defined and custom frames. You can set PhotoImpact to run the
Post-Processing Wizard automatically from the Advanced image acquiring
dialog box.

To run the Post-Processing Wizard:

1 Click the Post-Processing Wizard button on the Standard Toolbar or click
the Format: Post-Processing Wizard menu command. The Post-Processing
Wizard dialog box opens.

2 Click Next to go to the succeeding post-processing option and select the one
you wish to perform. This opens the selected option's dialog box and allows
you to make modifications. A Reset button exists in each of the post-
processing options, allowing you to go back to your original image before
the Post-processing function is performed.
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Any modifications made by the wizard will be reflected on the actual image
to which you want to apply the command. Click Preview if you want to see
an actual view of how your processed image looks. Click Cancel to abort
the said option and go back to the main post-processing dialog box.

3 Click OK to apply the command to your image. This closes the selected
option's dialog box and bring you to the next post-processing option.

4 Click Finish once you are done processing your image. The dialog box
closes and the post-processing options are applied to the image.

Acquiring images from the Internet

With the boom of the Internet, it has become increasingly more popular and
easier to acquire images from the web. Most people who download images
from the Internet – whether they be of a favorite celebrity, cartoon character,
or just a cool image happened across while surfing the net – then modify them
a little bit to put onto their own web site or create desktop wallpaper.

Acquiring images from the web is relatively easy. The images are already
'scanned' and all that needs to be done is for you to download them to your
computer. When you encounter a cool photo on the Internet that you want to
use, simply drag it from the browser window into PhotoImpact to open it for
editing. If the image is a hot link, dragging it into PhotoImpact is an impossibil-
ity, so you'll have to save it manually to a local folder via the browser's Save
Image As menu command (usually available from the popup menu that appears
when you right-click over an image.)

However, there is one very important factor to consider when acquiring images
from the Internet – copyright violation. It is essential to note that by copying
images from other people's web sites, you may have already violated the
copyright law – whether U.S. or International or both. Ideally, first ask permis-
sion of the owner for the right to use their creations. If the web site owner isn't
the copyright holder for that particular image, then the best thing you can do is
either track down the person who is, or leave the image alone.

Files saved from the web are invariably either GIF or JPEG. Recently, however,
the PNG image type has gained popularity so it's not altogether uncommon to
encounter files of this type.

Note:  Files saved as GIF files are in their 256-color data type while those saved as JPEG
files are True Color images. You can always change the data type of your 256-color GIF
files to True Color images.
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Acquiring images from photo CDs

Another great source for obtaining interesting photos is through a photo CD.
Photo CDs are huge collections of (generally) royalty free images in both high-
and low-resolution formats which you can easily use as long as you paid for the
disc. Royalty-free means that you've already paid for the 'rights' to use and, to
a limited extent, redistribute the images on the disc simply by purchasing the
CD. However, before you do anything with a photo CD image, read first the
License Agreement that comes with it so you know exactly what you may, and
may not, do with the images. Not all photo CDs offer you the same rights.
Photo CDs are available in bookstores, online, and in most software stores.

To acquire images from a photo CD, simply double-click the icon for the image
you wish to open, and it opens in PhotoImpact as long as that file format type
is associated with the program. You can also drag-and-drop images from the
photo CD into PhotoImpact or first catalog them using Album and open them
from there. Generally, this is best as it allows you to get a preview of all the
images first without having to open each one individually. For more on using
Album to catalog images, see Chapter 8.

Acquiring a good image

The best way to ensure that a finished image is of the highest quality is to start
with a carefully acquired image. The following tips are provided to help you get
the best results quickly when acquiring an image.

• Limit your image size whenever possible.
A small image requires much less hard disk space and processing time than a
large image. Always note the scanned image size in KB. If the scanned image
size approaches or is larger than your available disk space, adjust the scan
size downward before scanning.

• Scan to the same color mode as your intended output device.
OCR text: Black and White
Line art: Black and White
Laser printer: Grayscale mode
Monitor: 256/True Color (depending on your video driver)
Post production: True Color

• Scan high quality images and text.
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When scanning images, some information is invariably lost. If the output
device does not match the resolution of the scanned image or if the output
device cannot reproduce the color shading equivalent to that displayed by
your monitor, further information will be lost. Scan quality can only be as
good as the original image. Minimize these problems by avoiding scanning
materials that are either extremely light or dark, damaged or unclear.

• Scan photographs instead of printed pictures.
To help preserve accurate toning details, scan photographs instead of images
that have been printed in magazines or books. Printed pictures have already
been half-toned or dithered and are composed of tiny dots. Typical resolution
for color typesetting is 180-400 dpi with a halftone frequency of 90 to 200
lpi, so when printed images are scanned in at a higher resolution, no better
quality is obtained. In fact, at too high of a resolution, the scanner can see
the individual color dots and may produce a moire pattern.

• Do not always select the highest resolution.
High resolution images, especially 24-bit color images take enormous
amounts of disk space. There is no benefit gained if your image is scanned at
a resolution far higher than your intended output device is capable of produc-
ing. If you plan to display the image on a monitor you should select a 72 or
96 dpi resolution. However, if you wish to output to a colored printer, you
will want to scan the image in at between 150 and 300 dpi. (However, if you
want to enlarge a small photo, try a higher resolution.)

• Experiment with different settings.
Acquire images using different settings and then compare them on your
screen to verify which one suits your particular printing or imaging
requirements. You will find that PhotoImpact has many functions that allow
you to manipulate the acquired image to get the best results.

Stitching images together

If your image input device cannot handle larger images in one pass, such as
what may have happened when you are using a handheld scanner, PhotoImpact
enables you to input an entire image by scanning in strips and then joining the
resulting image pieces. In this situation, the ability to join images accurately and
efficiently is essential. PhotoImpact provides both automatic and manual image
stitching to aid you in reconstructing an image from multiple pieces with the
Stitch command.
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Clicking the Edit: Stitch menu command allows you to stitch any open image in
the workspace together with the currently active image. This process involves
choosing an image to join with the active image, floating that image into the
proper position over the active image through an automatic or manual process,
and then stitching together the images by combining the overlapping regions.

The way in which you use the Stitch tool to join image strips depends entirely
on the condition of the images you have. Some images are well suited for
automatic stitching and others may require manual adjustment. For this reason,
Stitch provides multiple options and controls for both manual and automatic
stitching, giving you pixel-level control for seamless joining of images. With the
Stitch tool, you can:

• Set auto-stitching parameters and make PhotoImpact automatically match
and align the floating image over the active image.

• Drag the floating image until it matches up with the active image.

• Define a reference point in each image which PhotoImpact then uses to align
the two images.

• Select Auto fine tune to help the images snap into the correct relative position
and aid in manual stitching.

• Set the transparency of the floating image to aid manual stitching and to
define how images are combined in the overlap area.

Notes:
• You can only join images that share the same data type and are either Grayscale or

True Color.
• The Stitch tool only works with base images, objects cannot be stitched. If you wish to

stitch an object, it must first be merged onto the base image.
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THE STITCH DIALOG BOX

Stitch with  – enables you to select an image from any that are open in the PhotoImpact
workspace. Click on the combo box to choose an image.

Overlap area transparency  – allows you to specify the transparency of the floating
image. While you are placing the floating image, use a transparency of 50 to enable you to
see both images equally. Before stitching, choose another transparency to define how the
area of overlap appears after stitching. Selecting 0 causes the floating image to obscure
the active image in the area of overlap, while a value of 99 causes the active image to
obscure the floating image.

Manually  – allows you to position the floating image over the active image by dragging
it with the mouse.

Auto fine-tune  – automatically adjusts the position of the floating image immediately
after you have moved it by dragging or by defining matching points. To be successful, the
floating image must be placed fairly close to its final destination (within thirty pixels either
way). This option usually achieves the best result with the least amount of effort.

Auto stitch  – sets the Stitch tool to automatically align the floating image over the
active image based on the specified overlap and tolerance parameters. When this option is
selected, a horizontal or vertical line appears on the active image. This line represents the
approximate position to which the floating image should overlap. This line is moved by
adjusting the Overlap range spin box.

Overlap range  – specifies the amount of overlap in the images to be stitched. If the
overlap is too small (less than thirty pixels), the chance of a successful match is greatly
reduced.

Horizontal/Vertical tolerance  – allows you to provide for misalignment in the
direction perpendicular to the stitching direction. The tolerance should be slightly greater
than the distance the floating image needs to move (horizontally or vertically) to align with
the active image.
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Test – automatically repositions the floating image to match the active image according
to the overlap and tolerance parameters you have defined.

Switch directions  – allows you to specify which side of the floating and active
images to stitch together. Clicking the left button swaps the images left and right. Clicking
the right button swaps the images above and below.

Deskew  – allows you to rotate the floating image with respect to the active image.
Click the left button to define a line to align the image horizontally, and click the right button
to define a line to align the image vertically. This is useful when the image strips are not
quite parallel to each other. (For more information on deskewing an image, see “Automati-
cally enhancing an image” p.86.)

Zoom In  and Zoom Out  – change the view of the images one step at a time. Use
these commands if you want to view a magnified or reduced portion of the images to
enable you to stitch more accurately.

Actual view  – returns the view of the images to the normal (1x) view where each
image pixel is shown by one screen pixel. (If you are already at actual view, this command
has no effect.)

Fit In Window  – displays the images at the maximum magnification that still allows the
active image to fit within the display window.

Automatic image stitching

The fastest and easiest way to stitch two image strips together is by using the
Auto stitch option. This option works for a wide range of images and is
especially useful for images that show a lot of detail and are fairly clear.

To stitch two images automatically:

1 Make one of the images you wish to join the active image.

2 Click the Edit: Stitch menu command to open the Stitch dialog box.

3 In the Stitch with drop-down menu, select the image you want to join to
the active image. The image selected here appears as the floating image in
the stitch window.

4 Use the Direction buttons to place the floating image in the correct position
relative to the active image.

5 Select the Auto stitch option, and then enter values in the Overlap
range and Vertical/Horizontal tolerance entry boxes according to the
approximate percentage of overlap and vertical/horizontal misalignment that
you feel is evident between the two images.

Note: Overlap range or Vertical/Horizontal tolerance values that are off by more than
50% of the image size prevent the Auto stitch option from properly joining image
strips.
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6 Click the Test button to preview the auto stitched image.

7 Click OK. The Stitch dialog box closes and a window appears containing the
newly stitched image.

Manual image stitching

You can use the manual stitching option to join images in unusual ways to
create interesting special effects. Such effects might include placing the same
image against itself or joining a flipped version of an image to the original to
create a mirrored effect. You might also use the manual stitching mode when
your image details are unclear or somewhat blurred or when you are joining
images with small scale repeating patterns.

To stitch two images manually:

1 Follow steps 1 through 4 for automatic image stitching (see previous
procedure).

2 Drag the floating image until you are satisfied with its position.

3 Click OK. The Stitch dialog box closes and a window appears containing the
newly stitched image.

Note:  To improve the stitching accuracy, select Auto fine tune to allow PhotoImpact to
automatically adjust image alignment after you have placed the images in an approxi-
mately correct position.

Stitching images by defining reference points

When you are stitching together images that have fine details in common,
it is quite easy to join them by using a reference point. A reference point can be
any small feature or detail that appears in the overlapping regions of both
images. Once specified, PhotoImpact uses that reference point to stitch the
images together.
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To stitch two images by using a reference point:

1 Follow steps 1 through 4 for automatic image stitching (see previous
procedure).

2 Define a reference point by holding down the Shift key and clicking on a
small detail common to both images in the floating image.

3 Define a matching reference point by holding down the Shift key and
clicking on the corresponding detail in the active image. The Stitch dialog
box closes and a window appears containing the newly stitched image.
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The chapter in review

Here are some key points and tips to remember from this chapter:

• Use the Acquire dialog box to choose either Basic image acquiring or Ad-
vanced image acquiring. Basic acquires the image from the source using the
default settings while Advanced allows you to change them (p.71).

• Use the Format: Tone Map menu command to calibrate your input device
(p.73).

• When acquiring images from the Internet always keep other people's copy-
rights in mind (p.76).

• If an acquired image is too large and was scanned in multiple pieces, use the
Stitch command to unify them (p.78).

Other topics of interest

If you would like to learn more about:

• Enhancing images for the Web, see Chapter 6 (p.161).

• Adding special effects to scanned images, see Chapter 5 (p. 127).

• Cleaning up images, see Chapter 4 (p.85).

• Managing your scanned images, see Chapter 8 (p.217).
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Chapter 4

Image Enhancement

After a comprehensive background on the fundamental concepts and

behavior of PhotoImpact, we'll now take you further to the more

advanced techniques – image enhancement. In this chapter, you will

learn basic image editing operations such as converting data type,

using the Auto-Process feature, adjusting your image's brightness and

contrast, adjusting its hue and saturation, cropping and transforming

images, as well as using the bezier curve and the path tool.

In this chapter you will learn:

• Automatically enhancing an image ............................................................. 86

• Cropping an image ...................................................................................... 87

• Understanding color correction ................................................................... 89

• Working with colors ...................................................................................... 94

• Using the Painting tools ............................................................................... 98

• Retouching images .................................................................................... 104

• Cloning parts of an image .......................................................................... 106

• Filling an area with color, textures, and gradients ..................................... 109

• Using the Transform tool ............................................................................ 114

• Working with paths ..................................................................................... 118



PHOTOIMPACT USER GUIDE86

Automatically enhancing an image

Whether you are learning image editing for the first time or you just don’t have
time for more involved image enhancement, PhotoImpact provides the Auto-
Process commands for automatic and intelligent control over most areas of
your image’s appearance. When using Auto-Process, PhotoImpact examines an
image or object and applies any necessary modifications to make that image
look better. For example, images that have been scanned can often benefit from
simple image processing techniques to correct bad cropping, poor brightness
and contrast, wrong color balance, and other easy-to-fix image problems.

To use Auto-Process:

1 Click the Format: Auto-Process - Batch menu command. The Auto-Process
dialog box opens containing seven auto-process options that you can apply
to an image or object.

2 Click the Auto-Process options that you wish to perform. The options
appear on the process queue from left to right in the order selected, and the
preview image (the right preview window) changes accordingly to give you
an idea of the resulting effect.

The Auto-process options are applied successively in the order of their
selection. You can change their order by dragging them from one position to
another. To remove an option, click its button or drag it off the queue. To
see more clearly how the options affect the image, click Preview. The auto-
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process options are applied to the image and the Auto-Process dialog box is
replaced by a confirmation bar. The OK button accepts the modifications
while Cancel rejects the modifications, thereby closing the confirmation and
returning you to the workspace. The Undo/Redo button allows you to better
compare the before and after views of the modifications and Continue
returns you to the Auto-Process dialog box, allowing you to further edit the
selected options.

3 Click OK. The dialog box closes and the auto-process options are applied to
the image.

Note:  Most of the options in the Auto-Process dialog box can be accessed independently
by choosing their respective command in the Format: Auto-Process submenu.

Cropping an image

There will be instances as you work on your project when you will have images
too large to be displayed and could contain information around the edges that
you wish to discard. In such cases, cropping is the best solution as it trims the
edges of an image and controls the position and size of the subject in that
image. To crop an image, select the area of the image you wish to retain and
select the Crop command [CTRL+R] in the Edit menu. The areas outside the
selection area are then discarded and only the area you've selected are retained.
(However, if you select an object and then choose the Crop command, the base
image and all other objects are cropped, leaving only the selected object as a
new image.)

Notes:

• If you select a non-rectangular area, the image is cropped to the smallest rectangle
that can contain the selected area. Areas outside the selected area, but within the
image frame, are filled with the background color.

• When cropping the base image, any objects are repositioned without merging.
• Use either the Auto-Process Crop option or the Post-Processing Wizard option to

quickly crop an image bordered with surplus empty space.

 

An example of cropping
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Resizing an image

You can resize an entire image in two ways: Changing its resolution or by
resampling. Changing the resolution of an image adjusts its physical size
without changing the actual image data, retaining the original quality.
Resampling an image adjusts the size by discarding data when you reduce an
image and adding new data when you enlarge one. Your choice of method
depends on the quality you want and the target destination for the image.

Changing an image’s resolution

Resolution determines the physical size of an image by defining the size of its
constituent pixels. As you change the resolution, you change the number of
pixels that appear per unit area. For example, increasing the resolution places
more pixels closer together, and thereby reduces the size of the image, while
decreasing the resolution places pixels farther apart, thus making the image
larger. In this way you can resize an image without actually changing the
number of pixels the image contains; as such, you are able to retain the original
quality of the image. Additionally, because no pixels are added or lost, the size
of the image file remains unchanged.

To change the resolution of an image:

1 Click the Format: Resolution menu command. The Resolution dialog box
opens.

2 Choose from among the new resolutions: Display, Printer , or User de-
fined. Select Display if you plan to show the image in a slide show or other
on-screen presentation and Printer if you wish to print the image out on a
black & white printer. When an image appears too large or too small in
another program, such as Microsoft Word or PowerPoint, choose User
defined and enter an appropriate resolution in the entry box.

3 Click OK. The dialog box closes and the settings are immediately applied to
the active image.

Note:  There is no change to the appearance of the image on-screen. Changes are
only apparent when you print the image or place it into another program that reads the
resolution.
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Resampling an image

When you open images, their size on screen is determined by your screen
resolution and the number of pixels the images contain. The Dimensions
command allows you to adjust the number of these pixels in an image. It is
important to note, however, that because resampling changes the number of
pixels in an image, its file size is modified accordingly.

You will want to resample an image when:
• You are preparing images for display on your computer and wish to make

them all display at the same size (in a slide show, for example).

• You are preparing images for a publication and you wish to make their file
size smaller so that they take less time to import into, and print from, your
DTP or word processing program.

• You wish to stretch or squash an image.

Understanding color correction

Learning how to adjust the colors in your image will be very useful in image
enhancement. By using the color correction tools in PhotoImpact, you can, for
example, remove the yellowish tint that makes a photograph look old, make dull
colors stand out, or make a blue sky look bluer. This ability to correct color
becomes extremely important when working with scanned images whose
colors may not match their original source images.

Using the color correction commands

PhotoImpact provides several commands on the Format menu that offer a wide
variety of control over color correction. In most instances, these commands
can be applied to selected areas, objects, or to entire images. However, some of
the commands are not applicable to certain data types or they cannot be applied
to selected areas in certain data types.

When you choose a color correction command, a dialog box opens displaying
sample thumbnails of the currently active image, object, or selection area. Some
commands display nine thumbnails and allow you to move through all possible
settings by clicking on each thumbnail accordingly. Other enhancements display
fewer thumbnails because there are fewer settings or because the number of
controls do not allow for such a thumbnail navigation scheme.
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Notes:
• When a color correction command is applied to a selection area, the selection is

converted into an object.
• Some color correction dialog boxes include refinement settings within their main

dialog box while others include an Options button for opening a separate dialog box of
refinement settings. To jump directly to the options dialog box, select the Don’t show
these quick samples next time check box at the bottom of these dialog boxes. To get
the quick samples back, select the Display quick samples option in the PhotoImpact
tab of the Preferences dialog box, (see p.22).

     

The Format comands from the left: Brightness & Contrast, Color Balance, Hue & Satura-
tion, Focus, and Invert.

To adjust the brightness and contrast values in an image:

1 Click the Brightness & Contrast button on the Standard toolbar or click the
Format: Brightness & Contrast [CTRL+B] menu command. The Brightness &
Contrast dialog box opens displaying nine thumbnails of the active image.
The center thumbnail represents how the current settings affect the image
and the surrounding thumbnails indicate slight variations of these settings.



IMAGE ENHANCEMENT 91

If you want to change which part of the image appears in the thumbnail,
click the Thumbnail button. This opens the Thumbnail dialog box with three
options that allow you to highlight a different portion of the thumbnail
image. The first option uses the entire image as the thumbnail, the second
uses a predefined area at 1x view (change its position by dragging on it in
the sample thumbnail), and the third option allows you to define your own
area to view by dragging your mouse over the sample thumbnail. When
satisfied with the current view, click OK; the dialog box closes, returning
you to the Brightness & Contrast dialog box and each thumbnail is updated
accordingly.

Note:  Any changes you make are still applied to the entire image, selection, or object,
regardless of the area displayed on the thumbnail.

2 Click on what you consider to be the best looking thumbnail. The center
thumbnail is then replaced with this thumbnail and all the others are updated
accordingly. (To change only the brightness or contrast value, you can
adjust their respective sliders.)

If you select the Real-time preview checkbox, the changes are also
reflected on the image. (Clearing this improves the speed in which the
thumbnails are redrawn after each selection.)
Notes:
• The Thumbnail Variation slider controls the degree of variation between each

thumbnail. Moving this to the right increases the variation, left decreases it,
making the variations appear more subtle.

• To preview your changes, click Preview. The dialog box is replaced by a confirma-
tion bar, allowing you to better see the active image. Click Continue to go back to
the dialog box for making adjustments, Undo/Redo to toggle between the original
image and the changes, OK to accept the changes and close the confirmation bar,
and Cancel to abort any changes.

3 When you are satisfied with the appearance of the center thumbnail, click
OK. The dialog box closes and the enhancement is applied to your image.

If you want to save your adjustments for later use, click Add to place the
adjustments in the EasyPalette. (You can give an explanation as its name,
such as “Add highlights to dull images.”) The next time you want to use the
same adjustment, simply drag-and-drop its respective thumbnail from the
EasyPalette onto an image. The adjustment is then automatically applied to
the image.
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To adjust the color balance of an image the “smart” way:

1 Click the Color Balance button on the Standard toolbar or click the Format:
Color Balance [CTRL+L] menu command. The Color Balance dialog box
opens with two tabs: Smart and Preset. Preset has PhotoImpact balance
the colors for you, while Smart allows you to perform your own balancing.
(The behavior of the Preset tab is very similar to that discussed in the
previous procedure about the Brightness & Contrast dialog box.)

2 Click the Smart tab. A thumbnail appears containing a sample of the cur-
rently active image. (You can use the buttons at the bottom of the image to
control the view. For example, repeatedly clicking on the Zoom in button,
increases the magnification of the image.)

The Smart tab works by balancing an image’s color based on a neutral gray.
Having selected an area on the image that should be neutral gray, all other
colors are balanced in accordance with that color. (If your image has no
noticeable gray areas, then it is best to use the Preset tab.) A good choice
for a neutral gray color would be some feature in the image that would
normally appear gray in a properly balanced image, such as a cement
sidewalk, many rocks, tin cans, elephants and so on.

3 Move your mouse over the image. Your cursor automatically becomes an
eyedropper tool. You will see the RGB value beneath the preview image
change as you move your mouse.

4 Click an area of the image that needs correction. Specify the color to
replace by right-clicking on the Desired color box. This displays the Color
Picker pop-up menu. For more information on the color picker, see p.95.

If you have the Real-time preview option selected, the active image will
reflect the changes.

5 When you are satisfied with the changes, click OK. The dialog box closes
and the adjustments are made to the image.

Note:  You can also use the Auto-Process: Batch command with the Balance option to
quickly balance an image’s color (see p.86).

To adjust hue and saturation in an image:

1 Click the Format: Hue & Saturation menu command. The Hue & Saturation
dialog box opens displaying two thumbnails of the currently active image.
The left represents the original image while the right shows how the current
settings affect the image.
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You can determine which specific part of the image you want to appear in
the thumbnail. Simply click the Thumbnail button. This opens the Thumbnail
dialog box with three options that allow you to highlight a different portion
of the thumbnail image. The first option uses the entire image as the thumb-
nail, the second uses a predefined area at 1x view. (You may change its
position by dragging on it in the sample thumbnail.) The third option allows
you to define your own area to view and its zoom level by dragging your
mouse over the sample thumbnail. When satisfied with the current view,
click OK. (You may click Preview to see a clearer view of what you've
accomplished before clicking the OK button.) The dialog box then closes,
returning you to the Hue & Saturation dialog box and the thumbnail is
updated accordingly.

Note: Any changes you make are still applied to the entire image, selection, or image,
regardless of the area displayed on the thumbnail.

2 Adjust the hue and saturation of the image by dragging their respective
sliders or type in the figures directly in the box next to them. The right
thumbnail automatically displays any changes applied to the original image.
Click Preview to get a clearer view of how the commands will affect the
original image before applying them.

3 Once satisfied with the appearance of the right thumbnail, click OK. The
dialog box closes and the enhancement is applied to your image.

If you want to save your adjustments for future use, click the Add button to
place the adjustments in the EasyPalette. As such, you may simply drag the
specific thumbnail from the EasyPalette and drop it into an image. The
adjustment is then automatically applied to the image. (For more details on
saving a special tool's attributes to the EasyPalette, see p.109.)
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Working with colors

One of the most important aspects when it comes to painting is choosing the
right color. PhotoImpact provides a number of ways to help you achieve this
while giving you maximum freedom in your choice of how to display and select
colors. The easiest way to do this is to use the Color Palette.

Using the Color Palette

The Color Palette contains colors that you can apply to any given image. Unless
you hide the Color Palette by clearing the corresponding box from the Toolbars
& Panels dialog box (opened by right-clicking over any of the toolbars and
clicking the Toolbars & Panels menu command), it is always automatically
docked to the right side of the program window when you start PhotoImpact.
(Just in case you find it distracting, you can always move it elsewhere by
simply clicking it and dragging it to any area of your workspace.) The way
colors displayed varies according to the type of image you are working on. For
Grayscale images, the color panel displays shades of gray. Changing to an
Indexed-Color image switches the color panel to display the 16 or 256 colors
from the image’s color table. For True Color images, a complete range of
colors is displayed in individual cells or as a continuous spectrum.

Of the available colors in an image, two are active at any given time. These two
colors, referred to as the foreground and background colors, are displayed in
the color squares just below the color area on the color panel. The foreground
color is in the front, slightly lower and to the right of the background color.
Clicking on any of the colors displayed in the color panel selects the color as
foreground, while right-clicking selects the color as background.

Using the color cache

The color cache displays eight color squares that you can easily select for use
as the foreground color. These color squares are located just below the two
color squares (foreground and background) also on the Color Palette. The idea
of this is to help you keep the eight most often used colors readily available for
painting, much as an artist’s color palette holds only those colors needed for
his/her work. Clicking on a color square selects that color as the foreground
color. To change a color in the color cache, right-click over a color square and
choose a color from the Color Picker pop-up menu.
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Selecting colors from the Color Picker pop-up menu

The Color Picker pop-up menu, displayed whenever you right-click over any of
the color squares on the Color Palette, allows you to choose a new color to
replace the selected color square or to choose from a range of Color Pickers.
Each Color Picker provides a different method for selecting colors, each
suitable for particular situations.

Using the Ulead Color Picker

Choosing the Ulead Color Picker command opens a dialog box showing a
continuous color spectrum. The color spectrum displays hue or color from top
to bottom and luminance, or the amount of brightness, from left to right. When
you move your mouse over any colors (without clicking), their respective RGB
color values are displayed below the color spectrum and the color itself appears
in the left color square. If you click and hold your mouse button down over a
color, a saturation bar appears allowing you to select a specific color. Releasing
your mouse selects the color, displaying it in the left color square.

For a more precise color selection, you can choose your color by clicking one
of the colored tabs above the color spectrum. This displays a whole range of
colors similar to the color on the selected tab. From here, you can select the
exact color by clicking the mouse on the desired color cell. Then click OK.

Note:  To select a particular color, use the RGB spin boxes to the right of the Color Picker
window.

Using the Windows Color Picker

When you select the Windows Color Picker, the standard Windows Color dialog
box appears, allowing you to select a basic or custom color.
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Using the Eyedropper as a Color Picker

Use the Eyedropper Color Picker when you want to select a specific color from
an image itself. This works the same way as the Eyedropper tool (described in
the next paragraph). The only difference is that it allows you to use zoom tools
to enlarge the currently active image, therefore increasing the precision of the
Eyedropper’s position. Also, if no color in the image is quite what you want,
you can enter your own RGB values and see the result in the color square in the
lower right corner.

Using the Eyedropper as a color picker

Selecting colors with the Eyedropper tool

The Eyedropper tool is used to select a foreground or background color from
colors in an image, the Color Palette, or the Attribute toolbar. (Whenever you
move your mouse pointer over the Color Palette, it changes to the Eyedropper
tool, regardless of your current tool selection.) The Attribute toolbar also
displays the RGB and HSB values of the image beneath the Eyedropper tool. As
you move the Eyedropper over the image, the values change reflecting the color
changes of the pixel beneath the Eyedropper. Clicking the left mouse button
selects the color under the pointer as foreground, while right-clicking selects
the color as background. (To place the color in the color cache, select the color
cache square to change before using the Eyedropper tool.)
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Editing an indexed-color image’s color table

Indexed-color images are unique in that they are small in file size (compared to
True Color images), yet offer a wide range of colors which can be arranged to
make it appear as if they contain much more. This is done through the use of a
color table which allocates a single color in either 16 or 256 discrete cells
(depending on the data type you are currently working in; for more on data-
type/bit-depth, see p.164.) You can view this color table by selecting the Color
Table command in the Format menu. (This command is disabled when the
active image is not Indexed-color.)

 

256-color Indexed palette                  16-color Indexed palette

As each color is in its own cell, you can change it to affect the color composi-
tion of an image. For example, you can change all occurrences of white by
simply changing the white color cell. To change a color, double-click the cell,
the Color dialog box opens, and choose a new color. Clicking OK replaces the
old color with the new one and returns you to the Color Table dialog box.

Loading and saving color tables

In PhotoImpact, you can save color tables and then load them into another
compatible Indexed-color image. This allows you to ensure that two or more
images share the same color composition, which is particularly important if you
are preparing images to be displayed in a 256-color display mode, such as with
CD titles or for the Web. You can also load in color tables that allow you to
colorize an image. For example, you can convert a grayscale image to Indexed
256-color and then load a color table to give it a particular hue. (During the
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installation of PhotoImpact, you had the opportunity to install some predefined
color tables for such purposes. Color tables appear with a .PAL extension.)

Note:  You can only load color tables containing 16 colors into Indexed 16-color images.
Likewise, color tables containing 256 colors can only be loaded into Indexed 256-color
images.

  

Original image    Applying a gold palette      Applying a fire palette

Using the painting tools

PhotoImpact comes equipped with an extensive assortment of painting tools
that allow you to apply paint to an image. Choices of such tools range from
brush, airbrush, crayon, charcoal, chalk, and pencil, to marker, oil paint,
particle, drop water, and bristle. To select one of these, click the lower right
corner of the Paint button on the Tool panel. A drawer of painting tools then
opens, allowing you to select the particular painting tool you wish to use. The
drawer closes and the attributes available for that tool appear on the Attribute
toolbar. Because PhotoImpact incorporates as many as 99 levels of Undo
function (see p.33 for more details on Undo/Redo feature), you never need to
worry about ruining your original image as you can easily have your actions
undone. Its Erase mode can also help you recover from mistakes (see p.100).

To apply paint to an image, simply move your mouse to the point on the image
where you want to start and click. The color displayed in the Color box of the
Attribute toolbar is then applied to the image. The tool's effect continues for as
long as you hold your mouse button down.

Note:  If you have created a selection area, the tools are only applied to the area within the
selection. Using selection areas in this way allows you to restrict the parts of the image to
which paint is applied, protecting the rest of the image from inadvertent changes.
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Paintbrush    Airbrush       Crayon

  

Charcoal     Chalk        Marker Pen

Working with paint tool attributes

Before applying any paint to an image, you need to specify the attributes of a
particular tool to achieve the desired effect. There are two ways by which you
can do this. You can either define the attributes directly from the Attribute
toolbar after selecting a certain paint tool or you can open the Brush Panel by
clicking the Layout icon on the Standard toolbar and selecting Brush Panel.
(The Brush Panel can also be displayed by right-clicking on either the Tool
panel or the Attribute toolbar and selecting Brush Panel.) Details to the Brush
Panel is discussed on p.101.

When you select a painting tool, its various attributes appear along the Attribute
toolbar. Many of these attributes are shared and work for all of the available
paint tools. For example, the first group of options on the Attribute toolbar
allow you to control the size, shape, and color of a painting tool’s brush.

• Shape allows you to choose a brush shape. You can specify the size of the
brush head by entering a value between 1 and 100.

• Transparency defines the degree of transparency of the paint to be applied
on your image. The higher the value, the more transparent that your paint
appears and the more that it reveals of the underlying image. Transparency
degree ranges from 0 to 99%.
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• Soft edge determines how much the color blends along the edges of an
image. A value of 0% produces no blending while a value of 100% com-
pletely smoothens the edges of your paint and blends it with the underlying
image.

• Preset allows you to choose from a set of paint brush options such as
specific types of a particular Paint tool. Each of the paint tool has a different
set of paint brush presets. Selecting None gives you the effect of your last
selected brush preset.

Specifying the painting mode

As you paint, you can switch among three different painting modes: Freehand,
Straight Lines and Connected Lines, opened via the Options button on the
Attribute toolbar. (You can also specify the painting modes and other options in
the Options tab of the Brush Panel. See p.102) Freehand allows you to paint in
an irregularly shaped stroke while Straight Lines is for painting in straight lines.
To paint a straight line, first click the point where you want the line to start then
drag to the point where you want it to end and release the button. (Pressing the
Shift key constrains the line to an angle of 0º, 45º, or 90º.) If you want to paint
a series of connected straight lines, use the Connected Lines mode. This mode
functions much like the Straight Line mode except that after a line is painted
you can select a new line segment and continue painting. Double-clicking
automatically paints a straight line connecting the end point to the starting point.

Erasing colors from an image

There are three ways to remove colors from an image: erase paint applied using
the Paint, Clone or Retouch tools, erase a selected color, and erasing the pixels
from the background image.

To erase paint applied using the Paint, Clone or Retouch tools, click the Erase
Mode button on the Attribute toolbar or Brush Panel while using the Paint tool.
The Paint tool then becomes an eraser and you can proceed to remove the
colors added previously.

To erase a selected color, use the Magic Wand selection tool as described on
pages 51-52 (and pages  55-56 for information on adding and subtracting from
selection areas.)

Finally, you can remove the pixels from the background, or original, image. To
do this, simply use the paint tool to paint over the pixels in question with a
neutral color (PhotoImpact uses the Foreground color for this.)
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An example of erasing paint in Erase mode

Specifying the Brush Panel attributes

Just as the attributes appear along the Attribute toolbar when you select a
specific painting tool, the Brush Panel also displays the attributes for that tool in
four folders: Shape, Options, Color, and Advanced. Open the Brush Panel by
clicking the Layout icon on the Standard toolbar and selecting the appropriate
menu command.

The current settings of these attributes are the same as they were when last
selected. If you change them, you can save the new settings to the Painting
Gallery of the EasyPalette by clicking the Add button on the Attribute toolbar.
The Painting Gallery of the EasyPalette also has a large number of paint brush
presets, such as specific types of art-pencils (2B, 6H), felt-tip pens and effect
brushes like fog and light. To use them as the current brush, double-click the
thumbnail of the one you want or drag-and-drop it onto an image. (For more
information on saving a special tool's attributes to the EasyPalette, see p.109.)

BRUSH PANEL: SHAPE TAB

Height  – specifies the height of a brush. (You can also drag the vertical slider to the
right of the preview. To keep aspect ratio, click the Lock button.)

Width  – specifies the width of a brush. (You can also drag the horizontal slider at the
bottom of the preview. To keep aspect ratio, click the Lock button.)

Erase mode  – removes previously applied paint from the paint layer.

Elliptical  – defines the shape of the brush head as elliptical. To use a circular head,
lock the width and height sliders.
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Rectangular  – defines the shape of the brush head as rectangular. To use a square
head, lock the width and height sliders.

Brush angle  – defines the angle of the brush tip, from 0 (perpendicular to the image
surface) to 359 (the most extreme angle).

Soft edge  – adjusts the color blending along the brush’s edge, from 0
(no blending) to 100 (complete blending). The greater the soft edges, the slower your
painting because it has to calculate the appropriate amount of blend with the underlying
image.

Weight  – defines how heavy the paint color is. The heavier the weight, the stronger
the impression it leaves.

Distribution – defines the placement of the brush bristles. The higher the value, the
narrower the placement, and a lower value means wider placement.

Random  – creates a random (although proportional) size variation among the bristles
of a brush. The value entered here defines the percentage of variance.

Bristle thickness  – defines the thickness of each bristle in the paint brush. The
higher the number the thicker each bristle and, as a consequence, the more paint it can
hold.

Density  – defines the number of bristles the paint brush contains. The more bristles it
contains the more paint it can retain and thus the stronger the applied color.

BRUSH PANEL: OPTIONS TAB

Apply method  – determines how paint is applied to an image. Depending on the tool,
you can choose one of the following:

• Always  replaces the original colors with the painted color.

• Hue and Saturation  applies only the hue and saturation values of the painted
color.

• Hue Only  applies only the hue value of the painted color.

• Saturation Only applies only the saturation values of the painted color.

• Luminosity  applies only the brightness and contrast values of the painted color.

• If Lighter  applies the painted color only if it is lighter than the background.

• If Darker applies the painted color only if it is darker than the background.

• Difference applies the color that is produced from the difference between the
values of the original colors and the painted color. For example, if the underlying color
is R:10 G:210 B:125 and the overlaying color is R:30 G:100 B:100 the resulting color
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when merged is R:20 G:110 B:25 – (R:30-10 G: 210-100 B: 125-100.) (Values outside
of 255 are taken as absolute values.)

• Addition applies the color that is produced from adding the color values of the
original colors with that of the painted color. For example, if the overlaying color is
R:10 G:210 B:125 and the underlying color is R:30 G:100 B:100, then the resulting
color will be R:40 G:255 B:225 – (R=10+30 G=210+100 B=125+100). (Values greater
than 255 are rounded down to 255.)

• Subtract  applies the color that is produced from subtracting the color values of
the original colors with that of the painted color. As in the above example, R:10 G:210
B:125 and R:30 G:100 B:100 would result in the color R:0 G:110 B:25 – (R=10-30
G=210-100 B=125-100) (Color values less than 0 are rounded up to 0.)

• Multiple  applies the color that is produced from multiplying the color values of the
original colors with those of the painted color and then divides the result by 255;
rounding to the closest integer value for each color channel. For example, if the
overlaying color is R:10 G:210 B:125 and the underlying color is R:30 G:100 B:100,
the resulting color will be R:1 G:82 B:49 – (R=10*30/255 G:210*100/255 B:125*100/
255.)

• Inverse of multiple  works in the same way as above except it inverts the
resulting color. For example, if the resulting color is black, the inverse will be white.

• Pigment –  applies the average color which is produced from blending the painted
color with the original colors, much in the same way an artist creates new colors by
mixing paints.

Freehand  – defines the drawing mode as Freehand. Freehand mode mimics painting
by hand, applying paint as you move your mouse.

Straight Line  – defines the drawing mode as Straight Line. This mode is for painting
straight lines where you first click the point you want the line to start and drag to the
point you want it to end, and then release your mouse. (Pressing the Shift key constrains
the line to an angle of 0°, 45°, or 90°.)

Connected Lines  – defines the drawing mode as Connected Line. This mode
functions much like the Straight Line mode except that after a line is painted you can
select a new line segment and continue painting. Double-clicking then paints a straight
line connecting the end point to the starting point.

Note:  If you make a mistake while drawing a single or connected line, or wish to start
again, press the Esc key.

Transparency – defines how pure a color is. A transparency of 0 is pure color
while a transparency of 100 produces no color.

Wet Control – defines how wet paint is when it’s applied, from 0 (the wettest) to
100 (the driest). The wetter the paint the greater the amount of overflow.
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Retouching images

The retouching tools are not strictly painting tools in the sense that they do not
“paint” over an image with a selected color. Instead, they are used to enhance
areas of an image by adjusting existing pixel colors. In all, there are nine
retouching tools: Dodge, Burn, Blur, Sharpen, Smudge, Tonal Adjustment,
Saturation, Warping, and Bristle Smear. To select a tool, click the lower right

BRUSH PANEL: ADVANCED TAB

Pressure options  – determine how paint is applied for tablet devices. If you do not
have a tablet device installed, these options are disabled.

Spacing  – determines how close each drop of color is applied as a percentage to the
current brush size. The higher the value, the farther away drops are applied. Likewise, a
lower value applies color closer together. For example, a value of 100 places each drop
of color next to each other, creating a dotted line effect, whereas a value of 300 places
each drop of color at a distance 3 times the size of the brush.

Fade in/out  – mimics the consistency of paint on the specified brush type by
defining how quickly it fades out or in when a stroke is made. A higher number equals a
longer fade.
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BRUSH PANEL: COLOR TAB

Single Color  – applies a single color as the brush paint.

Multiple Colors  – applies multiple colors as the brush paint. You choose which
colors from the Hue, Saturation  and Brightness  options. By controlling the value of
these options you determine how much color is applied. For example, more hue intro-
duces more color while an increase in the saturation makes the colors appear stronger.
When you paint, all the various colors are then applied producing a rainbow-like effect.
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corner of the Retouch button on the Tool panel; a drawer of retouching tools
opens and you can select the retouch tool you wish to use. The drawer closes
and the attributes available for that tool appear in the Attribute toolbar.

When you apply a retouching tool to an area, the tool uses the shape and size of
the current brush each time you click your mouse. To perform the effect over a
larger area, drag your mouse or increase the size of your brush. To reapply and
increase the effect on a specific area, click repeatedly. (Smudging requires you
to drag the tool, as it smudges color from one area into another.)

Note:  The retouching tools can only be applied to Grayscale and True Color images.

    

Original image    Dodge        Burn

    

Blur    Sharpen        Bristle smear

To specify the attributes of a particular Retouch tool, open the Brush Panel. The
attributes for the respective Retouch tools are displayed in three tabs: Shape,
Options, and Advanced. These attributes are identical to the paint tools except
the Options tab, which changes to display controls for refining the degree of
retouching (see p.102 for the Paint tools options.) The attributes in the Options
tab vary according to the type of Retouch tool selected.

Notes:  Confine the area to retouch by first creating a selection area.



PHOTOIMPACT USER GUIDE106

BRUSH PANEL: OPTIONS TAB (RETOUCH TOOL)

Dodge  increases the amount of luminosity in an image, making areas lighter.

Burn  reduces the amount of luminosity in an image, making areas darker.

Blur  blurs the edges in an image making them less distinct.

Sharpen  sharpens the edges in an image, making them more distinct.

Tonal adjustment  controls the amount of highlight, midtone and shadow in an image.
Highlight  works by adjusting the whitest or brightest parts of an image, while Midtone
adjusts the colors that fall between the dark and light areas of an image. Shadow  works
by adjusting the blackest or darkest parts of an image.

Smudge  smears the colors in an image as you drag your mouse.

Saturation  adds more intensity to colors, making them appear stronger.
Clicking the Desaturation button removes intensity from colors, making them lighter.

Warping  distorts an image as you drag your mouse.

Transparency determines the transparency of the paint as it is applied.

Wet adds water to the paint making it blend more smoothly with the colors of an image.

Dry  removes water from the paint making it more distinct from the colors of an image.

Smear  controls the amount of paint overrun.

Cloning parts of an image

When you want to duplicate an object or parts of an image and "paint" it over
another part of that same image or even other images, cloning is a great way to
achieve this. For instance, you can remove an unseemly area by cloning over it
with parts of the background or you may create more objects of the same kind
(creating the impression of more stars in a night sky, for example) by cloning
additional objects into the background.

The cloning tools consist of two main types: the Image Clone tool and the
Object Clone tool. The Image Clone tool incorporates a set of cloning tools with
different brush types. They copy part of an image to another area in the same
image or to another image of the same data type, such as painting one person’s
head onto another person’s body. The Object Clone tool is used to paint objects
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from an image file into an image as single stamped objects or as a continuous
stream of painted objects, such as trees in a forest.

Note:  You can only clone on Grayscale and True Color images.

Just as you are given the choice of selecting from among the various brush
types in the Paint tool, the Clone tool also provides you with the freedom of
choosing from an array of cloning effects – Paintbrush, Airbrush, Crayon,
Charcoal, Chalk, Pencil, Marker, Oil Paint, or Bristle.

To use the Image Clone tool:

1 Click the lower right corner of the Clone button on the Tool panel, a drawer
of cloning tools opens, and select any of the Image Clone tools. All except
the one on the extreme right are Image Clone tools. (The other one is the
Object Clone tool.) The drawer closes and the attributes available for that
tool appear on the Attribute toolbar.

2 Move to the image you want to clone and holding down the Shift key, click
your mouse once over the area you wish to clone. (This area is then marked
with a cross-hair and your mouse pointer changes to the clone pointer.)

3 Move to the area on the image where you want the clone to appear and start
dragging your mouse. The cross-hair changes to indicate the area you are
cloning, and as you paint, you replace the area with whatever the cross-hair
passes over. (The size and shape of the area painted are determined by the
current tool size and shape settings on the Attribute toolbar.)

Before starting to paint, you may determine the cross-hair’s position by
setting the options in the Options tab of the Brush Panel. Open the Brush
Panel by right-clicking on either the Tool panel or the Attribute toolbar and
select Brush Panel. At the bottom of the Options tab (just below the Apply
Method drop-down menu), you will see a set of six options, namely, (from
the left) Freehand, Straight Line, Connected Line, Absolute, Frame, and
Relative. The first three, which can also be accessed through the Options
menu on the Attribute toolbar, share the same function as those in the Paint
tools. (Details on these three options are discussed on p.103.)

• Absolute option allows you to clone from your defined reference or
starting point each time you click. (You define the starting point of the
area to clone by clicking on the desired area with the Shift key down.)
Meaning, after dragging your mouse to clone a particular image, release
the mouse button and you can instantly clone another similar image in a
different area without having to redefine your reference point.
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• Frame lets you clone in a different frame using the same reference
frame positions. Its reference point always starts from the upper left corner
of the image to be cloned.

• Relative functions similarly to Absolute except that it clones continu-
ously with the cross-hair remaining where you left it, prompting you to
define the reference point again if you want to clone that same image in
another area.

To use the Object Clone tool:

1 Click the lower right corner of the Clone button on the Tool panel, a drawer
of clone tools opens, and select the Object Clone tool. This is the tool to the
utmost right among the set of clone tools. The drawer closes and the
attributes available for that tool appear in the Attribute toolbar.

2 Click the Open button on the Attribute toolbar. The Open dialog box
appears.

3 Select the file you want to clone. (If the image file has no objects, the base
image is chosen as the cloned object.)

Note:  For an idea of what you can clone, try loading in one of the UFO files provided in
the SAMPLES folder under your PhotoImpact program folder.

4 Choose either the Randomly or Sequentially commands from the Options
menu on the Attribute toolbar. Randomly applies the cloned objects in a
random order while Sequentially applies them in the order that they appear in
their image file.

5  Choose either the Stamp or Trail command on the Options menu on the
Attribute toolbar. Stamp allows you to clone the loaded objects one at a time,
while Trail allows you to “spray” the active image with the loaded objects.

6 Click your mouse over the area that you want to apply the cloned object to.
Continue clicking over the image to apply additional cloned objects.

  

Original image   Standard cloning     Object cloning
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Saving a tool's attributes to the custom gallery

PhotoImpact provides a way for you to set up your own gallery of specially
configured tools – whether Paint, Retouch, or Transform tools. After having
modified the attributes of any specific tool which you may want to save for
future use, click the Add button on the Attribute toolbar. The Add To
EasyPalette dialog box opens, prompting you for information such as a name
for the tool thumbnail, the specific gallery or library where the thumbnail goes,
and the tab group to which the tool belongs. You should give the tool a name
that easily reminds you what the tool is and what it can be used for ("eye
pencil," for example) The Recently-used drop-down menu displays the gallery
and the tab group which you saved your last configured tool to. The tool
attributes are then saved in the designated gallery of the EasyPalette. To retrieve
the tool, simply drag the thumbnail of the tool from the EasyPalette onto the
image. The Attribute toolbar changes accordingly to reflect the new tool and its
attributes.

Filling an area with color, textures, and gradients

With PhotoImpact’s fill options, you can quickly fill any image, object, or
selection area with a solid color, gradient, pattern, or texture of your choice.
This is particularly useful when you want to create a background behind a
person or image, or introduce special effects into an image. PhotoImpact
provides three different methods for performing a fill operation: the Fill tool, the
Texture and Gradient galleries in the EasyPalette, and the Fill command.

Using the fill tools

The Fill tools on the Tool panel provides access to the Bucket, Linear Gradient,
Rectangular Gradient, and Elliptical Gradient Fill tools. The Bucket Fill tool
works by replacing any color you click on with the color shown in the Fill
Color square on the Attribute toolbar. To increase the range of the fill, adjust the
values in the Similarity spin box. The higher the value, the more colors that are
used in filling. Use this tool to quickly replace a solid color, such as white to
black (you don't need to create a selection area). The three gradient fill tools fill
an area with a smooth transition from one color to another, such as creating a
sunset or framing a photograph. (It is necessary to select an object or create a
selection area, otherwise, gradient will be applied directly on the base image.)
Enter a value in the Transparency spin box to specify the degree of transpar-
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ency when applying a fill color (from 0 to 99%). To adjust how your fill color
merges with an image, choose from among the Merge options on the Attribute
toolbar. Related information on these options can be found in the Object Proper-
ties dialog box, see p.60.

Notes:
• The Bucket Fill tool works with all data types, while the Gradient fill tools only work with

Grayscale or True Color images.
• If you don’t select an object or make a selection area, the fill tool acts on the base

image.

Choosing a fill method

In PhotoImpact, you can choose between two fill methods when applying a
Gradient Fill on your image. All three Gradient Fill tools share the same at-
tributes along the Attribute toolbar. You can select either Two-Color or Multiple-
Color. The Two-Color method applies a Gradient Fill to your image based on
any two colors specified in the Fill Color square on the Attribute toolbar. To
change the color, either click the square for the Ulead Color Picker or right-
click for the Color Picker pop-up menu (see p.95 for details on selecting
colors). The gradient applied will be a smooth transition from the first (starting)
to the second (ending) color. You can switch the two colors by clicking the
Swap button between the two color squares. The Multiple-Color method uses a
palette ramp to apply a Gradient Fill to your image in multiple colors as speci-
fied in the Fill Color square. Click the color square to access the Palette Ramp
Editor dialog box. It opens in a palette library which has a wide array of pre-
defined color rings that you can apply to your image. It also lets you create
your own combination of colors.

To make a Two-Color gradient fill:

1 Click the lower right corner of the Fill button on the Tool panel, a drawer of
fill tools opens, and select a gradient fill tool. The drawer closes and the
attributes available for that tool appear on the Attribute toolbar.

2 Using the Fill Color color squares on the Attribute toolbar, select the starting
and ending fill colors. (Click the Swap button between the two colors if you
want to switch the colors.)

3 Move to the image where you want to apply the fill and click on the point
where you want the fill to start. Drag your mouse to the point where you
want it to reach the end color and release. The fill is then applied between
these two points. (Any area before the start point and after the end point is
filled with the Start and End colors respectively.)
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Note:  If you are using the Linear Gradient Tool, holding down the Shift key while dragging
constrains you to a 0°, 45°, and 90° angle. If you are using the Rectangular and Elliptical
Gradient Tools, holding down the Shift key as you draw produces a square or circular fill
respectively.

  

Linear fill    Rectangular fill      Elliptical fill

To make a Multiple-Color gradient fill:

1 Click the lower right corner of the Fill button on the Tool panel, a drawer of
fill tools opens, and select any of the three gradient fill tools. The attributes
available for that tool appear on the Attribute toolbar.

2 Click the Fill Colors square on the Attribute toolbar. The Palette Ramp Editor
dialog box opens with the palette library displaying thumbnails of color
rings.

3 Selecting a thumbnail displays that color ring to the palette ramp on the left
window, with control points allowing you to drag anywhere around the ring.

4 To adjust the color of the ring, right-click over a specific control point and
select Change Color. The Color Picker opens.

5 Click OK after choosing a color. The color will appear on the area from the
control point you selected up to the next point. Drag the control point to
further adjust the color.

6 To adjust the hue, enter a value from 0 to 359 or click on (or drag) the color
hue bar and select the best color combination.

7 Entering a value (from 0 to 359) in the Ring spin box adjusts the position of
the color ring.

8 When satisfied with your palette ramp, click OK. You can add it to the
palette library by clicking Add. Assign a name to your palette by right-
clicking on the thumbnail and selecting Rename.
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Performing drag-and-drop texture fills

PhotoImpact makes it easy to apply a full range of predefined and custom
textures and color gradients to any image, object, or selection area through the
Texture and Gradient galleries in the EasyPalette. When you open the Texture
Gallery, you can view thumbnails of Magic and Natural textures, selected by
clicking the appropriate tabs. Magic textures are generated artificially, while the
Natural textures represent real-world textures such as wood grain, stone, and
fabric. To apply a Texture or Gradient Fill, drag its thumbnail onto an image,
object, or selection area.

Notes:
• You can modify a texture by right-clicking on a thumbnail and selecting the Modify

Properties and Apply command in the Thumbnail pop-up menu that appears. This
opens the Magic Texture dialog box which allows the texture setting to be modified to
create new textures that can be added to the Magic Texture tab of the Texture window.

• When a Texture Fill is applied to a selection area, the base image within the selection
area is filled with the texture.

    

An example of some of the Magic and Natural Textures available in PhotoImpact

Using the Fill command

The Fill command [Ctrl+F] in the Edit menu provides greater control over the
fill process and allows you to fill an image, object, or selection area with either
a color, an image from the clipboard, or a texture. Through the Fill dialog box,
which appears when the Fill command is selected, you can control exactly how
the fill occurs and what is used to fill the area.

Filling an area with a texture

The Magic Texture and Natural Texture options in the Fill dialog box allow you
to fill an area with either an artificially generated or natural texture. You can
choose either one by clicking the radio button next to either of the displayed
textures. To change the Magic Texture, right-click over the preview box next to
it or click its Library button and select Pick From EasyPalette Galleries or
Options. Pick From EasyPalette Galleries gives you access to Texture Gallery,
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where an assortment of Magic Textures is made available for you to pick and
apply to your images. Options, however, opens the Magic Textures dialog box
allowing you to modify a Magic Texture's attributes.

The Magic Textures dialog box

When modifying a Magic Texture you are presented with an array of thumb-
nails. The center thumbnail represents the current texture. To change this
texture, click any neighboring thumbnails. The thumbnail you selected then
replaces the center one and the others are redrawn accordingly. When you are
satisfied with the modified texture, click OK; the dialog box closes and you
return to the Fill dialog box. To change the Natural Texture, click its Library
button to open a library displaying all the different Natural Textures available.
You can choose from different wood grain, stone, metal, cloth, cloud, tree and
other textures by clicking on the desired texture’s thumbnail.

Using Clear and drag-and-drop to fill

One of the easiest ways to fill an image is to choose your fill color as the
background color and then press the Delete key. This fills the image or selected
area with your default background color without having to open the Fill dialog
box. If you wish to quickly use an existing image as the fill, you can drag it
from one image (with the T key held down) and drop it onto another. This fills
the image, object, or selection area with as many tiled copies as possible of the
original image. You can change your default background color from the Color
Palette, accessed by right-clicking on either the Tool panel or the Attribute
toolbar and selecting Color Palette. It automatically flashes to the right of your
PhotoImpact worskspace.
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Using the Transform tool

You will find the Transform tool a useful one as it allows you to take an image
or part of it and then manipulate it so that it changes shape and even perspec-
tive. To perform a transformation, select an object or the area on which you
want to transform and then click the Transform tool button on the Tool panel.
A set of eight different transform options appears as buttons on the Attribute
toolbar. (Some of these options are available in the Edit: Rotate & Flip
submenu.) On the following section is a brief explanation of what each of these
options are, some examples, and how to use them:

Notes:
• Applying a transformation creates objects out of any selected areas.
• If you rotate or distort an image by anything other than 90º, 180º or 270º, extra space is

introduced around the image. This space is filled with the background color if you do
not have Preserve Base Image selected in the Options menu on the Attribute toolbar.
(Objects are not affected in this way.)

• If there is no selection before using the Transform tool, the entire image will be
automatically selected.

• If your selection is a circle or an ellipse, a rectangular box covering the area closest
to your selection will automatically be displayed, allowing you to easily transform your
object through the control points at each of the four corners.

Transform tools

Rotate by horizontal line

Rotate by vertical line

Rotate freely

3D

Resize

Slant

Distort

Perspective

Rotate counterclockwise by degree

Degree of rotation

Rotate & flip

Rotate clockwise by degree

Add
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• Resize allows you to enlarge or reduce the size of your object by selecting it
and dragging the control points. To keep the aspect ratio, hold down the
Shift key while dragging.

• Slant adjusts the angle of your object so that it appears tilted but in a propor-
tionate manner.

• Distort  skews and changes the shape of your object. It functions similarly to
Slant except that you skew the appearance of your object without conform-
ing to the general proportion of the image; meaning, by dragging one corner
of your object to the desired position, you are only distorting that specific
angle.

• Perspective lets you change the perspective of your image by proportion-
ately modifying the viewing position of the object.

• Rotate by horizontal line draws a horizontal line at the center of an object
selection that allows you to rotate the object horizontally. Just manipulate the
handle to the desired direction and double-click (left mouse button) on either
of the end points.

• Rotate by vertical line does the same as Rotate by horizontal line except
that it draws a vertical line at the center of your object. Details to the Rotate
by horizontal and vertical line are discussed in "Straightening images," p.116)

• Rotate freely lets you rotate an object 360º by manipulating the four control
points located at each corner of the quadrangle.

• 3D transform allows you to create three-dimensional effects by steering the
track ball within the circle. You need to convert the selection to object before
you can apply the 3D transform tool. See "3D virtual transformation," p.117
for more.

• Rotate counterclockwise by degree swivels your object counterclockwise
by degrees as specified in the degree box.

• Degree of rotation specifies the angle by which you wish to rotate your
object.

• Rotate clockwise by degree rotates your object clockwise by degrees as
specified in the degree box.

• Rotate & flip  lets you define the rotation of an object with choices ranging
from 90º to 180º. Also flips your object horizontally or vertically.
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Original image    Free resizing      Slanting

    

Distorting   Changing Perspective      Rotating

    

Flipping horizontal    Flipping vertical      3D Transform

Straightening images

The Rotate by horizontal and vertical line options are useful when you have an
image which is not quite straight. This is often the case when you input an
image with a hand-held scanner. To horizontally straighten an image, click the
Rotate by horizontal line button and then drag a control point to one end of a
strong horizontal feature, such as the edge of the image. Next drag the second
control point to the other end of the feature, carefully aligning the control line
along the feature. Double-clicking on any of the control points now rotates the
image horizontally.

Note:  You can also use the Auto-Process: Straighten command to quickly straighten an
image. For more information, see “Automatically enhancing an image,” p.86.
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3D Transformation

There is more to Transform tool than just plain flipping and rotating.
PhotoImpact makes it easy to transform your images in three-dimensional space
via its 3D Transform option. This option will be most useful when you want
your images to appear in a different plane or perspective while at the same time
retaining the proportions of the original image.

To perform a 3D transform:

1 Create a selection on your image and click the Transform tool from the Tool
panel. Your selection becomes a path with eight control points at the corners
and on the sides. You will notice that the 3D transform option from the
Attribute toolbar is grayed out at this point.

Note:  Even if your selection is of a shape other than a quadrilateral, for instance, a
circle or an ellipse, the path which your image has become will automatically make it
a quadrilateral selection covering the entire area of that image.

2 To activate the 3D transform option, your image needs to be in the Path
mode. But first, you will have to convert your selection to an object. Right-
click on your image selection and choose Convert to Object.

3 To convert your object to a path, select the From Image to Path command
from the Edit: Convert Object Type submenu. The 3D transform option is
then accessible.

4 Click the 3D transform button on the Attribute toolbar. A circular path, the
3D virtual track ball, then appears around the selection with a focal point at
its center called the Object Center. That center, at this point, is also the
Projection Center.

5 Drag within the track ball to create three-dimensional transformation effects.
Moving the Object Center relocates its object handle, thus moving the entire
image but retaining the Projection Center in its original position.

6 Double-clicking anywhere inside the circle allows you to toggle between its
two 3D modes. To put it simply, doing so lets you toggle between operating
the 3D virtual track ball for changing the image's perspectives and moving
handles for changing the view angle.
Notes:
• To make things easier to remember, when you see a round path with a focal point at

the center, that is the Object Center and dragging anywhere within it transforms
your object in a three-dimensional effect. When you see two rectangular paths
around your image with a focal point at the center, you are in the Projection Center
mode and moving the handles lets you change your viewing angle of the object.

• The view angle is limited to between 0º and 90º.
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Sample images created with the 3D Transform tool

Working with paths

PhotoImpact makes it possible for you to convert objects and selection area
marquees into paths. Paths are vector-based images, as opposed to bitmapped
images, comprised of a collection of control points, bezier curves, and lines.
Paths do not contain any image data, but they can be shaped with great preci-
sion to produce shapes with little or no discernible jaggedness. It is this
smoothness that makes paths a valuable tool when working with text and other
shapes, such as corporate logos.

The Trace commands

The Edit: Trace submenu contains commands that can convert any base image,
selection area or object into a path-based object. The Selection Marquee
command converts a selection area into a path controlled by a number of
control points and handles. The Image command works in much the same way
as the Selection Marquee command except that the control points and handles
are located on the edges of the selected image, giving you greater control over
the shape of the vector path.

Deciding which Trace command to use is entirely dependent on the image that
you want to convert to a path. If the image is of similar brightness and contrast
with the background, such as a person’s face against a bright sky, it is better to
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first use a Selection tool to carefully outline the person’s face, and then select
the Selection Marquee command. In cases where the image data is easily
distinguished from background pixels, such as with text on an image, you
should use the Image command.

Note: To improve the quality of paths, set the Generation quality option in the Preferences
dialog box (see p.22) to Best. If speed is more important than quality, then set the quality
to Fair.

TRACE DIALOG BOX

Show path only  – displays only the vector path in the preview thumbnail. The
advantage of the Show path only view is that it displays the thumbnail more quickly and
gives you a better idea of how the path is taking shape.

Tolerance  – sets the accuracy of the control points on the vector path. Move the
slider to the right to set a high tolerance which results in fewer control points, and as such
does not follow the boundaries of the selection area or image as accurately. For simple
paths, such as a building or doorway, a high tolerance is no problem. However, for
irregular shapes, such as a person or a car, specify a low tolerance.

Jump point – determines the accuracy of the curves between the control points.
Move the slider to the left to create a path that fits more closely with the selection area or
image (the better the fit, the slower the conversion). Again, for simple paths, fewer jump
points is no problem, but for irregular shapes, specify more jump points.

Threshold  – determines which pixels are included in the vector path. Move the slider
to the left to decrease the number of pixels and to the right to increase the number of
pixels. This option is similar to color similarity, allowing pixels of a specified color range to
be included in the vector path. The higher the threshold, the larger, and possibly less
accurate, the path will be.

1

2

3

4

1

2

3

4
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The Path tool

Once you have created a path, you need to use the Path tool to modify it. (For
modifying paths created with the Text tool, see “Creating text effects” p.135.)
The Path tool operates in several modes: 2D Object, Path, Selection, 3D Round,
3D Chisel, 3D Trim, 3D Pipe, and 3D Custom. You determine which one to use
by selecting it from the Mode drop-down menu on the Attribute toolbar. The
2D Object mode converts your path back to a raster-based object, filling it with
the default color specified in the color square on the Attribute toolbar. Selecting
the Path mode allows you to freely edit the path, distorting its shape and
position. The Selection mode converts the path into a selection area, which you
can then fill with a color, texture or even with another image. The array of 3D
options works the same as the 2D Object only that the former incorporates
various modes in three-dimensional perspectives.

Changing the path shape

If you have created a path using one of the Trace commands, you cannot edit it
immediately as it has yet to be mapped with control points. To do this, choose
the Edit Existing Path command on the Edit menu on the Attribute toolbar.
Now, when you click the path, control points appear at each corner. To modify
the shape of the path, you need to change the position of these control points.

To move a control point, first click it to make it active (the pointer changes to a
cross-hair pointer) and then drag it to a new position. When you select a
control point, a handle appears connecting the control point to an additional two
control points. These control points allow you to modify a path’s curvature and
can be easily adjusted by dragging them anywhere within the workspace. (If
you click off the control point, the path is no longer active. To change its
curvature, you will then need to make the original control active again and then
drag on a handle.)

To change the path shape of images, move your mouse over the control points
which you want to edit. Again, a small cross-hair pointer with a hand appear,
pointing to the exact spot which you can change the position of. Click it again
to be able to start editing your path. (Only when a larger cross-hair appears can
you drag the control points elsewhere.)

Note:  You can make a control point by dragging your mouse over the path.
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An example of distoring text using the Path tool

When you change a handle, its behavior is determined by the Free edit option on
the Attribute toolbar. When cleared, the handles rotate together around the
control point. If selected, you can move each handle’s control point indepen-
dently, applying more acute angles and curvatures.

Creating a new path

PhotoImpact also allows you to create new paths by click the Edit: New Path
menu command on the Attribute toolbar. Wherever you click your mouse on an
image, control points appear, connected together by straight lines. Dragging
your mouse curves the line around these points. To finish, or close a path,
simply click the first control point or double-click. A line is then drawn from
the last control point to the first, closing the path curve.

After creating a new path, you need to either convert it to an object or selec-
tion, change the mode, or click the Edit Existing Path command on the Attribute
toolbar. If you don’t, each time you click your mouse, another control point is
placed on the image. To change the shape of the path, select the Edit Existing
Path command and then follow the procedures explained above.

Using path shapes

Just as you are able to create new paths independently, PhotoImpact also lets
you create predefined and custom shape paths. To create regularly-shaped
paths, just select any of the shape commands in the Edit menu on the Attribute
toolbar. You can choose from Rectangle, Rounded Rectangle, Square, Ellipse,
Circle, Diamond, and Custom shape. The Select Custom Shape command
situated just below these allows you to pick your choice from the existing text-
or object-based paths in your Gallery.
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Path properties

In addition to creating pre-set and custom paths, in either 2D or 3D style, you
can also further enhance or modify a Path by clicking the Options button on the
Attribute toolbar. This opens the Material dialog box where you can define such
properties as color, texture, bump, reflection, and shadow. It also lets you
adjust the lighting of the path object as well as how light is reflected from its
surface. As with the Text tool, the Material dialog box can be an invaluable tool
in adding dimension to your vector-based objects. Some of the many effects
you can perform are: glassy transparencies; textured spheres; and creating
custom shapes based on Adobe Illustrator-based vector drawings.

To create 'glassy' objects:

1 While using the Path tool, click the Edit button on the Attribute toolbar to
open the Edit menu. Select the New Path menu command.

2 Once you've changed the Mode, click the Options button on the Attribute
toolbar. The Material dialog box opens.

3 On the Bevel tab, select a 3D option to give the object the dimension neces-
sary to render the glass effect (preferably 3D Round as most glassy sur-
faces are smooth.)

4 On the Transparency tab, select the Transparency option and set the
percentage to approximately 75% to best mimic the appearance of glass.

5 Next, set a minumum transparency of 35%. This defines the minimum
transparency of the object's edges (generally the sides or 'edges' of transpar-
ent objects such as soda bottles are not as transparent as the center portions
due to the curvature of the material and the 'stacking' effect where the
object's backside is proximal to the frontside and making it slightly more
opaque.)

6 On the Shadow tab, select the Render Backface option to have PhotoImpact
draw the backside of the transparent object. If this option is left cleared, the
object may appear strictly convex with no visible far side.

7 Click OK when you are finished. The Path object updates itself accordingly.

 

      A glassy 3D path object
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To create a textured sphere:

1 While using the Path tool, click the Edit button on the Attribute toolbar to
open the Edit menu. Select the Circle menu command.

2 Draw a circle anywhere in the edit window, then select 3D Round from the
Mode drop-down menu on the Attribute toolbar.

3 Click the Options button on the Attribute toolbar to open the Material dialog
box.

4 On the Color/Texture tab, click the File button and select an image file to fill
the circle with. This texture is mapped strictly to the dimensions of the
circle, not the 3D surface 'extruding' above it.

5 On the Reflection tab, select the Reflection option and, when the Browse
dialog box opens, select the same image file used as a Texture. This maps
the image to the 3D surface above the Textured image, giving it more depth.

6 On the Bump tab, select the Bump Map option and, when the Browse dialog
box opens, select the same image file used in the previous two steps. This
image is used to create extrusions and grooves on the 3D surface that
correspond to the highlight and dark areas of the image itself. Because it's
identical to the Reflection and Texture maps, the 3D 'bumps' will correspond
nicely to the original image. This gives it a more natural textured appearance.

7 Click OK to return the edit window. The path object updates itself accord-
ingly.

      An example of a textured sphere object

To import illustration files into PhotoImpact:

1 Click New [CTRL+N] on the Attribute toolbar to open a new file and select
the Path tool from the Tool panel.

2 Choose the Select Custom Shape from the Edit menu on the Attribute
toolbar. A Custom Shape dialog box opens, displaying image objects from
your gallery.

3 Click Import to get the previously-saved illustration (.AI) files. An Input AI
Files window opens, prompting you for the name of your .AI file.
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4 Once you found the file you wish to import into your workspace, click
Open. The window closes and the file automatically becomes a thumbnail in
your gallery.

5 Click OK. The Custom Shape dialog box closes, returning you to your
workspace.

6 Select Custom Shape from the Edit menu on the Attribute toolbar. You may
now import your .AI file onto your image by dragging your mouse onto any
area you want the saved illustration to appear.

7 The vector-based illustration now appears on your workspace, allowing you
to easily manipulate it using either the Path or the Bezier Curve tools.
(Functions of each are discussed on p.118  and p.125, respectively.)

Note:  You can always toggle between the Path and the Bezier Curve tools to create
the best effect.

Grouping and ungrouping paths

When you edit an existing path, such as text, the path is likely to be in a com-
plex form containing many separately closed paths. You can edit these individu-
ally or as a group. To edit them as a group, first select them by dragging your
mouse over or using the Shift key in conjunction with your mouse, then select
the Group command on the Path menu. (You can find this command by right-
clicking over a path.) To ungroup a path, select it and then click the Ungroup
command from the same menu.

  

An example of selecting or grouping seperated paths

Filling a path

Whenever you convert a path into an object, the path is filled with the color
specified in the color square on the Attribute toolbar. Using the Even-Odd fill
option on the Attribute toolbar, you can determine how this fill takes place. For
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example, if left cleared, the fill occupies the entire interior of the path. This
option is particularly useful when you wish to maintain a solid fill whenever
paths overlap. When selected, the fill occupies different regions of the path, in
particular, regions where a path is folded over onto itself or contains multiple
paths inside. This option is best for when you have a complex or irregular path
whose overlapping portions you wish to keep free of paint.

    

Original path   Path with an Even-Odd fill      Path without an Even-Odd fill

Using the Bezier Curve Selection tool

The Bezier Curve tool is similar to the Path tool in the sense that it acts as a
joint tool allowing you to create more complex curves but with the exception
that it does not incorporate Object Mode. As mentioned earlier in the Path tool,
when you are done creating a selection, you can choose from the various
Object modes available in the Mode drop-down menu on the Attribute toolbar.
But with the Bezier Curve Selection tool, after you've done creating a path,
click the toggle button beside the Shape drop-down menu to toggle between
Path Edit and Selection mode. The Path Edit option allows you to either draw a
new path using the Bezier Curve Selection tool or edit an existing path. The
Shape drop-down menu on the Attribute toolbar lets you select a shape for your
new path. Choices range from Rectangle, Square, Ellipse, Circle, and Free Path,
which you may use when you want to create paths freely.

Once you have an active path on your workspace, meaning the path you have
created is in the Selection mode and not Path Edit (the path is in the Selection
mode if you see a marquee or the bluish dotted lines around the selection you
made), you will notice that the options on the Attribute toolbar are grayed out.
To activate the options, click anywhere on your base image. Only then can you
manipulate your path.
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The chapter in review

Here are some key points and tips to remember from this chapter:

• Use Auto-Process to automatically enhance images (p.86).

• CTRL+R allows you to crop an image on the fly (p.87).

• The Color Cache gives you quick access to the most frequently used colors
(p.94)

• Paint tools allow you to enhance images with a complete range of profes-
sional artistic tools with which to enhance images  (p.98).

• Use the Brush Panel to customize paint tool settings (p.101).

• Retouch tools give you the means to clean up poorly-scanned or problematic
images (p.104).

• Clone tools let you paint images, selection areas, and objects into one another
(p.106).

• CTRL+F opens the Fill dialog box, allowing you to fill selections or objects
with selected colors, textures, or gradients (p.112).

• The Transform tool lets you warp, twist, and turn images in either two or
three dimensions (p.114).

• Use the Path tool to create custom 2D or 3D shapes and objects (p.120).

Other topics of interest

If you would like to learn more about:

• Adding special effects to your image layers, or creating new special effect-
based animations, see Chapter 5 (p. 127).

• Imaging for the web, see Chapter 6 (p.161).

• Acquiring images for enhancement, see Chapter 3 (p.69).

• Managing your web-based animations and other images, see Chapter 8
(p.217).



Chapter 5

Special Effects

Special effects are a fun, and sometimes essential part, of imaging.

With them, you can turn plain old photographs into virtual pieces of

artwork. PhotoImpact contains a host of high-end, special effects

filters and plug-ins to give your work that extra bit of pizzazz. In this

chapter, you will learn how to create such effects as Smoke and Fire,

Ice, and Neon glows while the Creative and Artist plug-ins allow you to

mimic some of the more complicated real-world painting effects.

In this chapter you will learn:

• Special effects and filters ........................................................................... 128

• Warping an image ...................................................................................... 132

• Creating your own effects ........................................................................... 133

• Creating your own filters ............................................................................. 134

• Creating text effects .................................................................................... 135

• Using the Material dialog box .................................................................... 138

• Using Magic and Creative effects .............................................................. 145
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Special effects and filters

PhotoImpact provides you with a wide range of effects and filters to apply to
your images and/or object layers. You can apply effects and filters via three
methods: drag-and-drop preset effect thumbnails from the EasyPalette into the
image; configure the effect individually via the Effects menu commands; or
double-click the effect thumbnail in the EasyPalette gallery. Custom effects and
filters can be stored in the EasyPalette for use later.

Note: Because of the way filters and effects work, you can only apply them to True Color
(24-bit) or Grayscale (8-bit) image data types. If you have an image that doesn’t match
this criteria, then you can easily convert the image to True Color or Grayscale using the
Format: Data Type - submenu or by clicking the Image Type button in the lower right hand
corner of the PhotoImpact program window. With many third party plug-ins, you may also
be required to create a selection before the plug-in can be implemented.

Applying effects and filters to an image

The most convenient way to apply effects and filters is to drag-and-drop them
from the EasyPalette to the image, selection area, or object in question. To open
the EasyPalette, click the EasyPalette button on the Standard toolbar. When it
opens, click the Gallery button and select Effect Gallery from the drop-down
menu. The Effect Gallery displays all the effects and filters available, displayed
as thumbnails with various settings predefined. These settings are applied
automatically each time you drop the thumbnail into an image. To change the
default settings, right-click over the thumbnail and select the Modify Properties
and Apply menu command. The filter- or effect-specific dialog box opens,
allowing you to adjust its properties. For more on managing thumbnails in the
EasyPalette, see pp.45-47.

Note:  When you drop a filter or effect into a selection area, it gets converted to an object
and then the effect is carried out. The advantage to this is that the original selection is left
intact, allowing you to experiment with variations on the effect or filter and compare them.
If you are satisfied with the results of the effect or filter, then you can right-click over the
new object and select the Merge command to integrate it with the base image.

Customizing effects and filters

Each time you initiate an effect or filter from the Effect menu, a dialog box
opens showing you a range of thumbnails (although this may not be true with
all effects). The thumbnail in the center of the dialog box is the one that’s
applied to the image, selection area, or object. To adjust it, click any of the
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surrounding thumbnails and, in some effects, they shift accordingly. Generally,
anything to the left and top is less, while anything to the right and bottom is
more. That means less or more of the effect is applied to the image depending
on which area of the thumbnail gallery you click. To customize the settings for
the effect or filter, click the Options button. This opens that effect’s or filter’s
particular options dialog box where you can manually adjust the settings. If you
like the changes you’ve implemented, click the Add button to save the custom
effect to the EasyPalette.

  

The Cool Effect dialog box               The Add to EasyPalette dialog box

Modifying an effect or filter

When you want to apply an effect or filter to an image but do not wish to use
the default settings, you can modify it by either right-clicking over its thumbnail
and choosing the Modify Properties and Apply command or by choosing its
respective command directly from the Effect menu. Either action opens a
dialog box displaying that effect’s or filter’s settings as well as a preview
thumbnail of how the effect or filter modifies the image and a reference
thumbnail of the image for comparison. (For more information on how to
adjust these settings, click the dialog box’s Help button.)

  
Average Blur Emphasize edges



  

  

  

  

Find Edges Gaussian Blur Sharpen Edges

Unsharp Mask Add noise Despeckle

Remove Moiré Cool Facet

Warm Mosaic Motion Blur



  

  

  

  

Fat Thin Ripple

Whirlpool Pinch

Sphere

Punch

Watercolor Charcoal

Oilpaint Colored Pencil Emboss
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Warping an image

Warping is a method of distorting an image using a grid (or mesh) based
pattern. This grid is visible on a sample thumbnail that appears in the Warping
dialog box, opened by clicking the Warping command on the Effect menu. In
this dialog box, you can define the size of the grid squares and whether or not
to show control points at grid intersections. To warp an image, simply drag on
a grid intersection point. To see how the changes affect the image, press the
Test button. This adjusts the preview thumbnail at the bottom of the dialog box.

An example of warping an image

Note:  You can only warp True Color and Grayscale images.

Puzzle Tile Wind

Blast Stagger Warp
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Creating your own effects

The Custom Effect command in the Effect menu works in much the same way
as the Warping command in that it distorts the pixel positions in an image. The
difference, however, is that the Warping feature allows you to manually distort
a specific area of an image, whereas the Custom Effect distorts the pixels over
an entire image, changing their x and y coordinates respectively.

To create your own custom effects:

1 Click the Effect: Custom Effect menu command. The Custom Effect dialog
box opens.

The graph displayed in this dialog box represents the physical placement of
pixels in an image. In general, a steeper curve moves pixels in (pinching),
while a shallow curve moves pixels out (punching).

2 Click the Methods button and choose one of the predefined mapping
curves.

3 Drag your mouse over the mapping curve to change its shape. The change
is immediately applied to the preview thumbnail.

For better control, select the Show control points check box. This displays
control points on the curve that you can adjust without affecting the neigh-
boring ones. You can determine the number of control points that appear by
entering a value in the points spin box.

4 To save the effect for future use, click the Add or Save button. Add saves
the effect to the gallery you choose in the EasyPalette, whereas Save saves
the effect to a file which you can then distribute to others.

5 Click OK to apply the mapping curve to the image.
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Creating your own filter

Many of the filters provided by PhotoImpact work by regenerating a pixel value
based on its original value and the value of its surrounding pixels. The Custom
Filter feature allows you to create your own filters in a similar way using a 5 by
5 pixel matrix. After specifying values for the different cells of this matrix, that
matrix can then be applied, pixel by pixel, to an image to produce a variety of
special effects.

Note:  You can only create custom filters for use with True Color and Grayscale images.

To create your own filter:

1 Click the Effect: Custom Filter menu command. The Custom Filter dialog
box opens.

2 Click the Samples button and choose one of the predefined enhancements.

3 Enter values in the matrix cells.

The cell in the middle of the matrix represents the pixel whose value is going
to be regenerated. The surrounding cells represent the surrounding pixels
and the values determine the relative weighting assigned to them when the
matrix calculates a new value.

Changing the Divided by value allows you to control the contrast of the
custom filter and the Offset value controls the brightness of the custom
filter by adding to or subtracting from the matrix the value entered.
To convert the colors in the custom filter to their complimentary colors,
select the Invert check box.

Note:  To change values of the matrix back to their original state (a one in the center
surrounded by zeros), click Reset.
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4 To save the effect for future use, click the Add or Save buttons. Add saves
the effect to the gallery you choose in the EasyPalette, whereas Save saves
the effect to a file which you can then distribute to others.

5 Click OK to apply the custom filter to the image.

Creating text effects

PhotoImpact contains extremely versatile text generation tools that allow you to
create custom 3D or 2D text with gradient, texture, and magic texture fills as
well as add shadows and other effects to them. With the Text tool, you can
create dynamic and exciting text to liven up any web site or presentation.

To create text:

1 Click the Text tool button on the Tool panel. With your mouse, click in the
portion of the image that you want the text to appear (you can change this
later by dragging the text into a new position.) The Text entry box appears.

2 Type in your text in the text entry area. To break a sentence before a word,
press Ctrl+Enter. To type in specialized characters not found on the key-
board, such as the © symbol, enter the appropriate keyboard shortcut into
the keyboard numberpad (i.e. Alt+0168 gives you the copyright symbol for
most standard fonts). Alternatively, you can open the Windows Character
Map and copy the symbol or character to the clipboard and then paste it into
the text entry area. All non-standard characters appear as lines in the Text
Entry box, but they generally ‘print’ correctly in the image.

  

3 Select the Vertical option to have the text print top to bottom (to change its
direction, select the text and use the Tranform tool’s flip button on the
Attribute toolbar.)

4 Click OK when you are finished. The final text appears in the image.
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Enhancing text

Once you’ve created and positioned your text, the next step is to give it that
extra spark of life to make it really stand out. You can use any of the Transform
tools to warp it or you can create custom color or texture fills, as well as make
the text 3D or add shadows to it. Use the Path tool to twist your text into any
shape you like (however, using the Transform or the Path tool can sometimes
remove the Text attributes of the object, not allowing it to be edited any fur-
ther.) Finally, the Material dialog box, available to both the Text and Path tools,
can be used to add unique effects to a text object’s surface.

To create 3D text:

1 Click the Text tool on the Tool panel and then click on the edit window.
Enter your text in the Text Entry dialog box that appears.

2 Select one of the 3D options from the Mode drop-down menu on the
Attribute toolbar. The text changes accordingly. With some particularly
complex fonts, this may take some time.

 

Some examples of 3D text

To add a shadow to text:

1 Click the Text tool on the Tool panel and then click in the edit window. Enter
your text in the Text Entry dialog box that appears.

2 Click Options on the Attribute toolbar to open the Material dialog box.
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3 Click the Shadow tab and select the Shadow option.

4 Click the Options button to customize the text shadow. The Add Shadow
dialog box opens.

5 Select the Direction and the X- and Y- offsets. The X- and Y- offsets
describe the number of pixels away from the original object that the shadow
lies, in both the X and Y planes.

6 Enter the Transparency for the shadow. The higher the value, the lighter
that the shadow will appear.

7 Enter the Shadow size. You can reduce the shadow by half, increase by
double, or any variation in between.

8 To give the shadow a soft edge, select the Soft edge option and enter a
value in the entry box. The edge blending value describes the average
number of pixels around the shadow’s edge that are ‘softened’ to give the
shadow a more natural look.

9 Enter the color of the shadow by clicking the color box at the bottom of the
dialog box. This opens the Ulead Color Picker. To select a color from the
quick palette, right click over the color box and select a color from the
Color Picker that appears.

10 Click OK to return to the Material dialog box.

11 Click OK to exit the Material dialog box and return to the edit window.
Note: Once a shadow has been added to an object, it’s ‘grouped’ with that object. To
separate the shadow from the object, right-click over it and select the Ungroup menu
command from the pop-up menu. This allows you to drag the shadow away from the object
and manipulate it independently.

 

Some examples of text with shadows
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Using bump maps

“Bump map” is a colloquial term describing an image file that, when applied to
another image, creates the appearance of 3D grooves and extrusions on the
image’s surface. This is done by creating a ‘slope’ based on the color densities
within the image (the darker a particular region is, the ‘deeper’ the groove,
while the lighter a region is, the ‘higher’ the extrusion appears).

To add a bump map texture to text:

1 Click the Text tool on the Tool panel and then click in the edit window.
Enter your text in the Text Entry dialog box that appears.

2 Click the Options tab to open the Material dialog box and then select the
Bump tab.

3 Select the Bump option. If no bump map has been previously assigned to
the text, a Browse dialog box opens allowing you to search for and select
the image file you want to use to create your ‘bump.’ Otherwise, you can
click the File button to open the Browse dialog box and locate the file.

4 Enter the desired density of the bump, where 100% is the maximum and 0%
is the minimum. Density describes the strength with which the bump
shows through the surface image.

5 Select the Use bump as reflection to map the image across the top surface
of a 3D object. If left cleared, the image is mapped to the ‘flat’ dimensions
of the object and does not compensate for the 3D curve.

6 Click OK.

 

A text object without and with a bump map applied

Using the Material dialog box

The Material dialog box is where you give a text or path object life. With it, you
can add shadows, reflections, textures, bumps, and light sources to any kind of
text or path-based creation. You can open the Material dialog box by clicking
the Options button while using either the Text or Path tools.
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MATERIAL DIALOG BOX: COLOR/TEXTURE

The Color/Texture tab alllows you to customize the object’s appearance with either simple
or gradient colors, or either a natural or magic texture fill. Texture fills are applied to the
area within an object’s border regardless of whether the object is 3D or not.

One color – fills the object with single color. To select the color, click the color box to
open the Ulead Color Picker or right-click over it to select a color from the popup menu.

Gradient color – fills the object with a gradient created between two solid colors.
Click the color box to open the Gradient Fill dialog box, where you can set the gradient
colors as well as direction.

Texture  – fills the object with a magic or natural texture selected from the Magic or
Natural Texture gallery. Alternatively, you can load a texture from file by clicking the File
button.

File  – fills the object with the texture from an image file. Click the File button to open the
Browse dialog box and search for a file to use.

Deform image  – select this to ‘lock’ the color, gradient, or texture fill to the path or text
object. If the path or text object is subsequently transformed, the ‘locked’ color, gradient, or
texture maintains its original alignment with the object.

MATERIAL DIALOG BOX:  BEVEL
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The Bevel tab allows you to define the 3D edge of an object with a variety of preset styles,
or you can use the custom style to create your own.

None  – removes the beveled edge from a 3D object, effectively making it 2D.

3D Round – creates a round appearing beveled 3D edge.

3D Chisel – creates a chiseled or squared off appearing beveled 3D edge.

3D Trim – creates a light gradient fill that gives the appearance of a 3D surface
without actually having any beveled edges.

3D Pipe  – turns the object into a 3D frame where the inside is empty and the outside
edge becomes a tube or pipe.

3D Custom  – allows you to create custom 3D edges, used in conjunction with the
Border/Depth tab.

MATERIAL DIALOG BOX: BORDER/DEPTH

The Border/Depth tab allows you to define the relative ‘thickness’ of a 3D object, both in
height (Depth) and beveled edge (Border).

Border  – defines the width of the border in number of pixels.

Depth  – defines the depth of the object, either as an extrusion or a depression. The
depth value is measured on a scale of -100 (maximum depression) to 100 (maxiumum
extrusion).

Maximum border width  – defines the range, in pixels, of the border. The higher the
number, the more of a ‘slope’ attributed to the border.

Type of border  – defines whether the border grows inward or outward. If you select
Both, then a hollow frame is formed out of the object.
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MATERIAL DIALOG BOX: BUMP

The Bump tab is where you give more dimension to your 3D creations by applying ‘bump
maps’ to their surfaces. Bump maps create grooves and extrusions in the surface of a 3D
object based on the contrasting dark and light areas.

Bump map  – enter the path and file name for the image file you wish to use as a bump
map. To browse your computer for the file, click the File button.

Bump map density  – describes how strong the bump map’s impressions in the
surface of the image appear. 100% is the highest density while 0% is the lowest.

Use bump map as a reflection  – maps the bump map across the 3D slope of the
object and not to the dimensions of the object (when an image is mapped to an object’s
dimensions, it appears flat despite the 3D slope of the object.)

MATERIAL DIALOG BOX: REFLECTION

The Reflection tab allows you to create a raised surface on an object’s face. This differs
from the Texture tab in that the reflection image is actually mapped to a curved, 3D surface.

Reflection map  – select this option to add an image file as a reflection to the surface
of the object. Click the File button to browse for the desired reflection map. Reflection
mapping applies the image used across the surface of the object, following the 3D slope.

Density  – enter the strength with which the image shows through as a reflection on
the object’s surface. The higher the number, the stronger the density.
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MATERIAL DIALOG BOX: TRANSPARENCY

The Transparency tab lets you set whether or not you can ‘see through’ the object, and if
so, to what degree.

Transparency  – defines the relative transparency of the object. The higher the value,
the more transparent it is, while the lower the value means a more opaque object.

Minimum  – sets the minimum transparency for the edges of the object. This allows
you to create a gradient transparency.

MATERIAL DIALOG BOX: LIGHT

Lights – defines the number of lights illuminating the surface of the object (up to 4).

Light #  – sets whether the light is Direct  or Spot . Direct has a larger soft edge and is
not as heavy, while Spot is more focused and not as a light as Direct.

Ambient  – defines the relative strength of ambient light across the surface of the
object.
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MATERIAL DIALOG BOX: SHADING

The Shading tab allows you to define whether the material reflects light metallically or like
plastic.  Plastic, or Phong, describes a non-shiny shading scheme.

Phong – adds a non-metallic sheen to the surface of the object.

Metallic  – adds a metallic sheen to the surface of the object.

Shininess  – defines the relative shininess of the shading across the surface of the
image. The higher the value, the shinier the shading is.

Shine strength  - defines the density of the shininess of the object’s surface.

MATERIAL DIALOG BOX: SHADOW

The Shadow tab is where you assign a shadow to your object. It also gives you the option
to have PhotoImpact ‘draw’ the backside of the 3D object.

Shadow  – opens the Add Shadow dialog box, allowing you to customize the type of
shadow applied to the object. For more on applying a shadow to an object, see p.62.

Render backface  – select this option to draw the ‘backside’ of the object. This is only
useful if the object is transparent and the ‘backside’ shows through.
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Customizing material settings

Each time you open the Material settings dialog box and make adjustments, you
can save the changes to the EasyPalette for later use. Saving your settings
regularly ensures that you always have a constant supply of new and unique
presets on hand. Additionally, stored Material dialog box settings can be later
modified to create variations on a theme and then saved independently of the
original.

To save Material dialog box settings to the EasyPalette:

1 From the Material dialog box, click the Add button. The Material Save
Options dialog box opens.

2 Select either All to save all the Material settings, or Partial  to choose which
settings to save.

3 Click OK to close the Material Save Options dialog box and open the Add to
EasyPalette dialog box.

4 Enter the name for the new thumbnail in the Sample name entry line.

5 Select the Gallery to which you want to save the settings. Alternatively, you
can choose the last Gallery and Tab activated in the EasyPalette from the
Recently used drop-down menu.
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6 If the chosen gallery contains tabs, select the Tab group to place the
thumbnail on.

7 Click OK to add the settings to the EasyPalette. The thumbnail appears
immediately in the appropriate location.

Later, if you want to alter the settings for a particular thumbnail in the
EasyPalette, right-click over it and select Modify Properties and Apply from
the popup menu. This opens the Material dialog box, allowing you to change the
existing settings and save them as a new thumbnail in the EasyPalette.

Using Magic and Creative effects

In addition to the plethora of special effects and filters introduced on pp.129-
132, PhotoImpact also has two plug-in libraries of powerful and unique effects:
Magic and Creative. These effects give you the maximum amount of versatility
and creativity with a minimum amount of work (otherwise, performing these
kinds of effects from scratch, using macros and paint tools, would take ages.)
With them, you can create any kind of special, custom effect to give your work
that extra edge.

Note: The Magic and Creative effects, like the other effects and filters, are designed to
work with True Color or Grayscale images. They can be quickly accessed from the
EasyPalette as well as the Effects menu.

Applying a Magic Gradient

Magic Gradient is the tool for generating wild gradient patterns that can’t
normally be accomplished using the Gradient tool or a Gradient fill.

To apply a Magic Gradient to a selection area or path:

1 Create a selection area where you want to fill in the Magic Gradient or
create a new path using the Path tool. (You can modify an existing path, as
described on p.120).
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2 Click the Effect: Magic - Magic Gradient menu command to open the Magic
Gradient dialog box.

3 To select a gradient ramp to use or to modify the existing one, click the Edit
button. The Palette Ramp Editor dialog box opens. Select the Palette ramp
you wish to use and click OK to return to the Magic Gradient dialog box.

Note:  To edit a ramp on the fly, enter new values to the Hue Shift entry box or the Ring
entry box. This causes the color spectrum of the ramp to shift.

4 Select the gradient style from the Mode list.

5 You can adjust the positioning of the gradient with the Slope dial. Turn the
dial in either direction to move the gradient accordingly.

6 Click OK.

 

Gradient fills applied to a heart-shaped object
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Applying a Kaleidescope effect

Kaleidescope allows you to create multiple, spiraling images within an edit
window, creating an effect similar to the one found in a child’s kaleidescope
toy. The Kaleidescope effect can be customized to give you unique effects each
time you use it.

To add a Kaleidescope effect:

1 Click the Effect: Magic - Kaleidescope menu command to open the
Kaleidescope dialog box.

2 Select the type of Kaleidoscope effect you want to apply to the image. If
you want to create a custom Kaleidoscope effect, click the Options button.
This opens the custom Kaleidoscope dialog box.
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3 From the different options, select a Kaleidoscope style. In the first preview
window, adjust the bounding box until you get the effect you want (shown
in the second preview window.)

4 Click OK to apply the effect.

 

The Kaleidoscope effect applied to two images

Applying Light to an image

The Light effect is very useful for adding a spotlight or soft ambient light to an
image, further enhancing it and drawing out aspects of it that might otherwise
go unnoticed or overshadowed. The effect itself uses a combination of Bright-
ness and Contrast adjustments together to create the light and shadows that
play across the image’s surface.

To add Light to an image:

1 Click the Effect: Magic - Light menu command to open the Light presets
dialog box.
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2 Select the preset you wish to use to achieve the desired lighting effect. If
none of the presets matches what you had in mind, click the Options button
to open the Light customization dialog box.

3 Set the Exposure to define the amount of light hitting the image. The range
can be anywhere between 0 and 200%. The higher the value entered, the
more light that is let through to the image.

4 Define the color and setting for the Ambient brightness. Use the color box
to set the color and the slider tab to set the brightness level.

5 Set the Light color and brightness. The color can be selected from the color
box to the right of the slider tab, which defines the brightness of the light.

6 Adjust the Light angle until you have achieved the effect that you want by
moving the light angle nodes with your mouse cursor (or by setting the
Skew, Spread, Distance, and Elevation manually in the entry boxes pro-
vided.)

 

Two images with the Light effect applied
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Creating a Turnpage effect

The Turnpage effect is useful for giving your images that curled edge look that
makes them appear as if they are attached to a piece of paper or a page from a
book. With it, you can ‘turn’ an image to any degree desired and from any
corner you wish.

To create a Turnpage effect:

1 Click the Effect: Magic - Turnpage menu command to open the Turnpage
dialog box.

2 Select the type of curl to apply to the image from the Type options. You can
choose between Cylindrical and Conical.

3 From the Corner options, select from which point on the ‘page’ the turn
originates from. You can choose any one of the four corners.

4 Set the page-turn Mode. Opaque gives you a non-transparent curled edge,
while Reverse gives you a reflection of the original image showing through
the curled edge. Transparent shows the mirror inverse of the image on the
curled edge as if the image being turned is printed upon cellophane.

5 Define how much the tip of the curled edge turns inward using the Angle
dial. The higher the value, the more the page curls in upon itself.

6 Using the Slant angle controls in the left-hand preview window, define the
size of the page-turn. The two outer nodes adjust the individual sides while
the center node allows you to move both sides simultaneously.

7 Using the Lighting direction  control, adjust how the light plays across the
page-turn.

8 Click OK to apply the effect and return to the edit window.



SPECIAL EFFECTS 151

Using the Artist Texture effect

The Artist Texture effect allows you to create wild, psychedelic patterns and
semi-random animations using Palette ramps. It works in conjunction with GIF
Animator when creating animations, passing the image layers over to it as they
are generated (these animations can be used as backgrounds for webpages, a
feature supported by the 4.0 series of web browsers). It also lets you generate
single image layers and can be applied to both selection areas and objects.

To create an Artist Texture effect:

1 Click the Effect: Creative - Artist Texture menu command to open the Artist
Texture dialog box.

2 Click the Edit button to customize the existing Palette ramp or to choose an
entirely new one. The Palette Ramp Editor opens. Select the Palette ramp
you wish to use or modify the existing one, then click OK to return to the
Artist Texture dialog box. Alternatively, to edit the existing ramp from within
the Artist Texture dialog box, adjust the Hue shift, Ring, and Repeat
number options until you get the desired effect.

3 Select a style from the Pattern samples preview boxes or create a new set
of 6 by selecting a base image from the Pattern templates. The Pattern
Templates define the basic ‘warp’ that is applied to the Palette ramp,
samples of which are displayed in the Pattern samples area. The samples
change according to alterations made during palette customization.
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4 Click OK to create a single pattern in the active edit window. The Artist
Texture dialog box closes and the effect is applied. However, if you wish to
create an animation, click the Advanced button to continue.

5 Drag a sample from the Pattern samples box down into the Storyboard to
add it to the animation sequence. Depending on the number of frames
selected for the animation (see the following steps), the frames in the
Storyboard morphs from one into the next, and so on down the line. If you
have less frames, then the morphing transition is not as apparant.

6 After selecting the frames in your animation, click the Animation button.
This opens the Animation dialog box.

7 Select whether to export the animation to GIF Animator (click the GIF
animation option) or as a sequence of images. If you export as a sequence
of images, each frame in the sequence is labeled name0001.bmp where
name is the one you specify in the Save As dialog box.

8 Enter the number of frames for the animation or sequence.

9 Click OK. If you selected GIF Animation, the images are sent directly to
GIF Animator. If you selected Image Sequence, then you are prompted to
specify a folder and name for the images.

   

Frames from an animation created using the Artist Texture plug-in
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Using the Creative Warp effect

The Creative Warp effect lets you apply the Kaleidoscope effect in conjunction
with Artist Texture to an image but rather than output it as a single frame, you
can create an animation or an image sequence by using multiple kaleidoscope
effects simultaneously.

To create a Creative Warp effect:

1 Click the Effect: Creative - Creative Warp menu command to open the
Creative warp dialog box.

2 Select the Pattern template you wish warp the image with.

3 Click Advanced to expand the dialog box and display the Storyboard at the
bottom. Drag the warped image from the right-hand preview pane down to
the Storyboard to add it to the sequence. To remove an image from the
sequence, first click the icon in the Storyboard then the Delete button. To
remove all the images from the sequence, click Delete All.

4 After setting up all the images in the sequence, click the Animation  button
to open the Animation dialog box.

5 Select whether to export the animation to GIF Animator (click the GIF
animation option) or as a sequence of images. If you export as a sequence
of images, each frame in the sequence is labeled name0001.bmp where
name is the one you specify in the Save As dialog box.

6 Enter the number of frames for the animation or sequence.

7 Click OK. If you selected GIF Animation, the images are sent directly to
GIF Animator. If you selected Image Sequence, the you are prompted to
specify a folder and a name for the images.

    

An animation created using the Creative Warp effect
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Creating painting effects

The Painting effects dialog box is extremely useful for creating special paint
such effects as impressionistic-style paint strokes over an image or special
canvas and paint texture effects. The Paint Effects plug-in allows you to use
pre-defined effects templates, customize templates, and create your own.

To create special paint effects:

1 Click the Effect: Creative - Painting menu command. The Painting effects
dialog box opens.

2 Select a template from the Paint templates gallery to apply to the image in
the Preview window. The image in the Preview window changes accord-
ingly to display the image with the template effect applied.

3 Use the Fine control panel and the Patterns gallery to either customize the
existing template or create a new one. All the templates are based upon the
Patterns, so if you customize one of them, you can save it to the Pattern
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templates gallery. Click the Add button to save the custom Paint Effect to
the EasyPalette. To view the Pattern templates using the active image as the
source for the thumbnails, click the Try  button. Clicking the Default button
restores the thumbnails back to the original image. To use an existing BMP
file as a pattern, click the Load button and browse for the file you wish to
use. When this pattern is applied to the image in the Preview window, its
attributes define how the pattern is implemented.

 

4 Click OK when you are satisfied with the effect and want to apply it to the
edit window or object.

 

An image before and after applying a Paint Effect

Adding Particle effects

Particle effects are a revolutionary way of creating similar effect objects with
maximum variation between them. For example, Particle effects allow you to
create snow, rain, fireballs, stars, and fog. With the Particle effects plug-in,
each flake of snow, drop of rain, or wisp of smoke you create has its own self-
contained set of attributes which can be individually customized.
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To add a Particle effect to an image:

1 Click the Effect: Creative - Particle menu command to open the Particle
dialog box.

2 From the Effect gallery, select a particle effect to apply to the image.

3 In the Effect control box, define the number of objects (or particles) using
the Density slider tab. You can also define the basic size of each particle as
well as the variation between them.
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4 In the Particle parameters box, define the basic, general attributes of the
particles, such as color, hue, and opacity. Each Particle effect has its own
set of parameters.

5 To set the attributes for a particular Particle, click the Particle to modify
within the preview window. Selecting the Particle shows you its own
individual set of Effect controls and Particle parameters if it, in fact, has
any. You can also select the individual particles to reposition them.

6 Click OK to use the settings and apply the Particle effect to the image.

 

An image before and after the Particle Effect plug-in has been applied
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Using the Transform effect

The Transform effect turns your image into virtual clay, allowing you to push
its pixels around in order to transform the surface. It differs from the Trans-
form tool on the Tool panel in that it doesn’t allow you to manipulate the
position of a selection or object, but rather manipulate its ‘consistency.’

To transform an image:

1 Click the Effect: Creative - Transform menu command. The Transform
dialog box opens.

2 Select the Transformation template from the gallery. This establishes the
transform parameters for the Transform paint tool. To adjust these param-
eters, enter new values in the Transformation control options.

3 In the left hand preview pane, use your mouse cursor to transform the
image. Your cursor becomes a Transform paint tool  while working in the
preview image.

4 To save the image to the Storyboard below, click the Insert button. You can
Reset the image at any time and select a new Transformation template to
begin again or you can change templates in mid-transformation.

5 Click the Animation button to create a GIF animation or an image sequence
of the transformation. Click OK to apply the current effect (or effects) to
the active object or edit window.

   

An image manipulated with the Transform effect plug-in
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Adding special Type effects

The Type effects plugin gives you the opportunity to modify text and objects in
ways beyond the capabilities of the Text and Path tools. With it, you can add
fire, ice, neon glows, and branding, among other things, to text objects.
Combined with the innate functions of the other tools, this effect can be quite
powerful.

To add a special type effect:

1 Click the Effect: Creative - Type menu command to open the Type dialog
box.

2 Choose the effect you want to apply to the selected object from the Effect
gallery. Every time you select an effect, the preview window adjusts
accordingly and the effect’s controls appear in the Parameters box.

3 Modify the effect’s Parameters until you achieve the result you wish. Each
effect has its own unique set of parameters.

4 Click the OK button to apply the effect to the selected object.
Notes: Type effects replace the text object, effectively rendering it un-editable with the
Text tool once it’s been applied.

 

The Type effect applied to text
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The chapter in review

Here are some key points and tips to remember from this chapter:

• Special effects and filters can only be applied to True Color (24-bit) and
Grayscale (8-bit) images (p.128).

• Most effects can be customized (p.128).

• You can create your own Effect or Filter by selecting the Effect: Custom
Effect or Custom Filter menu commands (p.133).

• Text effects can use any character that appears in the font information.
Specialized characters, such as the copyright symbol (©) can be generated
by pressing the Alt key and entering the character’s numeric value on the
numberpad of your keyboard (p.135).

• Using the Material dialog box, you can add textures, bump maps, shadows,
reflections, and light to either text- or path- based objects (p.138).

• Use the Light effect plug-in to create ambient or spot light on an image
(p.148).

• The Artist Texture effect plug-in allows you to create animated backgrounds
for use on the web (p.151).

• Painting effects give a wide variety of tools for reproducing real-world
painting techniques (p.154).

• Particle effects allow you to create multiple objects of the same type with
maximum variation between them (p.155).

• Type effects let you customize text and objects above and beyond the
parameters of the Text and Path tools (p.159).

Other topics of interest

If you would like to learn more about:

• Enhancing animation images, or to creating new ones, see Chapter 4 (p.85).

• Using GIF Animator to bring special-effects enhanced images to life, see
Chapter 7 (p.193).

• Optimizing images for display on the Web, see Chapter 6 (p.161).
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Imaging for the Web

Imaging for the web has become, in recent years, a major concern for

many corporations and small businesses. There is no other single

medium outside of television that allows a company to reach as many

people as the World Wide Web does, and the quality of a web site’s

content can make or break a company’s presence on the web. That’s

why you need the best tools available for creating lively web content,

and PhotoImpact can give them to you.

Chapter 6

In this chapter you will learn:

• Understanding the web .............................................................................. 162

• Basic web imaging ..................................................................................... 168

• SmartSaving web images .......................................................................... 174

• Advanced web imaging ............................................................................. 184

• Creating image maps ................................................................................ 184

• Creating custom HTML tags ....................................................................... 186

• Adding shadows to objects ........................................................................ 187

• Adding frames to images ........................................................................... 188

• Assigning a Helper Program ..................................................................... 191
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Understanding the web

Without the ability to display images, the World Wide Web would be just another
fancy BBS. Graphics set the web apart from other Internet protocols; they are
the hook that catches the reader’s eye, the dynamic, sometimes interactive,
element that makes the web a very powerful form of communication. Images
add color, detail, and information that enhance your web site and make it more
interesting to browse.

How an image is displayed on the web

Displaying images on a web page, at first glance, is as easy as writing the
HTML code to place it there. At least, that’s the impression most people have.
Unfortunately, it’s not that simple. The method with which images are displayed
varies significantly from computer to computer, platform to platform, and
browser to browser. Different computers have differing gamma values for their
monitors, differing display cards which render colors in their own, proprietary
way, and quite possibly different operating systems, each of which has its own
methods for displaying the color information sent to it from the display card. In
addition to physical, hardware differences, the type of web browser someone is
using affects the way a page and its graphics appear. In many cases, the display
differences are quite minor and don’t amount to much. In other instances, they
can be quite severe.

An image on a PC monitor An image on a Macintosh monitor
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Generally, you’ll find that images appear slightly darker on PC monitors and
slightly lighter on Macs. Depending on an individual computer’s hardware and
software configuration, this may not always be true, however. Also, given the
rate at which technology changes, monitors nowadays are becoming more
uniform between operating systems, so the display differences may not amount
to much. In order to compensate for possible display differences, you should
create images with strong contrast and color values, so that they display clearly
no matter what the monitor they appear on is set at. For more on adjusting an
image’s contrast and color values, see pp.90-93.

Gamma

Gamma is the amount of brightness and contrast for any given monitor. Very
rarely do you find two computers with the same gamma, especially since
temperature and environment play a big a role in determining how color ap-
pears. As a result, images displayed on one monitor are going to look slightly
different on another monitor. When creating images for the web, it’s best to
calibrate your display to ensure the best image reproduction. An image created
under balanced gamma levels won’t change too extremely when viewed on
monitors with slightly higher or lower gamma settings.

Adjusting your monitor's gamma

When working in PhotoImpact, you can adjust the gamma of your working
environment by clicking the File: Preferences menu command. When the
Preferences dialog box opens, click the Display tab. Select Monitor gamma and
then adjust the gamma value until the two gray squares match. Also, depending
on your monitor type, you can manually adjust the monitor’s gamma via its
built-in control panel. For more information on this, consult the user’s manual
that came with your monitor.

The Display tab in the Preferences dialog box
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Bit-depth

Bit-depth describes the maximum number of colors an image or monitor can
contain and display. The number of colors a pixel on a monitor can display is
determined by its bit-depth, and images are saved to specific bit-depth in order
to be viewed on such monitors (or better). What that means to web imaging is
this: Images created and saved at one depth will not display properly when
viewed at a lower depth. For example, GIF files are capable of displaying up to
8 bits of color data, but if an 8-bit GIF file is viewed on a 4-bit (16 color)
monitor, colors will be lost in the transition as the 4-bit monitor is incapable of
displaying more than 16 distinct colors at one time. In a 256-color GIF file, that
means 240 colors are going to be lost, effectively destroying the quality of the
image.

So what can be done to compensate for different bit depths? Well, unfortu-
nately, not much. One of the hazards in designing for the web is that not
everyone is using the same hardware. Graphic and web designers are all
invariably using True Color (24-bit or more than 16.7 million colors) monitors,
while some people out there are still using outmoded 16-bit monitors. The best
thing for you to do, in this case, is to either a) know your audience and design
specifically for them, or b) design your graphics so that they are capable of
making a relatively decent transition from one bit-depth to another. However,
the second alternative is not always the best option. If you are designing a
multimedia website filled with hot, True (24-bit) or Hi (16-bit) color images,
then you can’t really create your images with such limited color palettes, which
is essentially what you need to do in order to compensate for shifting bit-depth.
On the other hand, if your site is dedicated more towards content and not
flashy graphics, the second alternative becomes more feasible and realistic.

Note:  All images contain information within them about the number and type of colors the
image needs to display properly. These are called color palettes or color tables . Each
bit depth essentially describes the size of a given image’s color palette, so when you are
creating your images, know exactly how many colors you can work with; otherwise, you
may find yourself severely limited. Using a reduced palette reduces file sizes consider-
ably. For more information on color palettes, see p.94.

  

An image at various bit-depths (24, 8, 4, and 1)
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2

Changing the bit-depth of an image

While working in PhotoImpact, you may want to change the bit-depth of an
image on the fly to either experiment with how it looks or to compensate for
for your target audience’s viewing capabilities. Other times, you’ll find you
need to convert an image to a higher bit-depth or different data type in order to
take advantage of having more colors available to you (for example converting
from Grayscale, which has a range of 256 possible “colors,” all falling between
pure white and pure black, to True Color, which has more than 16 million
colors available). Your choice of data type directly relates to an image’s file size
and quality. For example, by converting to a data type that supports more
colors, you can take advantage of the extra colors, but the image’s file size will
increase. To convert an image’s data type, choose an appropriate command
from the Format: Data Type submenu or click the Data Type button on the
Status bar. Some data types may not be available: these require an intermediate
conversion to True Color. After choosing a data type, the conversion is immedi-
ate or an options dialog box appears.

Notes:
• Conversions change the original image, unless you have the Create a New Image

command selected in the Format: Data Type submenu.

GRAYSCALE (8-BIT) TO BLACK AND WHITE (1 BIT) DIALOG BOX

Resolution  – allows you to choose the resolution of the new image. You can choose
the resolution to match that of the active image, printer, display or you can define your
own. (If you select a high resolution, a very large file will be produced and the conversion
may take a long time.)

Halftone screen  – allows you to specify your dithering method. Shape selects a pixel
pattern to use for the dithering. (The Diffusion option generally results in the best conver-
sion.) Frequency controls how many lines per inch appear for a particular shape that you
are using to dither and Angle controls the angle that the shapes are placed at when
dithering.

1 2
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TRUE COLOR (24-BIT) TO 16-COLOR (4-BIT) DIALOG BOX

Palette  – allows you to select the colors to be included in the new image’s color table.
Standard uses the system’s default 16-Color table, containing the 16 colors available on a
standard VGA display. This option is most useful when you transfer images to other
Windows programs or prepare them for use in a help file or a CD title.

The Optimized option creates a color table that is the closest representation of the colors
used in the image. In most cases, this option gives the best conversion. Reserved entries
allows you to reserve some entries in an optimized palette. For example, you may need
black to add text later, but your image is largely green and blue. Selecting the Reserved
entries Black & White option then creates a color table containing greens, blues, black and
white. Selecting the eight primary colors option retains red, green, blue, cyan, magenta,
yellow, black and white in the color table.

From file allows you to load an Indexed 16-Color palette file that was previously saved
from another Indexed 16-color image file and use that palette to map the colors of current
image.

Dither  – allows you to choose a dither method. None maps each pixel in an image to
the closest color in the palette. Pattern arranges pixels in square patterns to simulate more
colors than are present in the palette and Diffusion uses a more random method to dither
colors. (The Diffusion option generally results in the best conversion.)

TRUE COLOR (24-BIT) TO 256-COLOR (8-BIT) DIALOG BOX

1 2

1

2

1 2
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Palette  – allows you to select the colors to be included in the new image’s color table.
Standard uses the system’s default 256-Color table and gives the most balanced use of
palette color. Use this option if you are preparing images which need to be displayed
consistently on 256-Color display modes. The 3-3-2 (bits) option uses the system’s color
table based on a combination of eight (3-bits) reds, eight (3-bits) greens, and four (2-bits)
blues, while 6-7-6 (levels) uses a color table that offers six levels (shades) of red, seven
levels of green, and six levels of blue.

Choosing Optimized creates a color table that matches the range of colors used in the
image as closely as possible and as such normally produces the best results. You specify
the color index value of the first color in the palette by entering a number in the Start index.
(This is best determined by noting the color value of the most white color in an image and
choosing that color index to be the first color in the palette.) You can also specify the range
of color by entering a value in the Maximum number of colors entry box corresponding to
the spread of color in your original image. The higher the value, the more colors created.

Choosing From file allows you to load an Indexed 256-Color palette file that was previously
saved from another Indexed 256-Color image, and uses that palette to map the colors of
the current image.

Dither  – allows you to choose a dithering method. None maps each pixel in an image to
the closest color in the palette. Pattern arranges pixels in square patterns to simulate more
colors than are present in the palette and Diffusion uses a more random method to dither
colors. (The Diffusion option generally results in the best conversion.)

A quick word about web file formats

When designing images for your web site, keep in mind that the two most
common image file formats are GIF (GIF89a, actually created by Compuserve
in 1987 to facilitate the transfer and exchange of images across the Internet)
and JPEG (created by the Joint Photographic Experts Group for distribution of
highly compact, photo-realistic images created using a unique compression
scheme). GIF in and of itself is a lossless format, meaning images created as
GIFs won’t lose any of their inherent quality while undergoing compression,
while JPEG is lossy, meaning that the image loses quality while undergoing
compression; the amount of loss, however, depends upon the amount compres-
sion applied.

Because GIFs are, at most, an 8-bit file format, the number of colors available
to you is limited to 256 or less. Which 256 colors you want to use is up to you,
but you cannot exceed this limit. JPEG, on the other hand, allows you to create
24-bit images if you want. Because of these factors, GIFs are ideal for line art,
text, clip art, and other kinds of “hand-drawn” images, while JPEGs are the
perfect medium for photo-realistic images or images that contain hundreds or
even thousands of colors.
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Basic web imaging

Now that you’re familiar with essential principles behind web imaging, it’s time
to begin creating your own images. This section teaches you how to design and
create tilable backgrounds, navigational buttons, and web-optimized GIF and
JPEG images.

Creating tileable backgrounds

When creating background wallpaper to place on your web page, the one thing
you must always remember is the word readibility. No matter how cool your
wallpaper is, if your text isn’t legible because it blends in too effectively with
the background, then the wallpaper is counter-productive. Tileable backgrounds
can be of any size, but the smaller the image you use, the faster it will down-
load. Also, the smaller an image is, the more frequently it will repeat itself in the
background. A good rule of thumb is to make the average background tile
about 80 by 80 pixels. This will make the file relatively small and fast to
download as well as allowing it to tile approximately 50 times in the background
on a typical 800x600 monitor.

To create tileable background:

1 Click the Web: Background Designer menu command to open the Back-
ground Designer dialog box.
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2 Select whether to Generate a new tile or to Apply on image. Generate a
new tile opens a new window containing the background tile you design,
while Apply on image generates the background tile on the currently active
window.

3 Enter the dimensions of the background tile in the Cell size entry boxes.
The recommended tile size is 80 x 80 pixels.

4 Next, select the style of wallpaper you want to create from the Schema
drop-down menu. The schema you select defines the texture of the tile.

5 Select a texture pattern from the Background type options. This modifies
and alters the pattern of the texture to make it more random and unique.

6 Click the Edit button to open the Palette Ramp Editor in order to change or
modify the current color palette ring. This palette ramp determines the color
gradient used to generate the texture. In the Palette Ramp Editor, you change
the color of the ramp by clicking over the ring and selecting a color from
the color picker or by shifting the position of the Hue slider. To shift the
color gradient around the ring, adjust either the Ring slider tab or the nodes
that orbit the color ramp.

7 Adjust the Frequency, Density, Amplitude , and Darken and Lighten to
customize the variable appearance of the tile. Frequency allows you to
sharpen or blur the patterns edges, while Density describes the number of
times the pattern stacks upon itself. Amplitude creates higher contrast
between the light and dark areas, while Darken and Lighten make the tile
either lighter or darker.

8 To save the tile for use again later, click the Add button to save the tile to
the custom library.

9 Click OK. The new background tile appears in either a new window or the
currently active window, depending on the settings you selected earlier.

Shifting an image

Sometimes an image doesn’t lay properly in the background, either sitting too
far to one side or lying in such a way as to be a distraction to the viewer. In
any case, if you are not satisfied with how the image tiles, you can shift it,
moving into a position that allows it to tile more naturally. This is especially
useful with background tiles that are larger than 400 x 400 pixels.

To shift an image:

1 Click the Web: Shift Image menu command to open the Shift Image dialog
box.
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2 Grab the image in the Preview pane with your mouse cursor and move it
around until you get the results you want.

3 Click OK. The shifted image replaces the original in the currently active
window.

A shifted image in a browser window

Creating seamless tiles

Often times you’ll want to create a tile that is “seamless” or one that tiles in the
background in such a way that it gives the appearance of a being single, large
texture. In other words, the distinctions between tiles don't exist. These kinds
of tiles are not only appealing to the eye, they are also less of a distraction when
reading the content of the web page.

To create a seamless tile:

1 Create a selection area in the portion of the image that you want to create a
seamless tile out of or use the entire image.
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2 Click the Web: Create Seamless Image menu command to open the Create
Seamless Image dialog box.

3 If necessary, adjust the Merge values for the seamless tile. These values are
Top, Bottom, Left, and Right and allow you to change how strongly the
image or selection area overlaps upon itself as well as how strongly it blends
the overlap with the native image pixels.

4 Click the Tiled Preview button to see how the image or selection area
appears when tiled.

5 Click OK when satisfied with the settings. The new seamless tile appears in
a new window.

Creating buttons

Buttons are very useful for creating easy to understand and interesting naviga-
tional aids. Most graphics-oriented web sites contain some kind of graphic
navigational interface, usually in the form of buttons. Buttons can be created
out of any shape object, but the easiest and most basic kind is one that con-
forms to simple geometric shapes.

To create a simple button:

1 Click the Selection tool button on the Tool panel and then choose the
Rectangle shape from the Attribute toolbar. Create a selection area on the
image you want to use for your button.

2 Select the Web: Button Designer – Rectangular menu command. The Button
Designer dialog box opens.
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3 Select a button Style from the range of different button types. You can also
further define the style by selecting one of the variations in the Thumbnail
pane below the Preview window.

4 Choose a Direction. The Inward  option gives the button the appearance of
being pressed down, while the Outward  option gives the button the appear-
ance of extruding.

5 If you want the edges of the button to be uniform in width, select the
Mirror  option. Any value entered into the width entry boxes is duplicated
for each side. The Width value can be set anywhere from 1 to 25. If you
leave the Mirror option cleared, then you can enter indivual values in for the
width of each button side.

6 Set the Transparency for each button side. Again, if the Mirror option is
selected, the settings entered for one side are applied to the other three as
well.

7 Under Colors, redefine the shades of light that play along the button’s edges
by clicking the available color squares. This opens the standard Windows
color picker. (The number of color squares varies depending on which Style
you selected.)

8 Click OK.

To create irregularly-shaped buttons:

1 Click the Lasso Selection tool button on the Tool panel. Create a selection
area on the image you want to use for your button.

2 Select the Web: Button Designer – Any Shape menu command. The Button
Designer dialog box opens.
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3 Adjust the angle of the light reflecting off the button in the left-hand preview
pane by grabbing the yellow box with your mouse cursor and moving it
around. Alternatively, you can enter the number of degrees of the angle in
the Angle box (0-359).

4 Next, adjust the width of the button’s edges by sliding the Bevel size tab.
Sliding it to the left reduces the width of the bevel, while sliding it to the
right increases it.

5 The Bevel smoothness slider tab adjusts how sharp the edges of the button
appear. Sliding it to the left reduces the edge sharpness while sliding it to the
right increases it.

6 To give the button an inverted look, select the Pressed option.

7 Adjust the distance of light from the button in the Light  elevation box by
moving the control point either up or down or by entering a number in the
Light elevation entry box.

8 When you are satisfied with the results, click OK. If you want to save the
button to your Gallery in the EasyPalette, click the Add button.

Spacing and aligning buttons and other objects

When working with objects, you may find that you need to space them evenly
or align them if they occupy disparate positions within the edit window. This
can be accomplished with two commands on the Web menu: Align Objects and
Space Evenly. These commands are especially useful when creating a naviga-
tional toolbar or image map for your web page.

To space objects evenly:

1 Press the Ctrl button and click each object in the group you want to select.

2 Click the Web: Space Evenly menu command to open the Space Evenly
dialog box.

3 Select the direction in which you want to space the objects. Horizontally
creates equidistant spaces between objects on a horizontal plane while
Vertically  creates equidistant spaces on a vertical plane.

4 Set the spacing under Space options. Selecting Even allows PhotoImpact to
automatically calculate the space between objects based two fixed points,
namely the bookend objects, while Fixed anchors only the top/left object
and bases the distance between objects on the pixel value entered into the
Pixels entry line.
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5 Click OK to implement the settings you selected. To preview the effects of
the settings before closing the dialog box, click the Preview button. You can
reset the settings by clicking the Reset button.

To align objects:

1 Using the Pick tool with the Ctrl key held down, click on the objects you
want to select.

2 On the Web menu, select the Align Objects menu command to open the sub-
menu.

3 Select the method by which you want to align the objects. The objects are
repositioned automatically.

SmartSaving web images

Once you’ve created the images for your web site, whether they are tileable
backgrounds or navigational buttons, you’ll want to save them in a web-
optimized format. As mentioned earlier, the GIF and JPEG formats are the two
most common web formats around. Almost every image you find on the web
will be in one of these two formats, with a few notable exceptions, support for
which is dependent on browser-type and plugins. Using the built-in GIF and
JPEG SmartSaver technology, you can save your images with highest possible
quality at the lowest possible file sizes.

The GIF SmartSaver presents you with a convenient interface for saving files
as GIF images, allowing to set different options for interlacing and transpar-
ency. You can also assign image masks to your image to help it better blend into
your web page’s background. Finally, GIF SmartSaver gives you complete
control over your palette and total number of colors included in the file.

The JPEG SmartSaver allows you to save your images as JPEGs, which tend,
overall, to be smaller than GIF files but the drawback to using them is the JPEG
format is a lossy format, meaning that the image quality degrades the more you
compress it. Using the JPEG SmartSaver interface, you can control precisely
how much compression is applied to your images in order to maintain the
highest degree of control possible. You can also control the compression
scheme and subsampling.
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To SmartSave an image as a GIF:

1 Click the Web: SmartSaver menu command to open the SmartSaver inter-
face. When it does, click the GIF button.

2 On the Mask Options tab, select the Interlaced option if you want the
image to load gradually into the browser window.

Note : This increases the overall file size slightly.

3 To create a transparent background, select the Pick colors option from the
Transparent area drop-down menu. Next, press the Ctrl button and then
select the colors you want to be transparent from the left-hand side preview
window. The mouse cursor becomes an eyedropper as soon as it crosses
over the picture, allowing you to pick the color you want to be transparent.
If you want to select a particular region rather than a single color across the
board, select the Adjacent color only option and enter a similarity value in
the entry box below it. This allows you to select a region of colors based on
their similarity to the pixel you selected using the eyedropper.

Note : You can also import an image mask to help you create custom transparencies by
choosing the Import mask option from the Transparent area drop-down menu. For more on
that procedure, see p.181.

4 On the Background tab, select a color to become the transparent “see
through” color or choose an image file to blend the rough edges of the non-
transparent colors with. This is useful for matching a transparent GIF up
with the background tile you will use on your web page, so that it appears to
blend in smoothly.

5 On the Color Reduction tab, choose the type of color palette you want to
use from the Palette drop-down menu. The Optimized palette allows you to
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use exclusively the colors present within the image and no other. Depending
on the monitor settings of the person viewing an image with an Optimized
palette, not all the colors may be supported. (True Color and High Color
monitors will have no problems, by 256-Color and lower will.) Both the
Netscape and Microsoft  palettes contain 216 preset ‘web-safe’ colors that
are guaranteed to be viewable in their respective browsers as well as on
256-Color and higher monitors. Finally, you can select a custom made
palette from file by choosing the Palette file option. This allows you to
browse for a previously saved palette and use that. If you want to manually
limit the number of colors your GIF file contains, entire the number of
colors you want to set in the Colors entry box (from 4 to 256).

6 From the Dither  drop-down menu, select the dithering method you want to
use to preserve colors in the optimized file. Often, when you reduce the
number of colors in a file, some colors that are integral to the file’s appear-
ance are lost. To compensate for this, you can ‘dither’ the image, which
mixes together existing colors from the palette in different patterns in order
to mimic the missing color. Sometimes this works quite well, while other
times it doesn’t. None replaces each pixel in the image with its closest
match from the optimized palette, thus creating the smallest possible file
size. If your image uses a standard, indexed, ‘web-safe’ palette for its
colors, then this is the best option as there won’t be any noticable loss.
Pattern uses colors from the palette and mixes them together using cross-
hatching. This is the best alternative if Diffusion is too ‘noisy’ and None is
too ‘blotchy’. Diffusion use a semi-random mixture of colors to simulate
missing ones and is best for converting True Color images to 256 Color or
less.

7 On the Palette tab, you can save the image’s existing palette as a file to use
again later. Click the Save button to open the Save Palette File dialog box.
Palettes are saved with the *.pal extension and can be loaded into GIF
SmartSaver from the Color Reduction tab simply by selecting the Palette file
option from the Palette drop-down menu.

8 After you entered the settings to optimize the GIF file, click the Save As
button to save it.

To SmartSave an image as a JPEG:

1 Click the Web: SmartSaver menu command to open the SmartSaver inter-
face. When it does, click the JPEG button.



IMAGING FOR THE WEB 177

2 On the Mask Options tab, create a transparent background by selecting the
Pick colors option from the Transparent area drop-down menu.  As you
press the Ctrl button, select the colors you want to be transparent from the
left-hand side preview window using the mouse cursor, which becomes an
eyedropper as soon as it crosses over the picture. If you want to select a
particular region rather than a single color across the board, select the
Adjacent color only option and enter a similarity value in the entry box
below it. This allows you to select a region of colors based on their similar-
ity to the pixel you select using the eyedropper. As the JPEG file format
does not natively support transparency, the 'transparent' areas are, in fact,
really blended with the background defined on the Background tab. You can
use this technique to blend the 'transparent' areas in with the background
colors of your page or with another image. Click the Full Screen Preview
button and adjust the image against the background for the best effect.

Note : You can also import an image mask to help you create custom transparencies by
choosing the Import mask option from the Transparent area drop-down menu. For more on
that procedure, see p.181.

3 Set the level of Smoothing for the image. In general, smoothing is used to
blur the image slightly to facilitate compression as well as to compensate for
any dithering previously applied to the image. The higher the level of
Smoothing you choose, the more blur that will be applied.

  

      An image with a smooth setting of '0' and one with a smooth setting of '2'

4 Next, select the type of JPEG file you want to create. There are three kinds,
essentially: Progressive, Standard, and Standard Optimized. Progressive
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creates images that gradually fades in as it downloads. This creates smaller
files, but some browsers may have difficulty displaying the JPEG properly.
Standard creates an image that is compatible with all browsers, but on the
whole, the files are larger than if they had been saved using the Progressive
method. Standard Optimized creates the smallest possible files using a non-
progressive compression technique. More often than not, these files are
smaller than if they had been saved using the Progressive method.

5 Finally, adjust the level of compression using the Compression vs. Quality
slider tab. This allows you to manually adjust the level of compression
against the level of image quality. For each adjustment you make, the
preview window updates itself accordingly, giving you a real-time preview
of how your changes affect the image. You can also enter the amount of
quality you want the image to have in the Quality  entry box.

6 Click the Save As button to save your file.

SmartSaving PNG files

In recent years a new, third file format has gained momentum on the web:
PNG, or Portable Network Graphics. This file format is capable of 24-bit
images and supports gamma information and transparency. Another advantage
to PNG over JPEG, and to a lesser extent GIF, is that it uses a lossless
compresion method. This means that your True Color images won't degrade
when saved as a PNG file. Unfortunately, however, the lossless compression
scheme leads to one of PNGs major drawbacks: File size. PNG files are
generally twice as a large, if not more, than JPEG. The second drawback to
using PNG is that, unlike GIF, it doesn't support multiple images, or animation.

To SmartSave a file as a PNG:

1 Click the Web: SmartSaver menu command to open the SmartSaver inter-
face. When it does, click the PNG button.

2 On the Mask Options tab, select the Pick colors option from the Transpar-
ent area drop-down menu to create a transparent background. To select the
colors you want to be transparent, press the Ctrl button and move your
mouse over the left-hand side preview window. The mouse cursor becomes
an eyedropper as soon as it crosses over the picture, allowing you pick the
color you want to be transparent. If you want to select a particular region
rather than a single color across the board, select the Adjacent color only
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option and enter a similarity value in the entry box below it. This allows you
to select a region of colors based on their similarity to the pixel you select
using the eyedropper.

Note : You can also import an image mask to help you create custom transparencies by
choosing the Import mask option from the Transparent area drop-down menu. For more on
that procedure, see p.181.

3 Set the level of Smoothing for the image on the PNG Options tab. In
general, smoothing is used to blur the image slightly to facilitate compres-
sion as well as to compensate for any dithering previously applied to the
image. The higher the level of Smoothing you choose, the more blur that
will be applied.

4 Next, select the type of PNG file you want to create. The three different
types available are: True Color , Indexed, and Grayscale. True Color PNG
files contain millions of colors and are significantly larger than JPGs as PNG
uses a lossless compression format and no data is lost as it's being saved.
Indexed creates 8-bit files similar to GIFs allowing you to have a maximum
of 256 colors in the image file, and Grayscale creates 8-bit grayscale
images, allowing you up to 256 distinct shades of gray.

5 Select the Interlaced option if you want the image to 'fade-in' gradually as
it downloads. This allows the user to get a rough preview of the image
before it has finished loading, although generally interlaced files are larger
than non-interlaced and may take a fraction longer to load.

6 If you chose to create an Indexed PNG file, select the default palette type
you want to use from the Palette drop down menu. The Optimized palette
allows you to use exclusively the colors present within the image and no
other. Depending on the monitor settings of the person viewing an image
with an Optimized palette, not all the colors may be supported. (True Color
and High Color monitors will have no problems, by 256-Color and lower
will.) Both the Netscape and Microsoft  palettes contain 216 preset ‘web-
safe’ colors that are guaranteed to be viewable in their respective browsers
as well as on 256 Color and higher monitors. Finally, you can select a
custom made palette from file by choosing the Palette file option. This
allows you to browse for a previously saved palette and use that. If you
want to manually limit the number of colors your PNG file contains, enter
the number of colors you want to set in the Colors entry box (from 4 to
256).

7 Select the Alpha channel option if you chose the Import Mask from the
PNG Options tab. This saves the mask as an actual alpha channel that can
later be used and modified.

8 Click the Save As button to save your file as a PNG.
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Testing your files with different settings

GIF, JPEG, and PNG SmartSaver all let you try out different color and com-
pression settings on your file before you actually save it. This lets you experi-
ment more quickly with the variables that affect these image file formats the
most. The GIF and PNG SmartSaver Batch dialog box both allow you to test
the number of colors while the JPEG SmartSaver Batch dialog box allows you
to test compression.

To perform a batch test:

1 Click the Batch button to open the Batch dialog box.

 

2 Next, for GIF and PNG enter the lowest number of colors to test in the
Fewest colors entry box. For JPEG, enter the lowest quality (from 0 -
100%).

3 Enter the highest number of colors to test in the Most colors entry box in
the GIF and PNG Batch dialog box and the highest quality percentage for
JPEG.

4 Select either a specific number of tests (Number of tests) or to perform a
single test for every increment of 0-20 colors (Increment). If you choose
to have tests done by Increment, then know that smaller number of incre-
ments you enter results in more tests.

5 Click OK. Once the tests have been generated, you can view the results in
the History window. The Select button allows you to place a particular test
image into SmartSaver’s preview window and use those settings applied to
it during the test.

Using image masks for GIF, JPEG, and PNG

SmartSaver allows you to use 'masks' to create transparent areas and gradients
for outputting to GIF, JPEG, or PNG. The GIF and PNG file formats natively
support transparent areas, while the JPEG file format doesn't. Rather, the
'transparent' area is actually blended with the background you selected on the
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Background tab. This creates the illusion of transparency where there is none.
When setting transparency, image masks give you more control over edge
blending, especially in GIF, as well as allowing you to create custom transpar-
ent areas.

To use an image mask in SmartSaver:

1 Open the image in SmartSaver either from within PhotoImpact or from
Windows Explorer.

2 On the Mask Options tab, select Import Mask  from the Transparent area
drop-down menu.

3 If no mask has been previously selected, the Get Mask From File dialog box
opens. Locate and select the file you wish to use as a mask and click OK.
The dialog box closes.

4 Select the dithering method for the mask from the Adjust mask drop-down
menu. None leaves the mask as is, while Pattern and Diffusion blend the
mask into the image using predictable static patterns (Pattern) and semi-
random patterns (Diffusion) to mix the blended pixels with the original
image. Threshold sets a value for the amount blending that occurs between
the mask and the image, with 0 being none and 254 being the highest.

5 Check the Enable background blending option to blend the mask more
smoothly into the original image.

6 Click the Save As button to save your image with the mask applied.

SmartSaving GIF Animations

Often times while browsing the web, you'll come across GIF animations - these
are essentially identical to regular GIF files with the exception that animated
GIF files contain multiple image layers. Special controls within the file regulate
how and when an image layer is displayed (for more on GIF animations, see
p.193.) While it is entirely possible to SmartSave an animation using GIF
SmartSaver, this is not really recommended as only the initial image layer is
optimized. Instead, you can use Animation SmartSaver to optimize animations
you download from the web or create.

Animation SmartSaver gives you the power to not only optimize a single
animation at a time, but also to optimize entire folders or a web site full of
animations.
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To SmartSave animated GIF files individually:

1 Click the Animation SmartSaver icon in the Ulead PhotoImpact Start menu
folder to open the Animation SmartSaver dialog box.

2 On the Source tab, select the By files option and click the Select Files
button. The Select Files dialog box opens, followed by the Browse dialog
box.

3 Locate the folder that contains the image file you want to optimize and click
OK. The path for that file is entered into the Selected files list.

4 To add additional files, click the Browse button and locate them or enter the
file's name and path in the entry line and click the Add button. Each time
you select a file, its name and path are added to the Selected files list. When
you've selected all the files you want to optimize, click OK to close the
Select Files dialog box and return to Animation SmartSaver.

5 On the Destination tab, select a method for optimization. Evaluate scans the
image files and gives you a detailed summary of the file size reduction for
each image file. Replace original files and Create new files optimizes the
folder contents and generates new image files to either replace the originals
or to be placed in a different folder.

6 On the Options tab, select whether you want Animation SmartSaver to
automatically remove redundant colors (Retain original visual quality) or
to arbitrarily limit the number of colors used in the GIF animation file
(Reduce colors to achieve better compression). You can also choose to
remove all the comment blocks from the animations to further reduce their
sizes.



IMAGING FOR THE WEB 183

7 On the Reports tab, select Display report window to view a summary of
the file size reduction for each image in the folder you are optimizing or
select Create log file to have Animation SmartSaver generate a text file
containing this data.

8 Click the Start button to begin optimizing.

To SmartSave a folder or web site of animated GIF files:

1 On the Source tab, select the By folder option and click the Browse button
next to the By folder entry line.

2 Locate the folder that contains your image files and click OK. The folder
location is entered into the entry line.

Note: To optimize an entire web site, locate the parent folder for your web site and
click OK. The folder location is entered into the entry line. Then, select the Include
subfolders option. Animation SmartSaver will then scan all the folders within the
parent folder for GIF animation files and optimize them as well as the ones located in
the parent folder.

3 On the Destination tab, select a method for optimization. Evaluate scans the
image files and gives you a detailed summary of the file size reduction for
each image file. Replace original files and Create new files optimizes the
folder contents and generates new image files to either replace the originals
or to be placed in a different folder.

4 On the Options tab, select whether you want Animation SmartSaver to
automatically remove redundant colors (Retain original visual quality) or
to arbitrarily limit the number of colors used in the GIF animation file
(Reduce colors to achieve better compression). You can also choose to
remove all the comment blocks from the animations to further reduce their
sizes.

5 On the Reports tab, select Display report window to view a summary of
the file size reduction for each image in the folder you are optimizing or
select Create log file to have Animation SmartSaver generate a text file
containing this data.

6 Click the Start button to begin optimizing.

File sizes and download times

When saving your web images as either GIFs of JPEGs, remember that the file
size determines the download time for that particular image. This is a cumula-
tive effect, so if you’ve got six 50kb images on a page, your page is going to
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take a minumum amount of time based on 300kbs worth of image data. The
following table gives you a general estimate of download times for various-sized
image files using a 28.8k connection, and a 56k connection:

File size 28.8 kbs per sec 56.6 kbs per sec
10kbs 2.8 seconds 1.4 seconds
20kbs 5.7 2.9
30kbs 8.5 4.3
40kbs 11.3 5.8
50kbs 14.2 7.2
60kbs 17.1 8.7
70kbs 19.9 10.1
80kbs 22.8 11.6
90kbs 25.6 13.0
100kbs 28.4 14.5

Advanced web imaging

PhotoImpact is the ideal tool for creating more advanced web graphics as well
as the more basic navigational buttons and backgrounds. With it, you can easily
and quickly add drop shadows, create image map coordinates, create exciting
GIF animations, add frames to your images, or create custom HTML <BODY>
tag attributes for your web page. This section details how to take your web
imaging one step further, where the possibilities are limitless.

Creating image maps

Image maps are extremely useful as navigational aids on any website as well as
a stylish alternative to simple text-based hyperlinks. In PhotoImpact, there are
two basic methods for creating image maps: Object-based and Selection-based.
Object-based image maps have the advantage of being malleable - you can
come back to the image (or images) at a later time and move the objects around
or replace them with new objects while at the same time retaining the image’s
overall quality. Selection-based image maps simply create an AREA tag based
on the current selection area.

When using objects to create image maps, double click a specific object in the
edit window (which acts as the image map in this case) and the Object Proper-
ties dialog box opens. Click the URL button to open the URL dialog box and
you can assign an Internet address to the object, as well as define its basic
'hotspot' shape. The Detect automatically option is for irregularly shaped



IMAGING FOR THE WEB 185

objects. Later when you open the Image Map Tag dialog box, PhotoImpact
automatically inserts the object's URL and coordinates into the Tag String area.

To create an image map:

1 Create a selection area in the image that you want to be clickable using the
Lasso Selection tool (or you can select an already existing object).

 

2 Next, click the Web: Image Map Tag menu command to open the Image
Map Tag dialog box.

3 Select the type of HTML tags you want to use from the Format options.
For creating client-side image maps, select the Inline option. Otherwise, if
you are creating a server-side image select either CERN or NCSA, depend-
ing upon the protocol your server supports.

4 Enter the URL for the hotspot in the URL  entry line. This URL is automati-
cally placed in the Tag String window for you.

5 When satisfied with the results, click the To Clipboard  button to copy the
HTML string to the clipboard in order for you to paste it into your HTML
document using which ever editor you prefer.

6 Click Exit to close the Image Map Tag dialog box.
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Creating custom HTML tags

When you want to define the colors of your web page, such as the general
background color, text, and hotspots, you can use the HTML Image Assistant
to make your work significantly easier. With it, you can select colors for each
attribute in the BODY tag using a color picker and palette, and the Image
Assistant will automatically define the HEX color values for you. This saves
you the time and trouble of having to look them up in a color table and enter
them manually as well as giving you a convenient platform with which to
experiment.

In addition to helping you define the BODY tag color attributes, the HTML
Image Assistant allows you to set up image tags in one fast step. It automati-
cally creates the WIDTH and HEIGHT attributes, which, when defined and
parsed in an HTML document, allow any text that follows the image to load
faster as the browser doesn't need to wait on the image to load in order to
define the space it occupies.

To create custom HTML tags:

1 Click the Web: HTML Image Assisstant menu command to open the HTML
Image Assistant dialog box.

2 On the Body tab, define the color and / or image you want to use for the
background under Background options.

3 Under Text color options, define the colors for each of the following BODY
tag attributes: TEXT, which sets the default text color for the entire page,
LINK, which sets the generic hotspot color, VLINK, which sets the color
for links that have been visited already, and ALINK, which sets the color for
active links.

4 Click To Clipboard  to send the new BODY tag to the Windows clipboard to
paste it into your HTML document.
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To create a custom image tag:

1 Click the Web: HTML Image Assistant menu command to open the HTML
Image Assistant dialog box and then select the Image tab.

2 Click the Browse button to open the Browse dialog box and locate the image
file for which you want to create the image tag. The Information pane
displays all the pertinent information about the file, such as file size, whether
or not its Transparent or Interlaced, and its data type, among others.

3 Click the Low Res button to open the Low Res dialog box. This allows you
to resample the image and make it smaller in order to speed up download
time.  You can also change the image's data type (which changes its palette,
thus affecting file size and download time.) From the Low Res dialog box,
you can Save the image to a new folder with a new name, if necessary.

4 Click To Clipboard to send the IMG tag to the Windows clipboard.

Adding shadows to objects

Add depth and distinguish important elements of your web page from the rest
with the Object Shadow Designer tool. With it, you can give objects an almost
three-dimensional look that make them stand out from the rest of the graphics
on the page.
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To add shadows to objects:

1 Select the object to which you want to add the shadow with the Pick tool.

2 Click the Web: Object Shadow Designer menu command to open the Add
Shadow dialog box.

3 Select the direction you want the shadow to fall.

4 Enter the X- and Y- offsets in their respective entry boxes. X-offset defines
the number of pixels away from the object that the shadow falls on the
horizontal plane, while Y-offset defines how it falls on the vertical plane.

5 Define the shadow Transparency. The default setting is 50%. To make the
shadow darker, lower the transparency setting; to make it darker, raise it.

6 Enter the size of the shadow as it relates to the object in the Shadow size
entry box. 100% is normal while 200% is double sized and 50% is half-
sized.

7 Check the Soft edge option and enter a value in the entry box to give the
outside edge of the shadow a smooth look. The higher the value, the greater
the number of pixels blended into the background. This gives the shadow a
more natural appearance.

8 Set the shadow's color by clicking the color box and selecting it from the
Color Picker that opens. The default color is black.

9 Click OK.

Adding frames to images

Another good way to highlight particular images on your web site is to place
them within frames. This is especially useful for online photo galleries, such as
displays of artwork or family photo albums. Also, frames can be used to outline
interactive image maps, drawing focus to them.
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To add a frame to an image:

1 Click the Web: Frame Designer menu command to open the Frame &
Shadow dialog box.

2 From the Style drop-down menu, select the type of frame you want. 2D
and 3D Frames give a standard range of simple 2D and 3D shapes, while the
Edge Frame Gallery offers a selection of custom "edged" frames. Magic
Frame allows you to create more psychedelic borders. Preset Frames gives
you a gallery of predefined frames for you to use.

3 Define the frame Options. These vary with each different type of frame.

For a 2D or 3D frame, set the frame width in the Width entry box, and
whether or not the frame faces Outward  or Inward . You can also set the
frame color or instead, use a texture to paint it with. Click the Color or the
Texture box to open either the Color Picker with which to choose a new
color or the Texture box to select either a new magic or natural texture. To
change the color of the background, click the Canvas box and pick a new
color.

For Edge Frame Gallery, you can select the Photo edge option to give the
frame edge a more photo-realistic edge. Also, you can define either a single
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color for it by selecting the One color option or a gradient fill by selecting
the Gradient color option, or a texture by selecting the Texture option. To
change either the color, the range of the gradient fill, or the texture, click
their respective boxes.

For the Magic Frame option, select the Effect you want to use to create the
'magic' frame around the image. Each type of effect has its own specific
options you can modify to customize their appearances. Set the Outer edge
and Inner edge options to define the border. The Border option gives the
frame edge extra width and depth, allowing you to customize the border's
color using either a simple color fill or a gradient fill. Either of these can be
altered by clicking their respective boxes.

The Presets options tab doesn't contain any customizable attributes but
instead contains preset frames you can select from and apply to your image.

Note:   To add any customized frames to the Gallery, click the Add button.

4 On the Shadow tab, enter the shadow options (see p.188 for more on
those). Next, define your Canvas area. Enter the number of pixels for each
Top, Bottom, Left, and Right that you want to increase the size of the
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canvas around the image and frame. If you leave this option cleared, then
the canvas only expands around the new frame by a bare minimum. Click
the Lock button to give all the Canvas attributes identical values.

5 Click OK when you are satisfied with the results to close the Frame &
Shadow dialog box apply the settings.

 

Assigning a Helper Program

As you work with image files for your web site, you may find that you want to
switch back and forth between PhotoImpact and another program. To do this,
use the Web: Helper Program menu command. When you click it, the Helper
Program dialog box opens and you can select which program you want to use.
This is especially useful when working with multiple GIF files for use in GIF
Animator or for testing your images in a web browser.
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The chapter in review

Here are some key points and tips to remember from this chapter:

• Images display differently on different computer systems (p.162).

• Bit-depth determines the number of colors available to you when image
editing (p.164).

• You can change the bit-depth of an image on the fly by clicking the Data
Type button on the Status bar (p.165).

• GIF and JPEG are the two most common image type formats on the Internet
(p.167).

• Use the Web: Button Designer - Any Shape menu command to quickly create
irregularly shaped buttons (p.172).

• SmartSaver can reduce your files to the maximum amount while giving you
the optimum quality (p.174).

• Use the Web: Image Map Tag menu command to quickly generate Image
Map tags to insert into your HTML pages (p.184).

Other topics of interest

If you would like to learn more about:

• GIF Animation, see Chapter 7 (p.193).

• Managing your web-based animations and other images, see Chapter 8
(p.217).

• Enhancing animation images or creating new ones, see Chapter 4 (p.85).

• Adding special effects to your image layers or creating new special effect-
based animations, see Chapter 5 (p.127).
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GIF Animator

You see them everywhere, on virtually every web page that you hit:

web animation. Some animations are created using complex propri-

etary plug-in based tools, while others are created as web-based mov-

ies, but the most common kind of animation is created by taking

advantage of a simple file format’s inherant attributes. The file format

is GIF, and using GIF Animator, you can  create your own web anima-

tions in a matter of minutes. It has an intuitive interface and is the

perfect web-imaging partner when working with PhotoImpact.

This chapter introduces you to the fundamentals of working with GIF

Animator as well as the basics of GIF Animation.

Chapter 7

In this chapter you will learn:

• Understanding the basics .......................................................................... 194

• About the GIF file format and animation ................................................... 196

• Customizing the way you work .................................................................. 196

• Getting started with GIF Animator .............................................................. 200

• Creating simple animations ....................................................................... 201

• Working with layers .................................................................................... 206

• Editing image layers .................................................................................. 208

• Exporting image layers .............................................................................. 212

• Merging images .......................................................................................... 213

• Optimizing animated GIFs ......................................................................... 214
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Understanding the basics

GIF Animator is designed to work in conjunction with PhotoImpact, yet it can
also be used as a standalone application. When you open GIF Animator, you’ll
notice that it’s an entirely separate program from PhotoImpact, not a plug-in or
add-on. Because of this, it has its own set of preferences and attributes inde-
pendent of PhotoImpact which let you customize how you work and get the
most of your GIF animations.

GIF Animator’s ‘what-you-see-is-what-you-get’ interface makes it the perfect
authoring tool for designing dynamic and vibrant web-animation. When you
open it for the first time, you are presented with a Startup Wizard which gives
you options for getting started immediately. You can open an existing animation,
create a new one from scratch, or open the Animation Wizard which walks you
through the process of putting together a web-animation, step-by-step.

The GIF Animator program window.
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About the GIF file format and animation

GIF, an acronym for Graphics Interchange Format, is an image file format
created in 1987 by Compuserve as a convenient means for storing and trans-
mitting multiple images within a single, convenient file. GIF or, as it’s techni-
cally known, GIF89a, allows you to store multiple images as well as set
controls for how and when those images are displayed. Originally, this was
intended to create something similar to a slide show, but since the World Wide
Web adopted it as a standard image file format, the more creative members of
the net community have taken advantage of these 'slide-show' features to create
exciting and dynamic web animations.

About GIF color palettes

Each GIF file can contain multiple color palettes with which to display the
images stored within it. The default palette is the ‘Global Palette’ and is used by
every image layer to render its colors. However, individual image layers can also
contain their own, unique color palettes called ‘Local Palettes’ that, generally,
supercede the Global Palette.

Both types of palette can contain a maximum of 256 colors each. Palettes add
to the size of the image layer, and subsequently to the overall file size. A full-
sized palette of 256 colors is approximately 768 bytes in size. If each image
layer in the file contained its own palette of equal size, then the base minumum
file size for your animation would be approximately 8 kilobytes for a 10 frame
animation. Therefore, when building your GIF animations, its very important to
balance the number and size of the palettes against overall file size. If you use
too few palettes or too few colors, then animation will appear grainy, at best,
and incomprehensible at worst. If you use too many palettes and too many
colors, then your file will be unmanagable in terms of web download. Fortu-
nately, GIF Animator contains built-in methods for optimizing GIF files so that
they take up the absolute minimum amount of space regardless of how many
palettes the file contains. (See p.214 for more on Optimization.)

Customizing the way you work

GIF Animator, like PhotoImpact, allows you to easily manage the way you
work with the program and the way it handles in-coming images. These
settings are defined in the GIF Animator preferences, which can be opened by
clicking the File: Preferences menu command.
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GIF ANIMATOR PREFERENCES DIALOG BOX: GENERAL

The General tab allows you to define the settings that GIF Animator uses to import a file’s
color palettes.

Use the palette of the first image layer  – The colors on the Global Palette are
defined by the colors of the first imported image. If the image contains more than 256
colors, then only those 256 colors that appear with the highest frequency are used. Limit
the number of colors taken from the first image layer in the Number of colors entry box.

Select a predefined palette  – Defines the Global Palette using a standard set of
colors selected from the drop-down menu. You can choose palettes that contain anywhere
from 16 to 256 colors as well as custom palettes designed specifically for the Netscape
and Microsoft web browsers. These custom palettes, also known as ‘web safe’ or ‘safe’
palettes, use a specific set of 216 colors guaranteed to display properly when viewed in
either browser type.

Use a custom palette file  – Allows you to assign a Custom color palette (*.pal) file to
the Global Palette. Palettes can be created and saved in either PhotoImpact or GIF Animator.
For more on saving palettes, see p.97.

Automatically expand global palette if it has fewer than 256 colors   –  Sets the
palette to expand every time a new image is inserted that contains colors not already found
on the Global Palette. The new colors, up to a limit specified in the Maximum number of
colors to add  entry box, are added automatically to the Global Palette.

Discard image title from layer pane to reduce file size when saving   –  Allows
you to discard the image layer names from the GIF file when saving in order to further
reduce its size (image layer names, based on the file names of the inserted images are like
comment blocks in that they contribute to the ultimate size of the file.)

Enable Startup Wizard dialog box  –  Select this option to display the Startup Wizard
each time you run GIF Animator.

5

1

2

3

4

6

2

3

4

5

6

1



198 PHOTOIMPACT USER GUIDE

GIF ANIMATOR PREFERENCES DIALOG BOX: IMAGE LAYER

The Image Layer tab allows you to define how GIF Animator imports image files from
outside GIF Animator.

Interlaced  – Select this option to ‘interlace’ the image layer. In single frame GIFs,
interlacing creates a gradual ‘fade-in’ effect as the image downloads off the net. This
means that parts of it come in sooner in order to get a preview of it before it has finished
downloading. Browsers today don’t support interlaced animations, however, so it’s
recommended that you leave this option clear in order to further reduce file size. Also, by
clearing this option, single layer GIFs that were interlaced before being imported into GIF
Animator will no longer be interlaced once they’re brought in.

Play interlaced when previewed   –  Displays the interlacing effect as the GIF
animation under construction plays. This only applies to images imported with the interlac-
ing option selected.

Delay time  –  Establishes the default amount of delay, or duration, for each image
layer as it is imported from outside. Delay time is measured in hundredths of a second.

Specify by frame rate  – You can also set the delay time in frames per second, up to
a maximum of 50. When you enter the Fps, the delay time changes accordingly.

How to remove  – Determines the removal or ‘undraw’ method for each image layer.
This defines how the visible image layer is removed during animation. There are 4 different
removal methods: Web browser decides  uses the default removal method as dictated
by the browser type; Do not remove  does nothing with the image layer during animation
and places all subsequent image layers over it; To background color  replaces the image
layer with the background color as defined in the Global Attributes toolbar; and To
previous state , which removes the image layer and replaces it with whatever was there
before it.

Palette conversion  – Defines how palettes are assigned to images. If you know in
advance what types of images you will be importing, then you can set your palette
preferences here first and the palette conversion/assignment is carried out automatically.
For more on Dithering and how it affects an image’s appearance, see pp.166-167.
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7 Show preview image dialog box  – Select this to display the Insert Image dialog box
as images are inserted, giving you manual control over palette selection and dithering
method.

GIF ANIMATOR PREFERENCES DIALOG BOX: PERSONAL COMMENT

The Comment tab allows you to automatically append a personalized comment to every GIF
file you created and saved using GIF Animator.

Add personal comment block when saving file  – Appends a standard, default
comment block to the animated GIF file when saving. This comment block is only visible in
GIF editors  and is extremely useful for creating copyright or authorship comments.

Content  – Enter the content of the default comment block here, up to a maximum of
512 characters.

GIF ANIMATOR PREFERENCES DIALOG BOX: ADVANCED
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The Advanced tab gives you options for customizing the Optimization Wizard and as well
as for the default number of Undo levels.

Run Optimization Wizard when saving file  – Select this to automatically run the
Optimization Wizard each time you save the file.

Optimize with pre-sets  – Select this to automatically Optimize the animated GIF file
based on the presets each time you save it. This method is much faster than going through
the Wizard, but the drawback is that the optimization is carried out without giving you the
opportunity to adjust the settings.

Check animation compatibility when saving file  – Checks the animation for
browser compatibility when saving it. Some browsers handle animated GIF files differently
than other browsers, so this ‘preflight’ check is essential to guaranteeing that your
animations work properly in all display environments.

Levels of undo  – Enter the number of Undo levels you want GIF Animator to keep. The
higher the number, the more memory GIF Animator requires of your system.

Getting started with GIF Animator

When you run GIF Animator for the first time, you are presented with the
Startup Wizard. This Wizard helps you set up a basic animation by giving you 5
different choices. You have the option to disable this Wizard in the future; to
later reenable it, go to the General tab in the Preferences dialog box (opened by
clicking the File: Preferences menu command) and select Enable Startup Wizard
option.

The Startup Wizard

Click the Animation Wizard button to open the Animation Wizard, which walks
you through the process of putting together a simple animated GIF. To start
with a new document, click the Blank animation button. The other three options
allow you to open existing animations.

GIF animations are created by importing each image layer or ‘frame’ into GIF
Animator from an outside source such as PhotoImpact. Any file type which
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you can open in PhotoImpact can be used in GIF Animator. There are 3 ways
to import image files into GIF Animator:

• Drag and drop them from the Windows desktop, Windows Explorer, or the
Internet Explorer web browser.

• Click the Insert Image or Insert Video button on the Standard toolbar in GIF
Animator and browse for the image or images you want to import.

• Cut or copy them to the Windows clipboard from PhotoImpact and paste
them into GIF Animator using the Copy and Paste buttons.

Creating simple animations

Simple animations can be quickly created on-the-fly without the need for
external tools. Common animations include: scrolling text, rotating text, and
color animation. GIF Animator gives you all the tools necessary to create these
types of animations and get up and running in no time flat.

Creating scrolling text

The easiest kinds of animation to create with GIF Animator are text-based,
requiring no outside image files of any kind in order to build them. Once you've
got a few text-based image-layers in GIF Animator, you can then use other
effects to enhance them or you can keep them the way they are and use them
as simple scrolling text.

To create simple, scrolling text:

1 When GIF Animator starts, select the Blank Animation option from the
Startup Wizard templates.

2 Select the Layer: Add Banner Text command to open the Add Banner Text
dialog box.

3 Set the width and height of your animated GIF by dragging on the control
handles of the bounding box located in the preview window.

4 Choose your background color by clicking the upper color box. This opens
the Pick Background Color window.
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5 Choose your text color by clicking the lower color box. This opens the Pick
Text Color window.

6 Enter your header message in the Banner Text entry line of the Text Style
tab page.

To add a shadow to the text, select the Shadow checkbox and then set its
attributes (X- and Y- offset and Color).

7 Click the Rolling option on the Rolling Control tab page and then set the
attributes that define how the text moves. The Quality menu gives you
choices about how good you want the animation to be - the better the
quality, though, the higher the file size. Duration defines how long each
frame is displayed before it is removed and replaced by the next one.

8 To create a border around your animated text, go to on the Border tab page.
To make your animated text blend in smoothly with your HTML document,
forego this option. Use this option if you want the text stand out and be
more eye-catching.

9 Click OK.
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Adding transition effects

Transition effects are a great way to move from one static image to another,
allowing you to create interesting effects and slide shows. The most basic kinds
of transitions are the Simple Transition Effects, which give you 10 preset
transitions you can add to your images.

To create a simple transition effect:

1 Select the Layer: Add Banner Text command to open the Add Banner Text
dialog box.

2 Enter your text in the Banner Text entry line.

3 Clear the Rolling option on the Rolling Control tab page. Click OK.

4 Repeat steps 1 through 3 to create the second text image in your sequence.
(For more on creating simple scrolling text, see the previous section begin-
ning on p.201.)

5 Select the Layer: Add Simple Transition command to open the Add Simple
Transition Effect dialog box.

6 Select the type of transition you want from the drop down menu to the right
of the preview window.

7 Set the Quality  of the transition you want (where quality is proportional to
the number of frames contained within the transition – the higher the quality,
the more frames required to pull off the effect).
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8 Define how long you want the transition to last in Duration . This sets how
long each image in the transition remains on the screen before it’s replaced
by the next in the sequence.

9 Click OK.
Note : If you only have a single image in your animation, then you can only create a
transition from it to a background matte. To set the matte color, click the matte color box
to open the color picker and choose a color

Adding Color Animation

Color animation consists of taking the existing colors in a single frame or image
and switching them semi-randomly in subsequent frames. This kind of effect is
ideal for highlighting static text or images by drawing attention to them with
shifting and animated colors.

To add color animation to static banner text:

1 Select Layer: Add Banner Text to open the Add Banner Text dialog box.

2 Enter the text you want in the Banner Text entry line on the Text Style tab
page. You can define the various attributes of the text such as font, size, text
color, and shadow from here.

3 Clear the Rolling option on the Rolling Control tab page.

4 Click OK.

5 Select the Layer: Add Color Animation command to open the Add Color
Animation dialog box.
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6 Select the colors your want to animate either from the color palette on the
left or from the preview window to the right.

7 Set the order of animation by dragging the color tabs around in the Anima-
tion order control bar.

8 Click OK.

Creating cube transitions

One type of effect unique to GIF Animator is the cube transition or cube effect.
This takes two images and rotates them, creating the appearance that they are
faces on a turning cube.

To create a cube transition:

1 Select the Layer: Add Banner Text command to open the Add Banner Text
dialog box.

2 Enter your text in the Banner Text entry line.

3 Clear the Rolling option on the Rolling Control tab page. Click OK.

4 Repeat steps 1 through 3 to create the second “face” of the rotating cube.

5 Select the Layer: Add Cube Effect command to open the Add Cube Effect
dialog box.

6 Set the direction of spin, the frame rate, and other attributes of the cube
effect. Some settings work better with certain background colors, so
experiment until you find the settings you like. The Contrast controls set
the amount of light and shadow cast across the cube face, while the Per-
spective controls adjust the “depth” of the cube face.

7 Click OK.
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Working with layers

This section describes how to work with GIF Animator’s various layers. Each
layer in the animation contains its own set of attributes or ‘controls’ which can
be customized. This gives you the maximum amount of control over the
behavior of the animation as well as over each image layer.

Viewing image layers

Once you’ve either opened an existing animation or created one from scratch,
you can quickly and easily navigate between the image layers in the Layer pane
simply by clicking on them. Alternatively, after you’ve already selected one
image layer, you can use the keyboard arrow keys to move up and down in the
list of image layers. If you prefer to view each layer as its own image frame,
click the View: Layer Pane - Thumbnail menu command. The images in each
layer are then displayed as thumbnails. The second method for viewing thumb-
nails, Relative, displays the images within each thumbnail relative to its position
and size in the Logical screen (for more on Logical screen, see p.207.). While
viewing images in the Layer pane as thumbnails, you can customize the size of
the thumbnails in the View: Thumbnail Size submenu.

In Thumbnail mode, the Global Information layer is represented by a thumbnail

of the Global Palette.

Moving image layers

There are two ways to rearrange image layers in GIF Animator. You can drag
them around the Layer Pane by grabbing them with your mouse or you can
shift them up and down with the Layer: Move Up/Down menu commands (and/
or their corresponding buttons on the Standard toolbar.) When image layers are
moved, they retain all of their original settings.

You can quickly shift between images by using the Next image and Previous
image shortcut keys, [SHIFT+A] and [SHIFT+Z], respectively.
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1

Using the Attribute toolbar

The Attribute toolbar contains information as it pertains to each individually
selected layer in the Layer Pane. When you a select a layer, its layer-specific
settings appear in the Attribute toolbar. All image layers share the same at-
tributes. The only two layers that don’t are the Global Information layer and the
Comment layer; the Attribute toolbar displays these attributes when the layers
are selected.

ATTRIBUTE TOOLBAR: GLOBAL INFORMATION

Logical screen  – Defines the dimensions of the virtual screen that the images are
played against. Generally, the Logical screen should be the same size as the largest image
in the animation. All smaller images are played against this. If images are placed outside the
boundaries of the largest image in the animation, then Logical screen adjusts accordingly.
However, when viewed in a browser, the animation may not play as you intend.

Global palette  – Displays the total number of colors in the Global Palette. Click the Edit
button to open the Palette, where you can add and remove colors, save the palette or load
a pre-existing one, or change individual color values.

Background color  – Displays the color value of the Logical screen. This color shows
through any transparent layers that lie directly over it, but it does not affect the animation’s
appearance in web browsers.

Looping  – Defines how many times the animation plays. You can enter a number in the
entry box or select the Infinite option to have it play indefinitely.

ATTRIBUTE TOOLBAR: IMAGE LAYER

Image title  – Displays the name of the image layer. The default is based on the file
name before it was imported.
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How to remove  – Defines how the image layer is removed after it has been displayed
for the duration specified in the Delay attribute. There are 4 removal methods: Web
browser decide , which removes the image layer according to the web browser’s default
removal method; Do not remove , which leaves the image layer on the screen and then
displays all subsequent image layers over it; To background color , which replaces the
image layer with the background color of the web page; and To previous state  which
removes the layer and replaces it with the previous image.

Global Attribute Change  – Opens the Global Attribute Change dialog box, allowing
you to change image layer attributes across an entire range of image layers. For more on
this, see p.209.

Image properties  – Displays the dimensions of the image in pixels as well as its X
and Y position relative to the upper left hand corner of the Logical screen, also in pixels. If
the image layer contains a local palette, then you can click the Edit button to open the
Palette dialog box and edit it.

Image display  –  Allows you to either interlace the image layer or set a transparent
color. You can select the transparent color by clicking the color box or by manually entering
the color value of the color you want to be transparent in the entry box.

Delay  – Defines the length of time in hundredths of a second that the image layer is
displayed on the screen.

ATTRIBUTE TOOLBAR: COMMENT

Comment title  – Enter a name for the comment layer here. If the comment block is the
Personal Comment automatically appended to the GIF file, then you cannot change the title.
For more on the Personal Comment, see Preferences on p.199.

Comments  – Enter your text here, up to a maximum of 512 characters. If the comment
block is the Personal Comment automatically appended to the GIF file, then you cannot
change it from the Comment Attribute toolbar but instead must alter it in Preferences. For
more on the Personal Comment, see Preferences on p.199.

Editing image layers

After you have imported images from outside GIF Animator and placed them
into your animation, you may find that they still need adjustments. With the
tools GIF Animator provides, you can crop, duplicate, rotate, and retouch your
image layers. Additionally, you can edit and customize the Global and Local
Palettes for creating special effects or for manually regulating palette size.

2

3

4

6

1

2

1

2

5



GIF ANIMATOR 209

Selecting image layers

Generally, you can only select a single image layer to work on at a time. When
you select it in the Layer pane, its image appears in the workspace, allowing
you to adjust its position and/or edit it using the different tools provided for you
on the menus. However, if you find it necessary to edit image attributes across
a range of images, you can select the images by clicking the checkbox next to
their names in the Layer pane. When you click the Edit: Global Attribute Change
[CTRL+G]  menu command, the Global Attribute Change dialog box opens
allowing you to select which properties you want to copy across the selected
image layers. Alternatively, you can also choose to copy the attributes across all
image layers.

The Global Attribute Change dialog box

Duplicating image layers

Duplicating image layers is useful for copying not only an image itself, but also
its attributes. The Duplicate dialog box, opened when you click the Edit:
Duplicate [CTRL+D] menu command, allows you to adjust the X- and Y- offsets
for individual layers as they are duplicated, as well as giving you the option to
duplicate just the checkmarked layers.

The Duplicate dialog box
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Cropping image layers

The Edit: Crop [CTRL+R] menu command opens the Crop dialog box, which
allows you to make your images smaller by paring away the extra, unnecessary
space. This is especially useful for creating ‘sprites’ to animate over a larger
background matte. In the Crop dialog box, you can replace the original image
layer or you can choose to create a new layer based on the cropped image. The
cropping effect can be applied to an entire range of selected images or every
image layer in the animation.

The Crop dialog box

Rotating and flipping images

The Edit: Rotate submenu allows you to rotate and flip images. When you
change an image’s orientation, the Logical screen adjusts accordingly if the
boundaries of the image exceed the Logical screen’s boundaries.

Editing palettes

Sometimes when working with image layers you may need to change a color
or multiple colors in either the Global or Local Palette for whatever reason. GIF
Animator allows you to open either palette and edit them manually or to import
pre-existing palettes from outside to replace the palette in question.

To edit the Global or Local Palette:

1 Select Edit: Global Palette / Local Palette menu command or click the Global
Palette / Local Palette Edit button on the Global Information Attribute
toolbar to open the Palette dialog box.

2 Choose the color you want to edit by selecting it with your mouse cursor.
Using the Ctrl key allows you to select more than one color a click at a time
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while using the Shift key allows you to select an entire row. If you selected
multiple color cells, you can only delete them or make a color gradient.

3 Change the color in the selected cell by clicking the color box; the Color
Picker dialog box opens. A color can also be defined by adjusting the RGB
color values manually.

4 Click OK.

Note : You can save the existing palette for later use by clicking the Save button. This
opens the Save As dialog box allowing you to save the palette file with the *.pal extension.
To load an existing palette file into one of the GIF palettes, click the Load button and,
using the browse dialog box, locate the palette you wish to use. Click OK and the palette
is loaded into the GIF palette.

To add colors to either the Global or Local Palette:

1 Click the Add button in either the Global or Local Palette dialog box. The Add
colors dialog box opens.

2 Enter the number of new color cells you wish to add to the palette.

3 Click OK. The dialog box closes and the new color cells are appended to the
end of the palette.

Note : You can only add a number of colors equal to 256 minus the number of already
existing colors in the palette.

To remove colors from either the Global or Local Palette:

1 Select the cell or cells you wish to remove. To select more than one cell,
hold down the Ctrl key as you select colors. To select an entire row, hold
down the Shift key.

2 Click the Delete button.

Note : Removing colors from the Local Palette may adversely affect an image layer’s
appearance. Removing colors from the Global Palette may adversely affect the entire
animation.

To add a color gradient to either the Global or Local Palette:

1 Select three or more colors. Choosing two colors will result in nothing
happening as they can only be used as the start and end colors. The more
colors you select, the more noticeable the gradient.
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2 Click the Gradient button. The Gradient dialog box opens where you can
define the start and end colors of the gradient.

3 Click OK. The gradient colors replace the previously selected colors.

Exporting image layers

Not only does GIF Animator provide you with the means for adding image
layers to your animations, it also allows you to export individual layers. This is
useful for editing image layers outside of GIF Animator. You can open the
Export Images dialog box by clicking the Layer: Export Images [CTRL+E] menu
command.

The Export Images dialog box

To export a group of images as a new animation:

1 Select the images you want using your mouse while holding down the Ctrl
key (to select individual image files) or the Shift key (to select a range of
image files).

2 Select As a single file under Export multiple images.

3 Click OK.

4 Name your new file and click Save.

To export a group of images as a sequence of files:

1 Select the images you want using your mouse while holding down the Ctrl
key (to select individual image files) or the Shift key (to select a range of
image files).
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2 Select As a sequence  of files under Export multiple images.

3 Click OK.

4 Choose a name to be shared by the files and Click Save.
Note : Images exported as part of sequence will all have the same name but be numbered
according to their order in the original GIF animation. For example, if you were to choose
‘Sunset’ as the shared name, then the new files would be named ‘sunset.gif’,
‘sunset001.gif’, sunset002.gif, and so on.

Merging images

When working with small, animated sprites over a larger background matte, it’s
usually a good idea to combine the sprites with the matte in order to help
further reduce file size. Using the GIF Animator Merge command, you can
merge all your images from a single, convenient dialog box. To open the Merge
dialog box, click the Layer: Merge [CTRL+M] menu command.

The Merge Images dialog box

To merge multiple image layers:

1 Choose the Layer: Merge Images command to open the Merge dialog box.

2 Select the image layers you want to merge using your mouse while holding
down the Ctrl key (to select images a click at a time) or the Shift key (to
select an entire range).

3 Click Merge. If you want to replace the original images with the merged
one, select the ‘Replace original image layers’ checkbox.

Note :  To have one layer ‘floating’ above another, the floating layer should come after the
backdrop layer in the Layer Pane.
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Optimizing animated GIFs

GIF Animator provides you with a revolutionary method for creating the most
compact GIF animations on the web: GIF Optimization. GIF Optimization
works by removing unused colors from the color palettes as well as redundant
portions from each image layer. It also gives you the means for creating a
‘Super Palette’ which gives an animation access to more colors than usual.

The Optimization Wizard walks you through the optimization process step-by-
step, allowing you to customize how the optimization is performed as well as
save these custom settings for future use. As GIF Animator is a non-destruc-
tive editor, you can optimize any animation and save it with a new file name,
leaving the original intact. Once you have the Optimization settings customized
for your work, you can by-pass the Wizard by clicking the Optimization button
on the toolbar or by clicking the File: Optimize with Presets menu command.

If you want the Optimization Wizard to be run each time you save a file, go the
Advanced Preferences tab and select the Run Optimization Wizard  when
saving file option. For more on that, see pp.199-200.

The Optimization Wizard
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The chapter in review

Here are some key points and tips to remember from this chapter:

• GIFs can contain more than one image layer, as well as controls for dictating
how the image layers are displayed (p.196).

• Each image layer can contain its own color palette (p.196).

• The entire GIF animation can utilize a single, global palette (p.196).

• Each layer in an animation contains its own set of animation controls
(p.206).

• Image layers can be exported for editing outside of GIF Animator (p.212).

Other topics of interest

If you would like to learn more about:

• Imaging for the web, see Chapter 6 (p.161).

• Adding special effects to your image layers or creating new special effect-
based animations, see Chapter 5 (p. 127).

• Enhancing animation images or creating new ones, see Chapter 4 (p.85).

• Managing your web-based animations and other images, see Chapter 8
(p.217).
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Chapter 8

Image Management with Album

Album is the program to use when it comes to viewing and managing

the files on your system. When you place files into Album, they are

represented as graphical thumbnails which allow you to see what a file

is, therefore making it easier to locate files and better organize your

work.

This chapter introduces the basics of Album, explaining how to create

and maintain album files, open programs from the Tool panel, perform

drag-and-drop operations, and use the Preferences commands to

customize the way Album works with you and your Windows environ-

ment.

In this chapter you will learn:

• Understanding the basics .......................................................................... 218

• Customizing the way you work .................................................................. 220

• Viewing ....................................................................................................... 225

• Using the clipboard .................................................................................... 228

• Printing thumbnails .................................................................................... 228

• Using the Tool panel .................................................................................. 229

• Performing drag-and-drop operations ...................................................... 231

• Performing OLE operations ....................................................................... 233

• Sending an album over the Internet ......................................................... 238

• Inserting thumbnails .................................................................................. 241

• Outputting HTML-based thumbnails ......................................................... 256
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Understanding the basics

Album is the perfect image management tool. Designed to work in conjunction
with PhotoImpact, it allows you to easily, quickly, and efficiently manage your
image files, create thumbnail albums and catalogs, and generate HTML-based
slide-shows. Album operates on the 'thumbnail' principle, rendering thumbnails
of all the images in your computer and storing them in customized 'album' files.
These albums can be moved, sent across the Internet, placed on the World
Wide Web, and otherwise shared with anyone else using the Album application.
The thumbnails contained within each album, while linked to the original image
files, are not dependent on the originals for display and viewing purposes.

The Album program window
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Customizing the way you work

An essential part of Album’s management is that it allows you to control both
the program and how it interacts with Windows. This is done with the two
Preferences commands, PhotoImpact Album and General, found on the File
menu. The PhotoImpact Album command allows you to define preferences for
Album only, while the General command is for both PhotoImpact and Album.
(General preferences are discussed in “Common preferences options,” p.24.)
When you select the Album command, the Album Preferences dialog box opens
with three tabs: General, Font, and OLE Representation. These allow you to
specify a variety of options such as checking links to source files, defining the
way files behave as OLE objects and controlling the size and type of the fonts
used in Album.

Note:  You can quickly open the Album Preferences dialog box by double-clicking the
Status bar or by pressing the F6 shortcut key.

ALBUM PREFERENCES DIALOG BOX: GENERAL TAB

Check links to source files  – makes Album perform an automatic check between
each thumbnail in an album and its source file. The check is done whenever a thumbnail is
selected or the view in the album changes, such as from scrolling or performing a sort
operation. Although this option does not require any extra memory, it may slow down
processing time as you wait for Album to finish checking. Leave this option cleared if you
are certain files have not been modified, if it is not necessary to update existing thumbnails,
or if you wish to scroll quickly through an album.

Note:  If, during a check, Album comes across any missing files, the index number of the
appropriate thumbnail is grayed-out.
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Minimize on use  – minimizes Album as soon as you invoke another program from the
Tool panel or Switch menu. This can help save on system resources as Album is no longer
occupying the desktop.

Free up memory when minimized  – releases any system memory used by an
album by swapping it out to disk whenever it is minimized. When you swap out to disk, the
memory contents of the album are saved to a file in your TEMP folder (*.$$$). Restoring the
album reads that file back into memory. This may slow processing time depending on the
size of this file and the current state of your system’s resources.

Confirm on thumbnail deletion  – prompts you with a confirmation message
whenever you try to delete thumbnails.

Create best quality thumbnail images – tells Album to generate the best quality
images for use as thumbnails. Select this option if you want your thumbnails to be as clear
as possible. (This does, however, require a longer thumbnail insertion time.) Leave this
option cleared if you are satisfied with the existing thumbnail image quality.

Display fixed-length tabs  – makes all the tabs in an album appear at a fixed size. If
this option is left cleared, each tab appears as large as the number of characters it
contains. (You control the number of characters with the Maximum tab width option
below.)

Print field data with source files – attaches field data to source files when printed.

Play annotation file after viewing thumbnails  – plays the annotation file associ-
ated with a thumbnail after you open the thumbnail’s source file, (using the View command
in the Source menu).

Backup album file automatically  – creates backups of album files everytime you
open an album file from the Album Panel.

Maximum tab width (in characters)  – allows you to specify the length of the
names that appear in tabs (from 3 to 30). Keep this number low when you need more
space to show tabs. To see tab names in full, increase this number.

Number of recently opened files  – specifies the number of files to list at the bottom
of the File menu, (up to 9). Clicking on a name from the list reopens the album.

Delimiter used in Search toolbar  – allows you to choose the delimiter to use when
defined criteria for searching consists of more than one word.

ALBUM PREFERENCES DIALOG BOX: FONT TAB

The Font tab allows you to control the type and size of the font used to display the text in
an album. (The options and dialog box layout displayed here are standard to all Windows
compatible programs.) If you are in high resolution display mode, such as 1024x768, you
may want to increase your font size so you can better see the names of your thumbnails.
Likewise, if you are in a lower resolution display mode, such as 640x480, you may want to
decrease the font size.
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ALBUM PREFERENCES DIALOG BOX: OLE REPRESENTATION TAB

The OLE Representation tab allows you to define how an object looks when placed into
another program (the container program).

Object broker for thumbnails – sets Album as the object broker during OLE hand-
offs to other programs. For more on this, see p.233.

Source object  – displays the entire file in the container document. This allows you to
clearly see the contents and dimensions of the object file but does increase the container’s
file size and slow down its operation.

Thumbnail only  – replaces the source file with its thumbnail in the container’s
document. This provides a visual clue as to the contents of the file without affecting the
container’s file size or speed of operation too much.

Low resolution place holder  – places a low resolution version of the object file into
the container document. This is particularly helpful in preparing images for publication when
it is not necessary to have a good quality image displayed on screen at all times. When you
print the document, however, the low resolution image is printed. To print the original file,
you must first update the thumbnail from the container program.

Album’s program icon  – allows you to use Album’s program icon to represent the
object file. This adds the least to the container’s file size, but you do not have a visual clue
as to the contents of the file.

Convert images as display mode  – converts the data type of an image
(when placed onto the clipboard) to that of your current display mode. This is particularly
useful if you are using a low resolution display and wish to save on system resources.
(This option is only enabled if you are running in 256-Color display mode.)
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Creating an album

Your first step on the way to managing files in your system is to arrange them
into albums. A key feature of Album is its support for UDFs or user definable
fields. Fields allow you to append all sorts of information about a file, in any
category that you determine.

When you run Album for the first time, it opens with existing albums in the
workspace containing thumbnails of the PhotoImpact sample files. You can
immediately begin to place your own thumbnails into these albums or create a
new album. You can create a new album by:

• Clicking the New button on the Standard toolbar.

• Choosing the New command [CTRL+N] in the File menu.

• Clicking the Album button in any of the other PhotoImpact programs’ Save
As dialog boxes and selecting New.

• Selecting thumbnails in an existing album and then choosing the Make Album
command in the Edit menu.

Note:  You can have any number of albums open in the workspace, and each album
supports over 64,000 files.

To create a new album:

1 Click the New Album button on the Standard toolbar or select New
[CTRL+N] from the File menu. The New dialog box opens displaying a
number of template options.

Templates are provided to help get you started with your album. For ex-
ample, the Personnel Database template contains fields such as Name,
Address, Gender, Salary and Job Title. Album templates are also fully
customizable; you can add, remove, or rename fields whenever necessary.

2 In the Album template list box, select a template that you want to base
your album on. The Total fields list box changes to show the fields included
in that template.

If you want to create a multipurpose album for simple file cataloging,
choose the default General Purpose template.

Note:  You can edit the fields of an album by clicking on the Customize button. For more
information, see “Editing an album’s properties”, p.239.
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3 Decide on a name for your album and enter it in the Title  entry box. The
title you enter appears in the album’s title bar and also becomes the filename
for the album itself. (Album files are indicated with an AB3 file extension
and are stored in the folder specified in the General tab of the New dialog
box, see p.231.)

4 Click OK. The new album appears in the Album workspace and the Insert
dialog box opens. You can close this dialog box and leave the album empty,
or continue to insert files. (For more on inserting files, see p.241.)

Using the Album Panel

Whenever you create an album, it appears in the Album workspace. You can
have any number of albums open in the workspace at one time. Of course, a
large number of albums would not only clutter your workspace but make it
hard to find those albums you want to work with. To help manage albums in
the workspace, Album provides you with the Album Panel. The Album Panel
arranges all your albums in a vertical pane to the left of the workspace, allow-
ing you to easily and quickly find the album file you need.

The Album Panel is a storage area in which you can place the albums you are
not currently working on or wish to remove from the workspace, as well as a
place to manage the albums you currently have open. It is a good idea to close
albums not currently in use, as this not only makes it easier to work with those
albums you often use, but also frees up system resources. To re-open a closed
album, simply click its 'book' thumbnail in the Album Panel.

Note:  To access files referenced in an album on the Album Panel, you must bring the
album back to the workspace by clicking its Album Panel icon.

The Album Panel allows you to:

• Move an album file to any folder in your computer.

• Copy, delete and rename album files.

• Remove an album file from the Library.

• Backup and Restore album files.

• Set the sharing options for each album file.

You can customize the albums in the Album Panel by clicking the Play button to
scroll through the thumbnails contained within it, then clicking Stop to select a
thumbnail as the Album thumbnail in the Album Panel. The scroll buttons allow
you to navigate the Album Panel if it contains too many albums to fit in a single
screen.
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Viewing

Thumbnails are one way (or mode) of viewing files in an album. You can also
view files in Attribute, Filename or Data Entry mode. Choose which one by
selecting the appropriate mode from the Standard toolbar or by choosing its
corresponding command from the View: Mode submenu or from the Viewing
Mode button on the Status bar. (An additional Layout command allows you to
configure each of these modes) You can also view an album in two different
modes simultaneously by splitting the window document into an upper and
lower pane. To split an album window, simply drag the splitter at the bottom
of the scroll bar up.

If you split an album into panes, changing the viewing mode via the
Standard toolbar or with a mode command from the View: Mode submenu
only changes the thumbnails in the default upper pane. To change the viewing
mode of the lower pane, use the Viewing Mode button on the status bar. This
has a menu with two sets of Mode commands. The top set is for the upper
pane and the lower set for the lower pane. Alternatively you can right click
over the pane in question and select the mode you want from the Mode
submenu. The following provides a brief explanation of what information is
displayed when you choose any of the four viewing modes:

• Thumbnail  displays the thumbnails of files from left to right and top to
bottom. You can choose whether or not to display certain album file
attributes or data field entries using the Layout dialog box, accessed by
choosing the Layout command from the View: Mode submenu.

Upper pane

Pane splitter

Lower pane



PHOTOIMPACT USER GUIDE226

• Attribute  displays both the thumbnails and information about each file. As
with the Thumbnail mode, you can specify what information to display from
the Layout dialog box.

• Filename displays filenames from top to bottom in the album. Depending on
selections made in the Layout dialog box, various information is displayed
about each file, such as file attributes, subject, description and pathname.
(Viewing in filename mode is quicker than thumbnail mode and requires less
memory.)

• Data Entry displays the field names and data of each thumbnail with the
image shown to the left of the fields. Choose this mode if you want to add or
edit information in the fields of an album.
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Viewing by tabs

Another way to view thumbnails is by tabs, displayed by choosing the Show
Tabs command in the View menu or by dragging down the splitter at the top of
each album window’s vertical scroll bar. Each tab contains a collection of
thumbnails with a common theme. The default classification is by media type.
To change this, you can select another type from the View: Tab by submenu.
This is also a quick way to find information within an album, particularly when
the album has a defined value list. For example, you can view your album based
on marital status, age, gender or income. (To create a value list, see p.246.)

Scrolling an album

Album provides several methods for locating thumbnails in an album. The most
obvious is the scroll bar which appears on the right side of the album. Clicking
the scroll bar direction buttons moves the view by a single line. Clicking in the
scroll bar moves the view by a page, and dragging the slider allows you to
move quickly to a new location. The number that appears next to the slider is
the index number of the first thumbnail in the row that you are scrolling to.

If you have a large number of thumbnails in an album you can automatically
scroll through them by using the Auto Scroll dialog box, opened by selecting
the Auto Scroll command in the View menu. In the Delay time entry box, type
the time (in seconds) that you want Album to wait before each scroll. When
ready, click on the OK button. The dialog box closes and automatic scrolling
begins. (To pause/continue scrolling, press the Space bar; to stop scrolling
press the Esc key.)

If you want to go to a specific thumbnail, click the View: Scroll menu com-
mand. This opens the Scroll to dialog box which lists the filenames and index
numbers of all the thumbnails in the album. Selecting a filename and clicking
OK automatically scrolls to the location of that thumbnail. (Double-clicking on a
filename performs the same effect.)

Using Scan Play

To quickly browse through a large number of wave, MIDI, video, or animation
files, choose the Scan Play command in the View menu. The multimedia files of
the selected thumbnails are played sequentially in a media window. The Play/
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Pause button in this window allows you to pause and continue the playing of
files. The Skip button allows you to skip the current thumbnail and start playing
the next one. You can mark thumbnails as you scan play by choosing a mark
from the menu and then clicking the Marks button (for more on Marks, see
p.260.)

Using the clipboard

One of the easiest ways to move thumbnails is by dragging and dropping them
into other albums. Other means involve using the clipboard and the Cut
[CTRL+X], Copy [CTRL+C], and Paste [CTRL+V] commands in the Edit menu.

Cutting a thumbnail removes it from the album and places it onto the clipboard
(only the thumbnail is cut: the thumbnail’s source file is not affected and
remains where it is). If you choose to use the Copy command, you have the
option of copying the thumbnail, its field data, or the filename. If you choose
“Field Data”, all field data is copied. To only copy certain field data, first
highlight the data you want to copy and right mouse click in the data entry pane
to show the pop-up menu. Choosing the Copy command from this menu only
copies the selected data to the clipboard.

Pasting field data into an album

The Paste command is available only when the clipboard contains a thumbnail
or field data that has been cut or copied from an album. This command is
useful when you have thumbnails that share the same or similar field data. By
copying the field data for one thumbnail, you can then paste it into others,
saving the time needed for retyping the same information several times. (If
pasting single field data, use the Paste command in the pop-up menu that
appears when you right mouse click on a field in data entry mode.)

Printing thumbnails

Album allows you to print the thumbnails of an album (in either of the four
different display modes) to any Windows compatible output device. Before you
print make sure that your output device is turned on, connected, and selected in
the Print dialog box. You can open this dialog box through the Print command
[CTRL+P] in the File menu.
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To print all thumbnails, select the All option in the Thumbnail range group box.
To print only the currently selected thumbnails, select the Selection option (this
is disabled if no thumbnails are selected). To print a range of thumbnails, select
the Range from option and enter the first and last thumbnail index numbers of
the range into the entry boxes provided. For the best possible representation of
thumbnails, select the Create thumbnails from source files option. This pro-
duces a clearer thumbnail but does slow down processing time.

Other options are also included in the Page Setup dialog box, opened by clicking
the Page Setup button. Here you can change the page layout, create a header
and/or footer as well as choose to append any relevant file information, such as
the album’s title, filename and current date. (This dialog box can also be opened
directly by choosing the Page Setup command on the File menu.)

Note:  To preview how your thumbnails will look when printed, choose the Print Preview
command in the File menu or click on the Print Preview button in the Standard toolbar.

Using the Tool panel

Central to Album’s ability to manage files is its ability to act as a program
manager through the Tool panel. By adding frequently used programs to the
Tool panel you can transfer control and, in many cases, files between Album
and those programs. You can also place similar programs into program groups,
allowing you to instantly change the Tool panel configuration depending on the
task at hand. For example, one group can consist of your multimedia programs;
another, your word processing programs and so on. Once an icon is added to
the Tool panel, simply click on it to open the corresponding program.

Note:  You can also open programs from the Run dialog box, accessed by choosing the
Run [CTRL+R] command in the Tool panel menu.
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Adding programs to the Tool panel

When you invoke Album for the first time, the Tool panel appears with a group
of icons featuring the PhotoImpact programs. You can choose to add more
icons to this group or create a group specific to the programs on your system.

To add a program icon:

1 Click the menu button in the Tool panel and click New. The New Group
dialog box opens.

2 Click the Program group option and in the Group name entry box enter
the name of the group you want the program to be associated with (for
example, Word Processing) and then click the New button.

3 Click the Program icon option and enter the Description, Command line
and Working folder  of the program concerned. These attributes are all
optional and need not be set.

To load the Windows WordPad program, type in WordPad for the
Description, the full pathname where the WordPad file is located for the
Command Line and the full pathname of your temp folder for the Working
Folder.

4 Click the New button. The program icon appears in the Tool panel.
(If you want to add more programs to the Tool panel, repeat steps 3 and 4.)

5 Click the Close button to close the dialog box and return to the Album
workspace.

Notes:
• You can also add programs to the Tool panel by dragging execution files (EXE) from

Windows Explorer and dropping them onto an empty icon in the Tool panel.
• To change program groups, choose the appropriate group name from the list of group

commands, available when you click on the Menu button.
• If you wish to change any of the options specified in the New Group dialog box, choose

the Properties command in the Menu button.

Removing a program from the Tool panel

At times you may want to remove a program icon: this can be because you no
longer need it, have deleted the program from your hard disk, or feel that there
are too many icons in the program group. When you remove icons, you can
choose to remove individual ones or all those associated with a program group.
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To remove a program icon or a program group:

1 Click the Configure button on the Tool panel and select Delete.
The Delete dialog box opens.

2 To delete the current program group, select the Delete current program
group option. (This deletes the group and all program icons associated with
that group.) To delete an individual program icon, select the Delete pro-
gram icon from current group option and click on the icon to be deleted
from the Icon combo box.

3 Click OK. The selected program icon or group disappears from the Tool
panel, and the dialog box closes.

Repositioning the Tool panel
When you work in Album, you may prefer to have the Tool panel in another
position. In other PhotoImpact programs, you would normally drag on the Tool
panel to remove it from its docked position. In Album, however, this is not
possible. Instead, Album allows you to configure the position of the Tool panel
via the Configure command (opened by clicking the menu button on the Tool
panel) or by one of the positioning commands in the Configure pop-up menu,
opened by right mouse clicking on the Tool panel. These allow you to dock the
Tool panel to the left or the right of the Album window or to make it floating.
(Once floating, the Tool panel can be dragged anywhere on the desktop.)

Performing drag-and-drop operations

Drag-and-drop is a simple, yet powerful technique for transferring information
within and between programs. Album provides extensive support for drag-and-
drop that enhances its ability to provide complete file and program
management.

Drag-and-drop to the Tool panel

One of the more common drag-and-drop operations you will perform is to drag
a thumbnail from an album and drop it onto a program icon on the Tool panel.
Given that the file is compatible and the program accepts command line opening
of files, the file associated with the thumbnail is opened in the destination



PHOTOIMPACT USER GUIDE232

program. Dragging and dropping to one of the PhotoImpact program icons is
even more powerful, as you can drag-and-drop multiple thumbnails in one go.

Note:  Pressing the Enter key with a thumbnail selected also opens the file of a thumbnail
as long as it has the correct program association.

Drag-and-drop to another program’s workspace

If you have other programs running at the same time, you can drag-and-drop
thumbnails directly into the program’s workspace rather than to its program
icon on the Tool panel. (Depending on the settings in the OLE Representation
tab of the Album Preferences dialog box, see p.222, this either embeds, links or
opens the file, where compatible.)

If you are working from Windows Explorer, you can:

• drag-and-drop program files (EXE) to an empty icon on the Tool panel of
Album to create program icons.

• drag-and-drop album files (AB3) into the Album workspace to open them.

• drag-and-drop files into albums to create thumbnails of the files.

Drag-and-drop thumbnails to albums

Using drag-and-drop, you can easily move thumbnails within or between
albums by simply selecting the thumbnails and dragging them to their new
destination. (This can be to an open album or to its icon on the Album Panel.)
Thumbnails moved from one album to another are removed from the first and
introduced at the end of the second (or in the position determined by the
album’s current sort mode). If you hold the Ctrl key down while dragging, the
thumbnails are copied. (The original files associated with the thumbnails are not
duplicated.)

Note:  Thumbnails dropped into an album change to suit the properties of the thumbnails
in that album.

Drag-and-drop thumbnails between tabs

To move thumbnails from one tab to another, simply select them and drag them
to the other tab. Doing this not only moves the thumbnails but also changes the
thumbnails’ list value. For example, if you have thumbnails in a tab for the
Sales department and drag them to the tab for the Marketing department, the
value for the Department field changes accordingly, from Sales to Marketing.
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Drag-and-drop thumbnails to other programs

When dragging thumbnails to other programs, the result is determined by the
particular program. In general, if you drop a thumbnail onto a minimized
program icon, or onto the program window’s title bar, the program will attempt
to open it. If you drop the thumbnail into the program’s workspace,
it may be placed into the active document as an object, or it may be opened:
exactly which depends on the program and the settings in the OLE
Representation tab in the Album Preferences dialog box (see p.222).

Note:  Holding down the Ctrl key as you drop an object into the destination program
embeds it, irrespective of the selection made in the OLE Representation tab of the Album
Preferences dialog box, (see p.222). Holding down the Ctrl +Shift keys links it. (If you do
not hold down any keys, the embedded object is linked to it associated program.)

Working in compact mode

When dropping thumbnails into another program, it is often easier to have
Album in compact mode and have the destination program running at the same
time. You can switch to compact mode by choosing the Compact Mode
command from the View menu or by clicking the Compact Mode button
located on the status bar. In compact mode, the Album program window
occupies minimum screen space with no menu bar, allowing you to see both
the active album and the destination program window. To switch back to
normal mode, select the Switch to Normal Mode command in the same menu.

Note:  In Compact mode you can still access Album’s commands by clicking on the
Display menu button located on the Status bar.

Performing OLE operations

Album supports linking and embedding features that allow you to easily modify
objects which have been incorporated into other program documents. When an
object is linked, information gets updated each time the source file is modified.
The container file, the file into which you insert the object into, only stores a
connection to the source file and a representation of the linked object. When an
object is embedded, it becomes part of the container file itself and the informa-
tion does not change if the source file is modified.
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Linking and embedding objects

You can link objects by:

• Holding down the Ctrl and Shift keys while you drag-and-drop a thumbnail
to a container program.

• Using the Copy: Thumbnail command in Album and the Paste Special
command (with the Paste Link option selected) in the container program’s
Edit menu.

• Using the Insert/Object command in the container program.

You can embed objects by:

• Holding down the Ctrl Key while you drag-and-drop a thumbnail to the
container program.

• Using the Copy: Thumbnail command in Album and the Paste Special
command (with the Paste option selected) in the container program.

• Using the Copy: Thumbnail command in Album and the Paste command in
the container program.

• Using the Insert/Object command in the container program.

Editing linked or embedded objects

Right mouse clicking on an object in a container program’s document brings up
the following commands:

• View/Play Ulead Album Thumbnail Link: Opens the object in Viewer for
image and graphics files and in Windows Media Player for sound, animation,
and video files.

• Reselect Ulead Album Thumbnail: For embedded objects, allows you to
select another thumbnail to replace the current thumbnail.

To reselect a thumbnail:

1 Right click on the thumbnail in the container program document that you
want to replace with another thumbnail, and click Reselect Ulead Album
Thumbnail . PhotoImpact Album opens.

2 Select another thumbnail to replace the current thumbnail.

3 In the File: Update submenu, find the container document with the thumbnail
you want to replace and select it.

4 Return to the container program document. The thumbnail is now
replaced with the newly selected one.
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Maintaining albums

When working with albums, it is easy to forget that they are, in fact files, and
as such can be managed and maintained. (The album file is identified with an
AB3 extension.) All the commands to maintain album files can be found on the
Album menu and include common commands such as Move, Copy, Delete, and
Rename. (Other more specific commands are discussed later in this chapter). It
is important to remember that when performing operations on album files, you
are not affecting the actual source files of the thumbnails. For example, if you
choose the Delete command, the album file is removed from disk, but all the
source files associated with it remain.

Refreshing an album

If you are sharing albums over a network, changes made to the source files
may not be reflected in the current thumbnails. To update the album, choose the
Refresh command on the Album menu. (This command is disabled if you are
not currently sharing an album over a network.) This checks each thumbnail in
an album against its source file. If the file has changed, the thumbnail is updated
accordingly.

Checking the thumbnails in an album

If you have been using the Windows Explorer or a DOS session to manage your
files, you may inadvertently 'break' the link between some files and their thumb-
nails. This can be because the original files have been moved, renamed, or
perhaps deleted.

To determine if this link has been broken, choose the Check command on the
Album menu. After checking for any missing or modified files, the Check dialog
box opens with two tabs: Missing files and Modified files. The Missing files tab
indicates those thumbnails whose original source files are now missing. You can
then choose to relink or delete the thumbnails of these files. (Delete removes the
thumbnail from the album, not the source file.) The Modified files tab indicates
those files which have been changed since they were originally inserted into an
album. Here you can choose to relink, update or delete the thumbnails.
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Notes:
• Check cannot be performed on read-only albums. To take the read-only attribute off an

album, choose the Sharing command in the Album menu and deselect the Read-only
mode option in the Sharing dialog box.

• Checking the Check links to source files option in the Album Preferences dialog box
(see p.220) automatically checks thumbnails whenever you select them, perform a
sorting operation, or scroll.

Backing up an album file

When you backup an album, you not only backup the album file but all those
files associated with the thumbnails. This serves two purposes: one, it creates a
copy of the important files you want to keep a record of, and two, it allows you
to delete the backed up files to create more storage space.

If you choose to delete the original files after a backup, you can still keep a
record of them by not deleting the album file. This allows you to view the
thumbnails of the files in the album. (To open the files you need to restore the
original album.)

To backup an album:

1 Select the album you want to backup.

2 Click the Album: Backup menu command. The Backup dialog box opens.

3 Use the Backup album to folder list box and the Drives menu to specify
the folder and drive to save the album.

Note:  Any files in the target folder are deleted before backing up begins.

4 If you have selected specific thumbnails to backup, check the Backup
selected files only option. Unchecked, and all files are backed up.

5 Select the Compress files option to compress the files as they are backed
up.
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Note:  If it is important to achieve maximum compression, try converting all image files in
the album to the JPEG format before backing up. JPEG, however, is a lossey compres-
sion scheme, and as such the quality of the compressed files may not be as good as the
original.

6 Click OK. The dialog box closes and the backup process begins.
(The progress of the backup is displayed in the album’s status bar.)

Backing up to floppy disks

If you are backing up to floppy disks, you will be asked to insert additional
disks as they are filled up. During the backup operation, Album splits files so
that the disks are filled as efficiently as possible. For an indication of the total
number of disks required to backup an album, refer to the Total size to backup
indicator in the Backup dialog box and divide this by the capacity of your disks.

Note:  It is important that you sequentially number and label each disk used during the
backup. This way when you come to restore the album, you will know which disks to insert
and in which order.

Restoring an album file

After backing up an album, you must restore the album to be able to use any of
the files contained in it.

To restore an album:

1 Click the Album: Restore menu command. The Restore dialog box opens.

2 Using the Restore album from folder list box and the Drives menu box,
locate the folder and drive containing the album you wish to restore.

3 In the Restore to group box, select the subfolder to restore the backed up
files to.

4 Click OK. The dialog box closes, your album and associated files are
restored to their specified subfolders, and the album appears in the Album
workspace.

When you restore an album, any existing files with the same filename as the
files to be restored are replaced. These files may be the files you originally
backed up and did not delete or files you have since created with the same
filenames.

Note:  You can restore an album file that has the same title as an existing one, as long as
the filename is different or you restore it to a different folder. However, once restored, you
cannot open it in Album until you have renamed, removed, or deleted the other.
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Sharing albums over a network

Album allows more than one user to use the same album file at the same time.
To control sharing, choose the Sharing command in the Album menu, this
opens the Sharing dialog box. Here you can set the rights associated to the
currently active album as well as how that album can be used by others. For
example, in the Active album group box, an album can be set as either read/
write or read-only, while in the Sharing mode group box, an album can be set
as do not share, read-only, or read/write. Setting the sharing mode to exclusive
gives you exclusive use of the album and other users on the network have no
access to it at all. If the sharing mode is read-only, then the album can only be
viewed. Read/write mode allows albums to be both viewed and worked on
simultaneously by multiple users. However, this mode does slow down perfor-
mance dramatically, as Album has to read data from disk whenever possible to
ensure that the data shown on the screen is consistent to those on file.

Note:  If others are already using the album, you will not be able to set the options for it.

Sending an album over the Internet

The Send command in the File menu is available only if a mail program has
been properly set up on your computer (i.e. MS Internet Mail, Netscape Mail,
or Eudora.) With this command, you can send an album to anyone else con-
nected to the network or the Internet.

When you choose this command, the Send Mail dialog box opens with two
tabs, Send files and Message text. In the Send files tab you can choose to send
the album file and/or the source files for all or some of the thumbnails in an
album. (When you send an album, Album sends only a duplicate of your
original album file and/or the source files of the thumbnails.) If you cannot send
large file sizes over the network, select the Send files as separate mails option.
This sends each file as a separate mail rather than attaching all files to one mail.
You can also choose to append the album’s field data by checking the Include
field data in message text option.
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Editing an album’s properties

When you create an album, you have the opportunity to define certain proper-
ties of the album such as its title, description, and fields. To modify these
properties, choose the Properties command in the Album menu or click the
Customize button in the New dialog box. You can also right click over an album
in the Album Panel and select the Properties menu command. This opens the
Album Properties dialog box with four tabs: General, Fields, Advanced and
More.

Note:  If the album is password protected, the Password Protected dialog box opens
asking you to enter the password.

ALBUM PROPERTIES DIALOG BOX: GENERAL TAB

Album title  – allows you to enter or edit the name of the album. The name you type
here appears in the album’s title bar but does not change the filename of the album.

Thumbnails  – allows you to specify the size of the thumbnails, the compression
scheme to use, as well as the number of colors the thumbnails can contain. (It is important
to remember that your choices here only affect the thumbnails, not the actual source files
themselves.) To save on disk space, choose a small thumbnail size and JPEG compression.
JPEG compression is lossey, so you may notice some degradation in quality. To improve on
this, choose lossless. This compression scheme retains all data but does not achieve as
high a compression rate as JPEG.

Description  – provides a brief summary of an album's template and its intended
purpose.

1
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ALBUM PROPERTIES DIALOG BOX: FIELDS TAB

Field name  – indicates the name of the currently selected field displayed in the Total
Fields edit box. You can change this to more accurately represent your album database,
for example, Work, Transport or Holiday.

Field type  – specifies the type associated with the currently selected field. The type
of a field is important as it indicates the kind of information you can place in the field. For
example, text fields allow you to use text; filename fields are for entering filenames and so
on.

Total fields  – displays all the fields in the current album or template. You can select a
particular field by clicking on it with your mouse and then use the Add, Change and
Remove buttons to edit the contents of this list box.

ALBUM PROPERTIES DIALOG BOX: ADVANCED TAB
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Folder monitoring  – allows you to specify which folder you want Album to monitor.
To monitor a folder, you must check the Enable folder monitoring option. Any changes to
the specified folder, such as file deletions or additions, are immediately updated in the
album. In this way you do not have to insert thumbnails to an album or remember to insert a
thumbnail whenever you create a file in another program such as PhotoImpact. You can
select multiple types of files to monitor by clicking them in the File types combo box.

Password  – allows you to specify a password of up to 22 characters to prevent your
album from being modified by unauthorized users. If users do not have the correct
password for a password protected album, they are automatically put in read-only mode.

ALBUM PROPERTIES DIALOG BOX: MORE TAB

The More tab displays information about the album file including name, size and date last
modified. (This tab does not appear if you access the Properties dialog box from the
Customize button in the New dialog box.)

Inserting thumbnails

Once you have created an album, you can proceed to insert thumbnails of your
files. It is important to remember that the original, or source, file never moves:
it remains where it is on your disk. How the thumbnail is represented depends
on the type of file it is linked or associated to. If its associated file is an image
or graphics file, the thumbnail displays the contents of that file. For video and
animation files, the first frame of the sequence is displayed. If the file’s con-
tents cannot be shown, as for text or sound files, the thumbnail displays the
source file’s program icon or a default icon.

Whether you want to insert thumbnails into an empty album or one that already
contains existing thumbnails, you can:

• Use the Insert command [INS] on the Thumbnail menu.

• Drag-and-drop existing thumbnails from one album to another.

• Use the Sanner or Digital Camera command on the File menu (only available
if you have an installed TWAIN device) or click the Scanner or Digital
Camera button.

• Click the Album button in the PhotoImpact programs' Save As dialog boxes.

• Drag-and-drop files directly from Windows Explorer into an album.

Note:  The thumbnail of a given file can only be inserted into the same album once. If you
insert a thumbnail from the same file more than once, the original thumbnail and informa-
tion are updated each time.

1

2
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To insert thumbnails of files:

1 Click the Thumbnail: Insert menu command. The Insert dialog box opens.

To insert specific files, choose the Insert Files option. To insert all the files
of a folder, choose the Collect files from a folder option. (This inserts
thumbnails for all files found within the specified folder and/or subfolders.)

2 Locate the folder containing the files you want to insert.

3 Select the media type you want from the Files of type drop-down menu.

4 Select the files you want to insert from the File name list box . (Not
necessary if you are inserting a folder.) You can perform a quick insert of
single files by double-clicking on their filenames.

5 Check the Write errors and journals to file  option if you wish to see a
report about the problems that occurred while inserting the selected files.

Use this option when inserting a large number of thumbnails and you don’t
want the insertion process to be halted if any errors occur. If this is left
unchecked, any problem that occurs prompts a message box and halts the
insertion process.

6 Click Insert. The selected files are inserted into the currently active album.
The dialog box remains open to allow you to insert more files into the same
album. To close the dialog box click on the Close button.

Inserting files from a TWAIN device

If you have an installed TWAIN device, such as a frame grabber or scanner,
you can input images directly to albums, fax machines, printers, or electronic
mails using the Acquire From Scanner button or the Acquire from Digital
Camera on the Standard toolbar or the Scanner/Digital Camera command on the
File menu. Clicking the Acquire button or choosing the Scanner/Digital Camera
command brings up a submenu with the following buttons or commands.

• File &  Album  acquires an image and inserts the file into the active album.

When you select this button or command, the Acquire dialog box opens. In
this dialog box, you can specify the filename and folder of the file to be
created. Once created, a thumbnail of the file is automatically placed in the
currently active album. (If acquiring multiple images, ensure that the last
character in the filename is a number. Album will automatically add one to
this with each successive input.)
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If using an auto feed scanner and scanning large numbers of pages with
information on both sides, check the Increase file number by two option.
For the first scan, all files are saved in consecutive odd numbers, for
example, IMG0001.BMP, IMG0003.BMP... When you scan in the reverse
sides of the pages, the files are saved as even numbers, for example,
IMG0002.BMP, IMG0004.BMP... This way you can be sure that the file
order is identical to your page order.

• Fax in B&W  acquires an image and sends it as a black and white fax.

• Fax in Color acquires an image and sends it as a colored fax.

• Printer  sends an acquired image to your PC’s default printer. Selecting the
Printer button or menu command opens the Print dialog box from which you
can specify the number of copies to send to the printer. To scale the file to
be as large as possible on the page while maintaining its aspect ratio, check
the Scale to fit the page option. With this option unselected, the file prints at
the size determined by its resolution. To print the
acquired image centered on the page, check both the Center image hori-
zontally and Center image vertically options.

• E-mail acquires an image and sends it as e-mail.

Note:  Before you use the Scanner/Digital Camera command, you may need to select a
TWAIN device from the Select Source dialog box, opened by choosing the Select Source
command from either the File: Scanner or File: Digital Camera menu command.

Entering field data

After you have finished inserting thumbnails into a new album or have opened
an existing album, you are ready to start entering information about each
thumbnail. The information that you enter can then be used to help locate and
sort thumbnails later on. The following section explains what kind of informa-
tion can be accepted by each of the field types.

Note:  Fields are defined at the time an album was created. To edit these fields, see
“Editing an album‘s properties”, p.239.

To enter data, you must be in data entry mode, opened by clicking the Data
Entry Mode button on the Standard toolbar. When you do so, the first thumb-
nail in the album appears with all of the fields associated with that album to the
right of it. Place your pointer in one of the field entry boxes to begin entering
data. The scroll buttons along the top allow you to step forward or backward
through the thumbnails in the album or jump to the start or end.
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Number

Number fields accept any numeric data from 0 to 4,294,967,294. Negative
numbers are not accepted in this field, and if decimals are used the numbers
after the decimals are truncated. For example, 16.75 becomes 16.

Date

When entering data into date fields, you must use the same short date format as
defined in the Date tab of the Regional Settings dialog box opened from the
Windows Control Panel. For example, if your date format is YY/MM/DD, then
your date should be 65/10/20. (If the date you enter does not conform to that
format, a message appears requesting you to enter the date again using the
correct format or change your Regional Settings.)

Text

Text fields can hold up to 255 characters and are very flexible as they allow you
to enter a variety of information, all of which you can later search and sort on.

Filename

Filename fields can accept a filename of up to 259 characters. When you type
in a filename, you need not include a file extension.

Keyword

Keyword fields allow you to assign keywords or phrases to thumbnails, making
it easy to find files that share common themes. For example, the keyword
“Sports” can be assigned to all those files in an album that are related to sports.

To edit a keyword list:

1 Click a Keyword field from the Total fields list in the Field tab of the New
(or Album Properties) dialog box, (see p.239). The Edit Keyword button
appears.

2 Click the Edit Keyword button to open the Edit Keyword dialog box, and in
the New keyword entry box, type in a keyword.

If there are existing keywords, the Change button is enabled. Clicking this
button changes the highlighted keyword in the list to the keyword appearing
in the New keyword entry box.
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3 Click the Add button or press the Enter key. This adds the keyword to the
keywords list box.

To add more keywords repeat this procedure. If you have mistakenly added
the wrong keyword to the list, select that keyword and click the Remove
button. To remove all keywords in the list, click the Remove All button.

4 Click OK. The dialog box closes and the keywords are now included in the
album. (They are not yet, however, assigned to any thumbnails.)

Note:  The total number of keywords you can have in an album is 8,000. You can assign
up to 32 keywords to each keyword field, but each keyword cannot exceed 255 charac-
ters.

Assigning keywords

To assign keywords to a thumbnail, double-click on the appropriate Keyword
field in data entry mode (the Keyword dialog box opens) and select one of the
keywords to assign to the thumbnail from the Current keywords available list
box. Clicking Add places that keyword into the Current keywords in field  list
box. Repeat until all keywords for this field are added and then click OK.

Saving and loading keywords

When you create a keyword list, you can save it for use in another album.
To do this, click the Save button in the Edit Keyword dialog box. This opens
the Save Keywords dialog box. Select the path you want to save the keyword
file to and type in a filename, selecting a TXT file format.

To add keywords from an existing keyword file, click the Load button in the
Edit Keyword dialog box. The Load Keywords dialog box opens. Choose the
appropriate keyword file and click Open. You will be asked if you want to retain
the current keywords. Click Yes to add the new keywords to those currently in
the keyword list; No replaces the current keywords with those from the file.

If you are preparing a large number of keywords, you may find it easier to first
compile the keywords in a word processing program and then load them into an
album. Doing so, you can easily edit and, where possible, spell check your
work before assigning keywords to thumbnails. Each keyword must appear on
its own line.
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List

The data in list fields is taken from a predefined list of values, called a value list.
For example, if you are setting up an employee database, you may have a list
field for marital status. Your value list would provide the values: Single and
Married.

To create a value list:

1 Click on a list field from the Total fields list in the Field tab of the New (or
Album Properties) dialog box (see p.239). The Edit List button appears.

2 Click the Edit List button (the Edit List dialog box opens) and in the New
value entry box, type in a word you want the list to contain – for example,
Single. If there are existing values, the Change button is enabled. Clicking
this button changes the highlighted value in the list to the word appearing in
the New value entry box.

3 Click the Add button or press the Enter key. This adds the word to the
values list box. To add more values, repeat this procedure. If you have
mistakenly added a wrong value to the list, select that value and click the
Remove button. To remove all values in the list, click the Remove All button.

4 Click OK. The dialog box closes and the values are now available to the
album. (They are not yet, however, assigned to any thumbnails.)

Note:  You can have as many as 8,000 values in a single value list.

Assigning value lists

To assign values from a value list, double-click the appropriate list field in data
entry mode (the List dialog box opens) and select one of the values to assign to
the thumbnail from the Current values available list box. (You can only assign
one value at any time.) The value appears in the New value entry box. (You can
also type in a new value here directly if one does not exist in the Current values
available list box.) Click OK. The value is added to the field.

Memo

This is  a special type of text data. It can contain up to 65,635 characters in a
field and is useful for appending miscellaneous information to a thumbnail.
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Importing field data

If you have database file information from another album or another database
program, such as dBASE IV, you can include it in your current album with the
From File command on the Thumbnail: Import submenu. This opens the Import
dialog box with two tabs: File and Fields. Use the File tab to locate the database
file you want to import and then click on the Fields tab. This contains two list
boxes: Fields in input file and Fields in album. The Fields in input file list box
displays the fields found in the input file and the Fields in album list box displays
the fields in the currently active album.

Note:  If there are more records in the input file than thumbnails in the album, the extra
records are discarded. If there are fewer records, the fields are left empty in the remaining
thumbnails.

To compare the values of the input list fields to that of the album, check the
Match field values with album’s fields option. The Treat first record in file as
field names option lets Album know that the first row of information to be
imported contains field names, not field data. When this option is selected, the
field names appear in the Fields in input file list box, allowing you to quickly
match the two lists of fields without making any mistakes.

The Import fields dialog box

Exporting field data to an external file

To save selected field data to an external file, click the Thumbnail: Export - To
File. The Export dialog box opens. In the File tab, you can specify the file name
and format of the exported file. You can choose to export a file as either
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Formatted Text Files, Tab Delimited Text Files (field data separated by tabs),
Comma Delimited Text Files (field data separated by commas), and dBase IV
Files.

The Export fields dialog box

Listed in the Export fields list box in the Fields tab are the fields in the present
album along with the width (the number of characters) reserved for each field.
From here, you can specify which ones to export to an external file by check-
ing/unchecking them appropriately. You can also drag-and-drop these selections
to change the order that they appear in the file.

From the Character set menu, you can choose to export the file as Windows or
DOS text. Export the data as DOS text if you plan to import the data to a DOS
program later on. The Store field names as first record in file option saves the
field names of the exported fields in the first row of the file to facilitate in the
importing process.

Notes:
• If there are thumbnails selected in the current album, only the field data from those

selected is exported. To export data of all thumbnails, make sure that all or none are
selected.

• You can have anywhere from 1 to 999 characters reserved for each field.
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Maintaining thumbnails

Album allows you to maintain thumbnails so that they always accurately
represent the files that they are associated with. One of the most obvious
methods is to set an album to monitor a particular folder (see p.241). Any
changes made to either a file or the contents of that folder are then immediately
reflected in the album and its thumbnails. If you do not monitor a folder, you
can still maintain thumbnails by either reinserting their associated files or by
selecting one of the update commands from the Thumbnail menu.

Updating a thumbnail

There may be times when you need to check a thumbnail with its source file;
for example, the source file may have been removed or its contents changed.
To do this, click the Thumbnail: Update – From source file menu command.
This performs a check between each selected thumbnail and its associated file.
(Holding the Ctrl+Shift keys down as you choose this command creates a
thumbnail at best quality; holding Ctrl only produces a good quality thumbnail.)

Note:  If you have the Check links to source files option selected in the Album Preferences
dialog box (see p.220), thumbnails are updated whenever the view in the album changes.
To update a large number of thumbnails, it is quicker to first select this option and then
scroll through the album.

Changing a thumbnail’s image

When you first insert the thumbnail of a file, it displays the contents of that file,
when possible. At times you may want to change the thumbnail, especially for
those thumbnails whose contents cannot be displayed, for example, sound and
text files.

When you change a thumbnail, you replace it with image or graphics data from
the clipboard using the From Clipboard command in the Thumbnail: Update
submenu. By doing this, you can use your favorite images to represent thumb-
nails or customize thumbnails to represent particular files.
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Relinking thumbnails with their associated files

When the thumbnail of a file is inserted into an album, it maintains a link with
the location of this file. This is why you can manage files by manipulating their
thumbnails. If files have been moved using Windows Explorer or if you have
remapped your disk drives, Album may lose this link. Thumbnails that have lost
their links appear with their index numbers grayed-out if the Check links to
source files option is selected in the Album Preferences dialog box. If you want
to reestablish the link, you can reinsert the file for the thumbnail or use the
Relink command.

To relink thumbnails:

1 Select the thumbnails that need relinking.

2 Click the Thumbnail: Relink menu command. The Relink dialog box opens.

3 Select the drive and folder that contains the files you want to relink the
thumbnails to.

4 Click OK. The dialog box closes and the relinking process begins. The
thumbnails are compared against the files present at the new location; their
paths are updated, and if necessary, so are their thumbnails and related
information.

Preparing CD-ROMs for distribution

The Relink dialog box also includes the option Album Drive, which allows you
to link source files to the drive where the album file resides. For example, if
your source file is located in C:\PHOTOS, and the album file is on your D: drive,
then the source location will be changed to D:\PHOTOS. The advantage of this is
that you can move all your files, both album and associated source files, to
another drive or medium, such as CD-ROM, and still have album accurately
locate them. If you do not do this, album will assume that the files are still at
their original location, and thus be unable to find them.

To distribute albums on a CD-ROM:

1 Make sure all the files you want to distribute are in the appropriate folders,
then click the Thumbnail: Relink menu command. The Relink dialog box
opens.
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2 Select the Album drive  option and click OK. If you have any files that are
not currently on the same drive as the album file, an error message appears
asking if you still want to link this file. Click YES if you are going to
distribute the file, NO if you are not.

3 Copy all your files to distribute, both source and album, to the CD-ROM. Be
sure to keep the same folder structure as you copy the files. If you use a
different structure, album will be unable to find the source files.

Annotating a thumbnail

In Album, you can annotate sound, MIDI, video, or animation files to any
thumbnail. This gives you an added dimension for identifying thumbnails, and is
particularly useful if you have audio editing software that allows you to record
audio files (WAV). To annotate a thumbnail, first select the thumbnail and then
click the Thumbnail: Annotation – Add menu command. The Add Annotation
dialog box opens. Locate the multimedia file you want to annotate and click
OK. The dialog box closes and a red music note appears on the thumbnail slide
indicating that it has an annotation. To play the annotation, double click on the
music note.

Note:  Selecting the Play annotation after viewing thumbnail option in the Album Prefer-
ences dialog box (see p.220), automatically plays the annotation file whenever you view a
thumbnail by double-clicking on it or by choosing the View command on the Source
menu.

Reordering thumbnail index numbers

Album allows you to freely change the position of thumbnails by either drag-
ging-and-dropping them to new positions or to sort them in a particular order
through the Sort dialog box, accessed by clicking the Thumbnail: Sort menu
command. Whenever you rearrange the order of thumbnails, you may find that
their index numbers no longer accurately represent their position in the album.
To reorder these numbers, click the Save button on the Standard toolbar or
clicking the Thumbnail: Save Sequence menu command. This automatically
changes all index numbers so that they run consecutively from the first to the
last thumbnail in an album.

Note:  Save Sequence also compacts albums and should be used before distributing
albums to other users.
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Maintaining source files

Once files are represented in an album, you can manage them just as you would
with Windows Explorer. This includes using such commands as Open, Move,
Copy, Delete, Create and Remove Folder. All the commands to manage files are
contained in the Source menu. When using these commands, you must remem-
ber that any action performed is done to the actual file. For example, if you
select the Delete command, the file is removed from disk and cannot be
retrieved unless you have a utility with an undelete function. (To delete only the
thumbnail and not its source file, select it and click the Clear command in the
Edit menu, or press the Delete key.)

Note:  You can use wildcards when renaming multiple files. For example, the string
“NEW*” will replace the first three characters of all selected files with NEW.

Opening and viewing files

Album allows you to directly open a file in its associated program by clicking
the Source: Open menu command. If you only want to see the file in greater
detail and not do any extensive editing, a quicker method is to click the Source:
View menu command or double-click the thumbnail itself. This opens any
image  file in the Viewer utility and any multimedia files in Windows Media
Player.

Converting a file’s format and/or data type

Clicking the Source: Convert menu command allows you to convert image and
graphics files to other file formats and data types. This command can be
applied to individual or multiple files, sharing the same or different file formats
and data types.

Being able to change the file format is particularly useful when you want to
open a file in a program that doesn’t support that file’s current format,
for example, changing TIF files to a BMP format so they can be opened in
Windows Paintbrush. Changing the data type is also useful when you are
preparing a large number of images for publication and wish to, for example,
convert your images from True Color to Grayscale.
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Printing a file

If you want to print the file of a thumbnail, click the Source: Print menu
command. The Print dialog box opens. In the Copies entry box, enter the
number of copies to be printed. Selecting the Scale to fit the page option scales
the file to be as large as possible on the page while maintaining its aspect ratio.
With this option cleared, the file prints at the size determined by its resolution.
The Center image horizontally and Center image vertically options allow you to
choose where images print on the page. If both options are selected, images
print centered on the page.

Note:  For some application-linked files, their associated program will be called up to
print the file. Once printed, the program will close. For example, to print a Write docu-
ment, Write is opened with the selected document in the workspace and its Print dialog
box also appears.

Changing the program association of a file

The Associate command in the Source menu allows you to change the associa-
tion of a file with a particular program. You will want to change the association
of a file when, for example, you double-click on a filename in Windows
Explorer and the file opens in a different program than expected. (Such situa-
tions often happen when you use different programs to work on the same file.)

Selecting the Associate command opens the Associate dialog box. In this dialog
box, you can specify the file extension whose program association you want to
change. If you do not select any thumbnails, this command affects all thumb-
nail files sharing the same extension.

Displaying a file’s properties

Clicking the Source: Properties menu command allows you to change the
attributes of the file whose thumbnail is selected. These attributes can be: Read-
only, Archived, Hidden, or System. A Read-only file allows you to open the file
but prevents any changes from being saved to it. This is useful when sharing
files over a network and you do not want anyone changing the content of your
files. The Archived attribute identifies those files which have been updated
since their last save. Selecting the Hidden attribute hides files from view, and
System marks files as MS-DOS system files, also hiding them from view.
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Showcasing image collections

Album provides a slide show feature which allows you to showcase your
image, graphics, and sound files. This includes using impressive transition
effects and providing manual or automatic playing. To run the slide show, click
the Slide Show button on the Tool Panel or click the View: Slide Show menu
command. Album also allows you to create an HTML-based slide show for use
on the web or in other interactive multimedia.

Note:  Once you have played a slide show, you may want to retain the same slide show
settings for future use. To do this, click the Save button to save your settings to file. Click
the Load button to bring your settings back for another slide show .

To view a thumbnail slide show:

1 Select the thumbnails you wish to use in the slide show.

2 Click the View: Slide Show menu command. The Slide Show dialog box
opens.

3 Select the type of transition to be used between images from the Effect
drop-down list on the General tab.

4 Adjust the speed of the slide show using the Speed slide control.

5 Enter the transition method. You can enter the delay between frames
manually in the Delay entry box or to sychronize it with a linked audio file.
Finally, you can choose to control the slide show manually with either
mouse clicks or the keyboard.
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6 Select the Repeat Continuously option to have the slide show play indefi-
nitely.

7 If some or all of the images are larger than the logical screen of the monitor,
select the Resize large images to fit screen size option.

8 Select the Hide pointer option to make the mouse pointer invisible.

9 Select the Play audio annotation option to play any annotated sound files
attached to the thumbnails.

10 On the Text and Color tab, assign a color to the text and background as
well as selecting which attributes are displayed during the slide show. You
can align the attribute text any where you like on the screen.

11 On the Music tab, select a WAV or MIDI file to accompany the thumbnail
slide show.

12 Click Play to engage the slide show or Save to save the settings for use
again later. You can use a saved slide show by clicking the Load button and
locating the *.shw file.

To create an HTML-based slide show:

1 Select the thumbnails you wish to include in the slide show.

2 Click the Thumbnail: Export - Slide Show menu command. This opens the
Export Slide Show dialog box.

3 Select either Manual or Automatic for the Slide Show Mode.

4 Set the size of the slide show window on the HTML page.

5 Enter the Delay between frames in number of seconds.

6 Under Output filename, enter the name and path of the HTML thumbnails.

7 Click OK. The thumbnails, the slide show engine, and the HTML are all
saved to the folder you entered in step 6.
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Outputting HTML-based thumbnails

Album provides you with the perfect method for sharing your image files over
the Internet or on the web. Using the Thumbnail: Export - Thumbnails menu
command, you can create thumbnail pages out of HTML. This allows you to
organize the images on your web site, create online catalogs, or web-based
galleries in a few, simple steps.

To output HTML-based thumbnails:

1 Select the files you wish to use and click the Thumbnails: Export - Thumb-
nails menu command. The Export Thumbnails dialog box opens.

2 On the Page Layout tab, choose the background image, header and footer,
title and output destination for the HTML file.

3 On the Thumbnail  tab, set thumbnail size, whether or not to include index
numbers (based on the thumbnails numbers in the Album), and thumbnail
prefix (appended to the beginning of each thumbnail filename.)

4 On the Fields tab, select which fields to include with the thumbnail. Field
information is display below the thumbnail image on the HTML page.

5 On the Format tab define the HTML text color, alignment, and other text-
attributes. This customizes the Text tags for each attribute defined on the
Format Text drop-down menu.

6 Click OK to generate the HTML files.

Locating thumbnails

Album brings with it a variety of commands and features giving you the most
efficient means of locating thumbnails and their associated files. For example,
you can use the Sort command in the Thumbnail menu to organize thumbnails
according to various file properties such as file names and file sizes. Another
method is to use the Search toolbar for quick, on-the-spot searches, while for
more complex and involved searches, you can use the Search dialog box.

Before you begin performing searches, however, you need to have a clear idea
of some of the logic behind them. The following section explains searches and
helps you better understand the power and possibilities of using them.

Search criteria and queries

Whenever you perform a search, you must first specify what it is you want to
search on. This is called the query. A query can consist of a single or multiple
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number of items, or criteria. For example, if you have chosen the query, file
names, the criteria would be the file name you are looking for.

Note:  If the criteria consists of more than one word, you must encase it with a delimiter,
for example, “New York.”

Logical operators

One of the more powerful features of Album is its use of logical (Boolean)
operators: Not, And, Or and ( ). These allow you to search through a vast
number of files quickly, looking only for specific file features. Below is a brief
description of how each of the operators work.

• Not is used to define the opposite of the indicated criteria. This allows you to
isolate thumbnails whose attributes make it a minority in an album. For
example, in an album consisting largely of TIF files, performing a file format
search, “Not *.TIF”, results in all thumbnails, except those linked to TIF
files, being displayed.

• And allows you to specify more than one criteria to search on. (Matching
thumbnails must meet all of these criteria.) For example, to find thumbnails
about your holiday in Spain, you could perform a search on – “holidays And
Spain”. All thumbnails with the words holiday and Spain will be displayed.

• Or  allows you to match thumbnails that meet one or more of a specified
criteria. For example, performing a file name search on, “F*.* Or G*.*”,
will display all those thumbnails whose files begin with an F or G.

• ( ) are used to group criteria together. This is particularly important if you
have several criteria, some of which must be paired together. For example, if
you are searching on the values, A, B and C, then you could define the
search as, “A And (B Or C)”, or “(A And B) Or C”. In the first example, the
thumbnails must have A and either B or C. In the second example, the
thumbnails must have either A and B together, or C only.

Note:  To use an operator, double-click (or select) the desired operator in any of the
dialog boxes that support this feature. The operator then appears in the Query entry box.
To add additional operators, simply repeat this procedure.

Search operators

Operators are characters or phrases that help define the range of a search.
Most of the search operators are quite self-explanatory – for example, = (equal
to), > (greater than), < (less than) and <> (not equal to). However, there are
two that require some clarification: “Contains” and “Empty.” Both are operators
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that appear whenever you have a query consisting of text, memo, list, mark,
and keyword fields.

The Contains search operator instructs Album to find all thumbnails that
contain whatever is entered in the Query entry box in the searched field. For
keyword and list fields, the Start with option appears to the right of the Query
entry box. Selecting this option tells Album to search for thumbnails that have
keywords or values that begin with the entered text.

The Empty search operator, on the other hand, instructs Album to find all
thumbnails with nothing entered into the searched field. This is particularly
useful when you want to locate thumbnails that have empty fields you would
like to complete.

Matching case and whole words

When performing a search on text, many of the search options allow you to
Match Case or Whole Word. Matching case tells Album to find those thumb-
nails matching the upper or lower case of the query. For example,
to match the case of “New York”, only New York would be selected, any
variations, such as “new York” or “NEW YORK” would be ignored.

Matching the whole word searches on occurrences of a defined word.
For example, to match the word “man,” only “man” would be selected, not
“woman.” If this option is left cleared, any occurrence of the letters (not the
word), m-a-n would be selected, such as “man,” “manage” and “human.”

Start with

Select the Start with  option if you want thumbnails with words that begin with
the entered text in the specified keyword or list field. For example, if you
entered “ch” in the Query entry box, then all thumbnails with words that begin
with “ch” in the specified keyword or list field will be displayed.

Performing a search

Performing a search can be as simple, or as complex, as you want to make it.
In most cases you will be performing simple, single criteria searches which are
best done from the Search toolbar. If you want more control over the search
process, click the Thumbnail: Search menu command.
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Some notes before you start performing a search:

• Since it is not possible to itemize all the possible search variations here, the
best thing to do is to read the previous section on search basics and then
experiment with your own variations.

• Some queries and criteria can be very complex and involved. Try first
working out your search on paper before entering it.

• Whenever you perform a search, the search is done only on the thumbnails
in the current view of the active album. If you want to perform a search on
all thumbnails in an album, make sure you click on the View All button or
select the All command in the View menu. The next time Album performs a
search, all thumbnails in the album will be included, irrespective of the
results of the previous search or current view.

To perform a search using the Search dialog box:

1 Click the Search button on the Standard toolbar or click the Thumbnail:
Search menu command. The Search dialog box opens.

2 Select the query you wish to search on from the Search Type combo box in
the Search criteria group box. Depending on the query chosen, define your
criteria. To further edit a criteria, click the Edit Criteria button. The Edit
Search Criteria dialog box opens. Here, you can specify to match the whole
word or its case, as well as use a logical operator and delimiter, (if neces-
sary).

3 Click the Add button. The query is now placed in the Search Criteria
window beneath. To include additional criteria, repeat step 2. To change a
query, select the query in the Search criteria window and redefine the
criteria and query in the Search criteria group box. This time, when you
are ready to add the query, click the Change button. This replaces the query
selected in the Search criteria window with the new one. To remove a
query, highlight it and then click the Remove button.

4 To search on all albums in the workspace, select the Search all open
albums except minimized option in the Search option group box. Select
the Search entire folder option to search for all thumbnails in the current
folder. To combine the thumbnails of successive searches, select the Add
search result to current view option. (You can also select and clear these
options from the Thumbnail menu.) Notice that when the Search all open
albums except minimized option is selected, the Search type combo box
only lists the user-defined fields that are common to all albums. Fields are
considered as common if they have the same field name, field type, and
keyword/list definitions.
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5 In the Action to take group box, select the View matched thumbnails
option to display the matching thumbnails or the Select matched thumb-
nails option to select the matching thumbnails.

6 Click the Save Query button to save the query for future use or editing. This
brings up the Save Query dialog box which prompts you for the query
name. Type in a name in the Query entry box and press Enter. To remove
an existing query, highlight it and click the Remove button. To edit a query,
select it from the Query entry box, the contents of the query are displayed
in the list box.

7 Click OK. The search is performed and, if you defined a query, the query is
saved and any thumbnails matching the search criteria are displayed in the
album.

Note:   Depending on the media type and file format of the thumbnail files, some search
options may be disabled.

Using the Search toolbar

Many of the search criteria found in the Search dialog box can also be accessed
directly from the Search toolbar. You will find the Search toolbar a much more
convenient and quicker way of performing single criteria searches. To use the
Search toolbar, select a query to search on from the Search type combo box,
the first on the left. The toolbar changes and, depending on the query itself,
displays a Search operator combo box as well as a Criteria entry box. Select an
operator and then enter in the description of the criteria you want to search on.
Clicking the Search button then performs the search and any thumbnails
matching the search criteria are displayed in the album.

Note:  To quickly perform a search using an existing query, select Query from the Search
Type combo box. In the combo box that appears, select the query and then click on the
search button.

Defining marks

Marks serve as visual tags for thumbnails in albums. In a sense, they are very
similar to keywords differing only in implementation. Whereas keywords work
“behind the scenes,” marks are clearly displayed on the thumbnail slide. You
will find marks particularly useful when you want to quickly navigate around an
album and pinpoint certain thumbnails for future operations.
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Assigning marks

To assign marks, you need to use the Mark panel. This is a floating panel that
allows you to assign up to 26 marks to thumbnails. Each mark is represented by
a letter of the alphabet, and once assigned, the letter is displayed next to the
index number on the thumbnail slide.

To assign a mark:

1 Double-click any letter on the Mark panel, the Edit Marks dialog box opens.

2 Select the letter you want to assign from the Marks  list box. In the Mark
name entry box, type in a description (up to 31 characters).

You can edit and assign descriptions to any mark by simply clicking it and
then entering a description in the Mark name entry box. If you wish to use
marks already present in another album, select the album from the Adopt
marks from album combo box. The marks, if any, appear immediately in
the Marks  list box.

3 Click OK. The dialog box closes, returning you to the Album window. The
mark description now appears on the Mark panel.

4 Click on the mark you want to assign on the Mark panel. The View Marks
and Assign Marks buttons are enabled.

To assign multiple marks, hold down the Ctrl key and click each mark to
select it. (Clicking again deselects the mark.) To select a range of marks,
click the first mark in the range, and, holding down the Shift key, click the
last. All marks in the range are selected. (Dragging your mouse over the
marks performs the same function.)

5 Click the Assign Marks button, the button changes to Stop, and click the
thumbnail you wish to mark. The letter of the mark is immediately shown on
the top left corner of the thumbnail slide, next to the index number. (Clicking
again removes the mark.) Repeat this step if you want to assign the same
mark to another thumbnail.

6 When you have finished assigning the current mark, click the Stop button on
the Mark panel, the button changes back to Assign Mark.

To assign another mark, repeat steps 4 and 5. (You can assign more than
one mark to the same thumbnail.)

Note: To remove the Mark panel, double-click on the title bar or clear the Mark Panel
option in the Toolbars & Panels dialog box.
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The chapter in review

Here are some key points and tips to remember from this chapter:

• Minimize inactive albums to the Album panel to save system resources
(p.224).

• You can split an album window into two, different views (p.225).

• Use View: Scan Play to quickly sample from your multimedia files (p.227).

• Drag-and-drop thumbnails onto any icon on the Tool panel to open it in the
application the icon represents (p.231).

• Drag-and-drop thumbnails directly into other applications' program windows
(p.232).

• Press the Ins key or click the Thumbnail: Insert menu command to add new
thumbnails to an album file (p.241).

• Use the Thumbnail: Export – Thumbnails command to create online image
galleries and catalogs (p.256).

Other topics of interest

If you would like to learn more about:

• SmartSaving album images for web-distribution, see Chapter 6 (p.161).

• Enhancing album images in PhotoImpact, see Chapter 4 (p.85).

• Adding wild special effects to album images in PhotoImpact, see Chapter 5
(p.127).

• More information on scanning images using PhotoImpact, see Chapter 3
(p.69).
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Appendix 1

Index

This appendix assists you in locating topics and information quickly

and efficiently.
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Symbols

3D edges  140
3D text  136
3D Transform  115, 117

A

Acquiring
destination  72
digital cameras  74
image sources  71
images  69
   to Album  242
Internet  76
photo CDs  77
post-processing  74
scanners  75
tips  77
TWAIN devices  70

Add  211
Adding

bump map  138
light to an image  148
shadows to objects  62, 187
shadows to text  136
text to an image  135
views  42

Adding annotations  251
Adjust focus  74
Adjust lighting  74
Advanced web imaging  184
Album Panel  224

placing albums on  224
Albums

auto scroll  227
backing up  236
CD-ROM distribution  250
creating  223
description  239
field data

entering  243
inserting thumbnails  241
linking  234
maintaining  249
OLE  233

editing linked objects  234
embedding  234

placing on the shelf  224
properties  239
refreshing  235
restoring  237
scan play  227
scrolling  227
sending over the Internet  238
sharing  238
title  239
updating  235

Aligning  173
Alpha channel  179
Animation

Artist Texture  151
color  204
color palettes  196

conversion  198
local  196

compatibility  200
Creative Warp  153
delay  198
file format  196
frame rate  198
GIF

basics  194
image layers

how to remove  198
interlacing  198
optimizing  214
scrolling text  201
SmartSaving  181
Transform  158
Wizard  200

Annotations
adding  251
removing  251

Any shape selections  50
Artist texture  151
Attribute toolbar  207
Auto-Process  86

B

Background color  94
Backgrounds  168

color  207
seamless tiling  170
shifting  169

Backing up
albums  236
source files  236
to floppy disks  237

Banner text  203
Basic commands

PhotoImpact  19
Batch task  32
Batch testing  180
Bevel

Material dialog box  139
Bezier tool  120, 125
Bit depth  164

1-bit  165
24-bit  166
4-bit  166
8-bit  165, 166
black & white  165
changing

Grayscale to black & white  165
True Color to indexed 16-color  166
True Color to indexed 256-color  166

color tables  164
Grayscale  165
HiColor  164
images

changing  165
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indexed 16-color  166
indexed 256-color  166
True Color  164, 166

Boolean operators  257
Border  55, 140, 202

Material dialog box  140
Brightness  90
Brush Panel

options tab  106
Brush panel  101

advanced tab  104
color tab  104
options tab  102
shape tab  101

Bump maps  138
density  141

Buttons  171
aligning  173
irregular  172
rectangular  171
spacing evenly  173

C

Calibrating
input devices  73
printers  35

Changing
image resolution  88

Checking
links to source files  220
thumbnails automatically  220
thumbnails manually  235

Clearing
undo/redo list  33

Clipboard  37, 39
Clone tools  106

saving attributes  109
stamp  106

Cloning images  106
Color 167
Color animation  204
Color balance  92
Color cache  94
Color correction  89
Color palettes  94, 166

adding colors  211
conversion  198
editing  97, 210
GIF  196
global  196
gradients  211
loading  97
removing colors  211
saving  97, 211

Color picker  96
Color tables  164
Colors

background  94
erasing  106
filling an area  109

foreground  94
Material dialog box  139
palettes  166
selecting  95

with Eyedropper  96
with Ulead color picker  95
with Windows color picker  95

selecting similar  56
Comment  199, 207, 208

title  208
Compact mode  233
Contrast  90
Converting  222

24-bit to 4-bit  166
24-bit to 8-bit  166
8-bit to 1-bit  165
Grayscale to black & white  165
source files

data type  252
format  252

True Color to indexed 16-color  166
True Color to indexed 256-color  166

Copying
field data  228
filenames  228
objects  37, 63
selection areas  37
thumbnails  228

Creating
keyword lists  244
value lists  246
albums  223

Creative effects  145
Artist Texture  151
Creative Warp  153
Painting  154
Particle  155
Transform  158
Type  159

Creative Warp  153
Crop  74, 87

image layers  210
Cube effect  205
Custom

filters  133, 134
Customizing

Album  220
galleries & object libraries  45
HTML  186
Material dialog box  144
PhotoImpact  22

effects and filters  128
Cutting

field data  228
filenames  228
objects  37
selection areas  37
thumbnails  228

D

Data entry  226
Data type
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effects and filters  128
Deform image  139
Delay  198, 208
Delimiter  221
Depth  140

Material dialog box  140
Destination  72
Determining color similarity  51
Digital cameras  71
Digitial cameras  74
Distort  115
Distorting

paths  120
Dither  166, 167, 176

Hi-Color  26
Drag-and-drop  231

between tabs  232
texture fills  112
to other albums  232
to other program workspace  232
to other programs  233
to the tool panel  231

Duplicating
image layers  209
images  29
objects  63

Duration  204

E

EasyPalette  45
exporting galleries  46
galleries  45
importing galleries  46
layer manager  46
object libraries  45, 64

Edge blending  137, 188
Editing

paths  120
Embedding  234
Enhancing

images automatically  86
text  136

Erasing
colors  100

Expanding selection areas  56
Exporting  212

field data  247
galleries  46

Eyedropper  96

F

Field data
copying  228
cutting  228
entering  243
exporting  247
importing  247
pasting  228

Field types  240

date  244
filename  244
keyword  244
list  246
memo  246
number  244
text  244

Fields
name  240

Filenames
copying  228

Files
associations  24
saving  30

Fill methods  110
Fill tools

elliptical gradient fill  109
linear  109
rectangular  109
solid fill  109

Filling
paths  124
using Clear  113
using drag-and-drop  113

Filters  128
applying  128
custom filters  134
customizing  128
data type  128
modifying  129

Fixed size selections  49
Flipping  210
Folder monitoring  241
Foreground color  94, 96
Frame rate  198
Frames  188

styles  189
Fundamentals  19

G

Galleries  45
customizing  45

Gamma  26, 163
adjusting monitor gamma  163

Generation quality  23
GIF  167

animation
basics  194
converting palettes  198
delay  198
getting started  200
removing image layers  198
scrolling text  201
SmartSaving  181

bit depth  164
color palettes  196

global  196
local color palettes  196

file format  196
interlacing  175, 198
number of colors  167
optimizing  214
SmartSaver  175
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SmartSaving
batch testing  180

GIF Animator
basics  194

Global attribute change  208, 209
Global information  207
Global palette  196, 207

adding a gradient  211
adding colors  211
editing  210
expanding automatically  197
removing colors  211
saving  211

Global Viewer  42
Gradients

adding to color palettes  211
Grayscale  165
Grayscale mask  57

editing  57
using  58

Grouping  59, 124, 137

H

Halftone screen  165
Helper programs  191
How to remove  198, 208
HTML Image Assistant  186
HTML-based slide shows  255
HTML-based thumbnails  256
Hue  92

I

Image clone tool  106
Image layers  206

cropping  210
duplicating  209
editing  208
exporting  212
flipping  210
merging  213
moving  206
rotating  210
selecting  209
viewing  206

Image Map Tag  185
Image maps  184
Image mask  57, 180
Images

acquiring  69, 71
acquiring to Album  242
adding frames  188
bit depth  164
changing resolution  88
cloning  106
converting

24-bit to 4-bit  166
24-bit to 8-bit  166
8-bit to 1-bit  165
Grayscale to black & white  165
True Color to indexed 16-color  166

True Color to indexed 256-color  166
creating new  28
cropping  87
custom HTML tags  187
display differences  162
duplicating  29
enhancing automatically  86
erasing colors from  106
exporting  212
filling with color  109
fitting to window  43
gamma  163
importing into GIF Animator  200
mapping  184
masks  180
merges  213
opening  27
preserving base image  53
printing  34
properties  208
resampling  89
resizing  88
restoring  33
retouching  104
retrieving  66
saving  30
saving from clipboard to disk  39
sending by e-mail  31
sequence  212
shifting  169
SmartSaving  174
sources  71
stitching  78
straighten  116
title  207
using as thumbnails  47
zooming  41

Importing
galleries  46

Indexed 16-color  166
Indexed 256-color  166
Input devices

calibrating  73
Inserting

thumbnails  241
Interlacing  175, 179, 198
Internet  76

sending albums  238, 243

J

JPG (JPEG)  167
compression  178
number of colors  167
SmartSaving

batch testing  180
smoothing  177

K

Kaleidoscope  147
Keywords
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assigning  245
creating a list  244
loading  245
saving  245

L

Lasso tool  50
adding  55
subtracting  55

Layer Manager  46, 58
changing layer order  60

Layer pane  206
Layout options  31
Light  142, 148
Limiting

hard disk usage  25
RAM usage  25

Lists
assigning  246

Loading
color palettes  97
image files onto the clipboard  39

Local palette  196
adding a gradient  211
adding colors  211
editing  210
removing colors  211
saving  211

Locating thumbnails  256
Logical operators  257
Logical screen  207
Looping  207
Lossless  167
Lossy  167
Low resolution place holder  222

M

Macros  32
recording  32

Magic effects  145
Kaleidoscope  147
Light  148
Magic Gradient  145
Turnpage  150

Magic Frame  74
Magic Gradient  145
Magic Wand tool  51

adding  55
determining color similarity  51
subtracting  55

Maintaining source files  252
Managing objects  46
Mapping  184

object-based  184
selection-based  184

Marks  260, 262
assigning  261

palette  261
Mask Brush  52

attributes  52
Masks  52, 57, 175, 177, 179, 180

adjusting  181
editing  57

Material dialog box  138
bevel  139
border  140
bump  138, 141
color  139
customizing settings  144
deform image  139
depth  140
light  142
reflection  141
shading  143
shadow  143

render backface  143
texture  139
transparency  142

Maximum border width  140
Measurement units  22
Merge  61, 213
Metallic  143
Minimum transparency  142
Modes

path  120
sharing  238

Modify  32
Modify and Apply  47, 129, 145
Modifying thumbnails  47
Monitor gamma  26
Moving

image layers  206
Moving objects  63
Multiple files

applying the same commands  29
Multiple-color gradient fill  111

N

New  28
Next image  206

O

Object clone tool  106, 108
Object libraries  45

customizing  45
Object Shadow Designer  187
Object-broker for thumbnails  222
Objects  48

3D edges  140
adding shadows  62, 187
aligning  173
copying  37
cutting  37
deleting  64
duplicating  63
edge blending  188
embedding  40
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editing  41
filling with color  109
grouping & ungrouping  59
Layer Manager  58
libraries  64
linked

editing  234
linking URLs  184
linking via OLE  40
mapping  184
moving  63
properties  59, 60
restoring  64
selecting multiple  49
sorting  62
spacing evenly  173
transforming  114
transparency  188

OLE  23, 40
Album  233
editing linked objects  234
embedding  40, 234

editing  41
linking  234
representation in Album  222

Opening  27
images

PhotoImpact  27
source files  252

Optimization Wizard  200, 214
Optimize with Pre-sets  200
Optimizing GIF files  214

P

Paint mode
draw line  100
draw polygon  100
freehand  100
specifying  100

Paint tools
attributes  99
brush panel

advanced tab  104
color tab  104
options tab  102, 106
shape tab  101

erasing colors  100
saving attributes  109
selecting  98
using  98

Painting
brush panel

advanced tab  104
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